
MPX Plus 866 A
Media Presentation Matrix Switcher 

68-1193-01 Rev. B
05 09



This symbol is intended to alert the user of important operating and maintenance 
(servicing) instructions in the literature provided with the equipment. 

This symbol is intended to alert the user of the presence of uninsulated dangerous 
voltage within the product’s enclosure that may present a risk of electric shock. 

Caution
Read Instructions • Read and understand all safety and operating instructions before using the equipment. 

Retain Instructions • The safety instructions should be kept for future reference.

Follow Warnings • Follow all warnings and instructions marked on the equipment or in the user 
information.

Avoid Attachments • Do not use tools or attachments that are not recommended by the equipment 
manufacturer because they may be hazardous. 

Warning
Power sources • This equipment should be operated only from the power source indicated on the product. This 

equipment is intended to be used with a main power system with a grounded (neutral) conductor. The 
third (grounding) pin is a safety feature, do not attempt to bypass or disable it. 

Power disconnection • To remove power from the equipment safely, remove all power cords from the rear of 
the equipment, or the desktop power module (if detachable), or from the power source receptacle (wall 
plug).

Power cord protection • Power cords should be routed so that they are not likely to be stepped on or pinched by 
items placed upon or against them. 

Servicing • Refer all servicing to qualified service personnel. There are no user-serviceable parts inside. To 
prevent the risk of shock, do not attempt to service this equipment yourself because opening or removing 
covers may expose you to dangerous voltage or other hazards. 

Slots and openings • If the equipment has slots or holes in the enclosure, these are provided to prevent 
overheating of sensitive components inside. These openings must never be blocked by other objects. 

Lithium battery • There is a danger of explosion if battery is incorrectly replaced. Replace it only with the 
same or equivalent type recommended by the manufacturer. Dispose of used batteries according to the 
manufacturer’s instructions.

Ce symbole sert à avertir l’utilisateur que la documentation fournie avec le matériel 
contient des instructions importantes concernant l’exploitation et la maintenance 
(réparation).

Ce symbole sert à avertir l’utilisateur de la présence dans le boîtier de l’appareil 
de  tensions dangereuses non isolées posant des risques d’électrocution.

Attention
Lire les instructions• Prendre connaissance de toutes les consignes de sécurité et d’exploitation avant 

d’utiliser le matériel.

Conserver les instructions• Ranger les consignes de sécurité afin de pouvoir les consulter à l’avenir.

Respecter les avertissements • Observer tous les avertissements et consignes marqués sur le matériel ou 
présentés dans la documentation utilisateur.

Eviter les pièces de fixation • Ne pas utiliser de pièces de fixation ni d’outils non recommandés par le 
fabricant du matériel car cela risquerait de poser certains dangers.

Avertissement
Alimentations• Ne faire fonctionner ce matériel qu’avec la source d’alimentation indiquée sur l’appareil. Ce 

matériel doit être utilisé avec une alimentation principale comportant un fil de terre (neutre). Le troisième 
contact (de mise à la terre) constitue un dispositif de sécurité : n’essayez pas de la contourner ni de la 
désactiver.

Déconnexion de l’alimentation• Pour mettre le matériel hors tension sans danger, déconnectez tous les cordons 
d’alimentation de l’arrière de l’appareil ou du module d’alimentation de bureau (s’il est amovible) ou 
encore de la prise secteur.

Protection du cordon d’alimentation • Acheminer les cordons d’alimentation de manière à ce que personne ne 
risque de marcher dessus et à ce qu’ils ne soient pas écrasés ou pincés par des objets.

Réparation-maintenance • Faire exécuter toutes les interventions de réparation-maintenance par un technicien 
qualifié. Aucun des éléments internes ne peut être réparé par l’utilisateur. Afin d’éviter tout danger 
d’électrocution, l’utilisateur ne doit pas essayer de procéder lui-même à ces opérations car l’ouverture ou le 
retrait des couvercles risquent de l’exposer à de hautes tensions et autres dangers.

Fentes et orifices • Si le boîtier de l’appareil comporte des fentes ou des orifices, ceux-ci servent à empêcher 
les composants internes sensibles de surchauffer. Ces ouvertures ne doivent jamais être bloquées par des 
objets.

Lithium Batterie • Il a danger d’explosion s’ll y a remplacment incorrect de la batterie. Remplacer uniquement 
avec une batterie du meme type ou d’un ype equivalent recommande par le constructeur. Mettre au reut les 
batteries usagees conformement aux instructions du fabricant.

Safety Instructions • English

Consignes de Sécurité • Français

Sicherheitsanleitungen • Deutsch
Dieses Symbol soll dem Benutzer in der im Lieferumfang enthaltenen 
Dokumentation besonders wichtige Hinweise zur Bedienung und Wartung 
(Instandhaltung) geben.

Dieses Symbol soll den Benutzer darauf aufmerksam machen, daß im Inneren des 
Gehäuses dieses Produktes gefährliche Spannungen, die nicht isoliert sind und 
die einen elektrischen Schock verursachen können, herrschen.

Achtung
Lesen der Anleitungen • Bevor Sie das Gerät zum ersten Mal verwenden, sollten Sie alle Sicherheits-und 

Bedienungsanleitungen genau durchlesen und verstehen.

Aufbewahren der Anleitungen • Die Hinweise zur elektrischen Sicherheit des Produktes sollten Sie 
aufbewahren, damit Sie im Bedarfsfall darauf zurückgreifen können.

Befolgen der Warnhinweise • Befolgen Sie alle Warnhinweise und Anleitungen auf dem Gerät oder in der 
Benutzerdokumentation. 

Keine Zusatzgeräte • Verwenden Sie keine Werkzeuge oder Zusatzgeräte, die nicht ausdrücklich vom 
Hersteller empfohlen wurden, da diese eine Gefahrenquelle darstellen können.

Vorsicht
Stromquellen • Dieses Gerät sollte nur über die auf dem Produkt angegebene Stromquelle betrieben werden. 

Dieses Gerät wurde für eine Verwendung mit einer Hauptstromleitung mit einem geerdeten (neutralen) 
Leiter konzipiert. Der dritte Kontakt ist für einen Erdanschluß, und stellt eine Sicherheitsfunktion dar. Diese 
sollte nicht umgangen oder außer Betrieb gesetzt werden. 

Stromunterbrechung • Um das Gerät auf sichere Weise vom Netz zu trennen, sollten Sie alle Netzkabel 
aus der Rückseite des Gerätes, aus der externen Stomversorgung (falls dies möglich ist) oder aus der 
Wandsteckdose ziehen.

Schutz des Netzkabels • Netzkabel sollten stets so verlegt werden, daß sie nicht im Weg liegen und niemand 
darauf treten kann oder Objekte darauf- oder unmittelbar dagegengestellt werden können.

Wartung • Alle Wartungsmaßnahmen sollten nur von qualifiziertem Servicepersonal durchgeführt werden. 
Die internen Komponenten des Gerätes sind wartungsfrei. Zur Vermeidung eines elektrischen Schocks 
versuchen Sie in keinem Fall, dieses Gerät selbst öffnen, da beim Entfernen der Abdeckungen die Gefahr 
eines elektrischen Schlags und/oder andere Gefahren bestehen.

Schlitze und Öffnungen • Wenn das Gerät Schlitze oder Löcher im Gehäuse aufweist, dienen diese zur 
Vermeidung einer Überhitzung der empfindlichen Teile im Inneren. Diese Öffnungen dürfen niemals von 
anderen Objekten blockiert werden.

Litium-Batterie • Explosionsgefahr, falls die Batterie nicht richtig ersetzt wird. Ersetzen Sie verbrauchte 
Batterien nur durch den gleichen oder einen vergleichbaren Batterietyp, der auch vom Hersteller 
empfohlen wird. Entsorgen Sie verbrauchte Batterien bitte gemäß den Herstelleranweisungen.

Este símbolo se utiliza para advertir al usuario sobre instrucciones importantes 
de operación y mantenimiento (o cambio de partes) que se desean destacar en el 
contenido de la documentación suministrada con los equipos.

Este símbolo se utiliza para advertir al usuario sobre la presencia de elementos con 
voltaje peligroso sin protección aislante, que puedan encontrarse dentro de la caja 
o alojamiento del producto, y que puedan representar riesgo de electrocución.  

Precaucion
Leer las instrucciones • Leer y analizar todas las instrucciones de operación y seguridad, antes de usar el 

equipo.

Conservar las instrucciones • Conservar las instrucciones de seguridad para futura consulta.

Obedecer las advertencias • Todas las advertencias e instrucciones marcadas en el equipo o en la 
documentación del usuario, deben ser obedecidas.

Evitar el uso de accesorios • No usar herramientas o accesorios que no sean especificamente recomendados 
por el fabricante, ya que podrian implicar riesgos. 

Advertencia
Alimentación eléctrica • Este equipo debe conectarse únicamente a la fuente/tipo de alimentación eléctrica 

indicada en el mismo. La alimentación eléctrica de este equipo debe provenir de un sistema de distribución 
general con conductor neutro a tierra. La tercera pata (puesta a tierra) es una medida de seguridad, no 
puentearia ni eliminaria. 

Desconexión de alimentación eléctrica • Para desconectar con seguridad la acometida de alimentación eléctrica 
al equipo, desenchufar todos los cables de alimentación en el panel trasero del equipo, o desenchufar el 
módulo de alimentación (si fuera independiente), o desenchufar el cable del receptáculo de la pared.

Protección del cables de alimentación • Los cables de alimentación eléctrica se deben instalar en lugares donde 
no sean pisados ni apretados por objetos que se puedan apoyar sobre ellos. 

Reparaciones/mantenimiento • Solicitar siempre los servicios técnicos de personal calificado. En el interior no 
hay partes a las que el usuario deba acceder. Para evitar riesgo de electrocución, no intentar personalmente 
la reparación/mantenimiento de este equipo, ya que al abrir o extraer las tapas puede quedar expuesto a 
voltajes peligrosos u otros riesgos. 

Ranuras y aberturas • Si el equipo posee ranuras o orificios en su caja/alojamiento, es para evitar el 
sobrecalientamiento de componentes internos sensibles. Estas aberturas nunca se deben obstruir con otros 
objetos.

Batería de litio • Existe riesgo de explosión si esta batería se coloca en la posición incorrecta. Cambiar esta 
batería únicamente con el mismo tipo (o su equivalente) recomendado por el fabricante. Desachar las 
baterías usadas siguiendo las instrucciones del fabricante.

Instrucciones de seguridad • Español

Precautions

安全须知 • 中文
这个符号提示用户该设备用户手册中有重要的操作和维护说明。

这个符号警告用户该设备机壳内有暴露的危险电压，有触电危险。

注意
阅读说明书 • 用户使用该设备前必须阅读并理解所有安全和使用说明。

保存说明书 • 用户应保存安全说明书以备将来使用。

遵守警告 • 用户应遵守产品和用户指南上的所有安全和操作说明。

避免追加 • 不要使用该产品厂商没有推荐的工具或追加设备，以避免危险。

警告
电源 • 该设备只能使用产品上标明的电源。 设备必须使用有地线的供电系统供电。 第三条线

（地线）是安全设施，不能不用或跳过 。

拔掉电源 • 为安全地从设备拔掉电源，请拔掉所有设备后或桌面电源的电源线，或任何接到市
电系统的电源线。

电源线保护 • 妥善布线， 避免被踩踏，或重物挤压。

维护 • 所有维修必须由认证的维修人员进行。 设备内部没有用户可以更换的零件。为避免出
现触电危险不要自己试图打开设备盖子维修该设备。

通风孔 • 有些设备机壳上有通风槽或孔，它们是用来防止机内敏感元件过热。 不要用任何东
西挡住通风孔。

锂电池 • 不正确的更换电池会有爆炸的危险。必须使用与厂家推荐的相同或相近型号的电池。
按照生产厂的建议处理废弃电池。



 

FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules.  Operation is subject to 
the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference 
that may cause undesired operation.  The Class A limits are designed to provide reasonable protection against harmful interference when the equipment is 
operated in a commercial  environment.  This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with 
the instruction manual, may cause harmful interference to radio communications.  Operation of this equipment in a residential area is likely to cause harmful 
interference, in which case the user will be required to correct the interference at his own expense.

N	 This unit was tested with shielded cables on the peripheral devices.  Shielded cables must be used with the unit to ensure compliance with FCC emissions limits. 
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About this Manual
This manual contains installation, configuration, and operating information for the 
Extron MPX Plus 866 A Media Presentation Matrix Switcher.

In this manual, the MPX Plus 866 A may be referred to as “the MPX” or 
“the switcher”.

About the Media Presentation Matrix Switcher
A media presentation switcher combines multiple A/V switchers, of different video 
formats, in one box.

A matrix switcher distributes any input to any combination of outputs and can 
route multiple input/output configurations simultaneously.

The MPX Plus 866 A (figure 1-1) combines two video matrix switchers, an audio 
matrix switcher, a program audio switcher, and a digital signal processor (DSP) that 
provides a wide variety of microphone pre-amplifier controls, mixers, and filters in 
a single product.
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Figure 1-1 — Typical MPX Plus 866 A application
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The MPX Plus 866 A has the following switching and mixing capabilities:

•	 An 8-input by 6-output VGA matrix switcher, comprising the computer video 
group

•	 A 6-input by 6-ouput S-video and composite video matrix switcher, comprising 
the low resolution video group

•	 A 14-input by 6-output primary audio matrix switcher, comprising the program 
audio group

•	 Four mono microphone (mic)/line level inputs that can be mixed with one or all 
audio outputs of the primary audio group 

N	 Video ties can only be made within the same group (computer or low resolution).

	 Audio ties can be made only to outputs in the computer/audio group (outputs 1 
through 6).

The switcher is a solution to complex simultaneous computer video, low resolution 
video, and audio routing applications.  Any input(s) within one of the two groups, 
computer video and low resolution video, can be switched to any one or all 
outputs within that same group.  Each input and output is individually isolated 
and buffered; switching is accomplished with virtually no crosstalk or signal noise 
between channels.

The audio switching can either be linked with the video (audio follow) or 
independent of the video (audio breakaway).  The 14 inputs in the primary audio 
group can be switched along with inputs from either video group (although audio 
ties can only be made to the computer/audio group).  Adjustable input audio gain 
and attenuation compensates for level differences among audio inputs.

The mic/line inputs have a talkover feature that automatically reduces the primary 
audio group when mic/line input is present.  When the mic/line input is not 
present, the primary audio group is restored to the set volume level.  The mic 
talkover threshold is adjustable from 0 dB to -60 dB.

The switcher has two, primary and secondary, rear panel RS-232 ports and a local 
area network (LAN) Ethernet port for remote control and reporting.  The matrix 
switcher is programmed with Extron’s Simple Instruction Set (SIS™), a set of basic 
ASCII code commands that provide simple control through a control system or PC 
without programming long, obscure strings of code.  SIS commands can be entered 
via the RS-232 ports or the LAN port.

The LAN port can be connected through a local area network (LAN) or wide area 
network (WAN).
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The MPX can be operated by any of the following connected to either RS-232 port 
or the LAN port:

	 •	 A control system

	 •	 A PC  and any of the following:

	 The Extron SIS

	 The Extron Windows-based DSP Configurator program

	 The Extron Windows®-based Matrix Switchers Control Program

	 •	 An Extron MKP 2000 remote control panel

	 •	 An Extron MKP 3000 remote control panel

	 •	 (RS-232 only) An Extron MCP 1000 remote control panel and/or MKP 1000 
remote keypad

The switcher is housed in a rack-mountable, 2U high metal enclosure with 
mounting flanges for a standard 19" rack.  The appropriate rack mounting kit is 
included with the switcher.

The switcher has an internal 100 VAC to 240 VAC, 50-60 Hz, 48 watts power supply 
that provides worldwide power compatibility.

Definitions
The following terms, which apply to all Extron matrix switchers, are used 
throughout this manual:

	 Tie — An input-to-output video and/or line audio connection.

	 Set of ties — An input tied to two or more outputs.  (An output can never be tied 
to more than one input.)

	 Configuration — One or more ties, one or more sets of ties, and/or  some or all of 
the signal processor settings made in the DSP Configurator program.

	 Current configuration — The configuration that is currently active in the 
switcher (also called configuration 0)

	 Partial (DSP-Configurator-created) preset — A partial configuration (a subset of 
ties and/or sets of ties and/or signal processor settings) that has been stored.

N	 Partial presets can be created only by using the DSP Configurator program.  
They can be recalled via any means.  When recalled (by any means), partial 
presets overwrite only a portion of the current configuration, leaving other ties 
and settings unchanged.

	 Global ties preset — A full, ties only, configuration that has been created via the 
front panel, SIS commands, or the Matrix Switchers Control Program.

N	 Up to 32 partial or global ties presets can be stored in memory.  Preset locations 
are assigned to the input buttons and output buttons.  Up to 26 preset locations 
can be selected from the front panel for either saving or retrieving.  When a 
preset is retrieved from memory, it becomes the current configuration (global 
ties preset) or part of the current configuration (partial preset).  Preset numbers 
larger than 26 are accessible under RS-232 or Ethernet control.
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Features

Video features
	 Computer video group — The switcher inputs and outputs RGBHV (VGA), 

RGBS, RGsB, RsGsBs, or Y, R-Y, B-Y video on 15-pin HD connectors.

	 Low resolution video group — The switcher inputs and outputs NTSC 3.58, 
NTSC 4.43, PAL, or SECAM S-video and/or composite video.

Input Video format

9* Composite only

10 Composite only

11 S-video or composite, as selected

12 S-video or composite, as selected

13 S-video or composite, as selected

14 S-video or composite, as selected

*	 Input 9 is a genlock reference.  All other low resolution inputs are synced 
to input 9.

Output Video format

7 Composite only

8 Composite only
N	 For outputs 7 and 8, if the tied input is S-video, the switcher encodes it to composite.  

If the tied input is composite video, the switcher passes it through unprocessed.

9 S-video only

10 S-video only
N	 For outputs 9 and 10, if the tied input is S-video, the switcher passes it through 

unprocessed.  If the tied input is composite video, the switcher decodes it to S-video.

11 S-video or composite

12 S-video or composite
N	 For outputs 11 and 12, the output is passed through in the same format (S-video 

or composite) as the tied input.

Bandwidth —

	 Computer video group — The switcher provides a minimum of 300 MHz (-3 dB) 
video bandwidth, fully loaded.

	 Low resolution video group — The switcher provides a minimum of 
150 MHz (-3 dB) video bandwidth, fully loaded.
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Digital Sync Validation Processing (DSVP™) (computer video group) — 
In critical environments or unmanned, remote locations, it may be vital to 
know that sources are active and switching.  Extron’s DSVP confirms that 
input sources are active by scanning all sync inputs for active signals.  DSVP 
provides instantaneous frequency feedback for composite sync or separate 
horizontal and vertical sync signals via the switcher’s RS-232 ports or 
Ethernet port.  The frequency information can be displayed on any control 
system or in the Windows-based control program on a LAN or Internet 
Protocol (IP) connection (figure 1-2).

	

OR

Input  Horz.   Vert.

01    31.50    60.00

02    31.50    60.00

03    31.50    60.00

04    48.01    67.50 

05    48.01    67.50

06    48.01    67.50

07    48.01    67.50

08    61.55    72.00

Sample control system panel

Windows-based control program

MATRIX INPUT STATUS
Input # 01

Signal: PRESENT
Sync Type: H&V
Vertical Freq.: 60 Hz 
Horz Freq.: 31.5 kHz

Input # 02
Signal: PRESENT
Sync Type: H&V
Vertical Freq.: 60 Hz 
Horz Freq.: 31.5 kHz

Input # 03
Signal: PRESENT
Sync Type: H&V
Vertical Freq.: 60 Hz 
Horz Freq.: 31.5 kHz

Input # 04
Signal: PRESENT
Sync Type: H&V
Vertical Freq.: 60 Hz 
Horz Freq.: 31.5 kHz

Input # 05
Signal: PRESENT
Sync Type: H&V
Vertical Freq.: 60 Hz 
Horz Freq.: 31.5 kHz

Input # 06
Signal: PRESENT
Sync Type: H&V
Vertical Freq.: 60 Hz 
Horz Freq.: 31.5 kHz

Input # 07
Signal: PRESENT
Sync Type: H&V
Vertical Freq.: 60 Hz 
Horz Freq.: 31.5 kHz

Input # 08
Signal: PRESENT
Sync Type: H&V
Vertical Freq.: 60 Hz 
Horz Freq.: 31.5 kHz

Input # 01
Signal: PRESENT
Sync Type: H&V
Vertical Freq.: 60 Hz 
Horz Freq.: 31.5 kHz

Figure 1-2 — DSVP data display

RGB Delay (computer video group) — The switcher can briefly blank the RGB 
video output while it switches to the new input’s sync source, and then 
switches the RGB signals.  This allows a brief delay for the display to adjust 
to the selected input’s sync timing before displaying the new picture, which 
will appear without glitches.  RGB delay, also known as Triple-Action 
Switching™ or video mute switching, is user selectable from 0 to 5 seconds, in 
half-second increments.
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Audio features
	 Primary audio group — Input and output balanced or unbalanced stereo audio 

on 3.5 mm, 5-pole captive screw terminals.

	 •	 Audio input gain/attenuation (primary audio group) — Individual input 
audio levels can be adjusted so there are no noticeable volume differences 
between sources.  Users can set the input level of audio gain or attenuation 
(-18 dB to +24 dB) via the Ethernet port, any RS-232 port, or the front panel.

	 Mic audio group — Input mono audio on 3.5 mm, 3-pole captive screw 
terminals.

	 •	 Audio input gain/attenuation (mic audio group) — Individual input audio 
levels can be adjusted so there are no noticeable volume differences between 
sources.  Users can set the input level of audio gain or attenuation (0 dB 
to +80 dB) using the DSP Configurator program or SIS commands and the 
Ethernet port or any RS-232 port.

	 •	 Phantom power — The switcher can provide +48 VDC phantom power, a 
standardized method of providing power to condenser microphones.

	 •	 Output two channel mono audio on the primary audio group outputs.

	 Audio output volume — The audio volume of each output can be displayed and 
adjusted through a range of full output to completely silent from the front 
panel or under RS-232 or Ethernet control.

	 Digital signal processor — The powerful, built-in, DSP provides a wide variety 
of high-end audio capabilities, including:

	 •	 Gain, volume, and trimming

	 •	 Balance control

	 •	 Filtering

	 •	 Dynamic processing

	 •	 Feedback suppression

	 •	 Delay

	 •	 Loudness

	 •	 Mic mixing

	 •	 Mic ducking

	 Group masters — Any of the gain, volume, and trim controls in the DSP can be 
grouped with other controls of the same type (in the same location in the 
audio signal flow) for single-slider control of the entire group.
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General features
Switching flexibility — Provides individually buffered, independent matrix 

switched outputs with audio follow and audio breakaway.

N	 Program audio inputs are independent of the video groups, but must be tied to 
the computer/audio group (outputs 1 through 6).

	 •	 Tie any input to any or all outputs within a video group

	 •	 Quick multiple tie — Multiple inputs can be switched to multiple outputs 
within a video group simultaneously.  This allows all displays (outputs) to 
change from source to source at the same time.

	 •	 Audio follow — Audio can be switched with its corresponding video input 
via front panel control or under Ethernet or RS-232 remote control.

	 •	 Audio breakaway — Audio can be broken away from its corresponding 
video signal.  This feature allows any audio signal to be selected with any 
video signal simultaneously to one or all outputs in any combination.  Audio 
breakaway switching can be done via front panel control or under Ethernet or 
RS-232 remote control.

Operational flexibility — Operations such as input/output selection, setting of 
presets, and adjustment of audio levels can be performed on the front panel 
or via the Ethernet or RS-232 ports.  The Ethernet and RS-232 ports allow 
remote control via a PC or control system.  The Ethernet link allows multiple 
remote links with two levels of password protection.

	 •	 Front panel control — The front panel controller supports input and output 
selection, preset creation and selection, RGB delay (computer video group), 
and audio gain and attenuation and volume control.  The front panel features 
illuminated pushbuttons that can be labeled with text or graphics.

	 •	 Windows-based control program — For RS-232 remote control from a 
PC, the two Extron Windows-based control programs provide graphical 
interface and drag-and-drop/point-and-click operation.  The Windows-based 
control programs also have emulation modes that let you create switcher 
configuration files at the home office and then download them for use by the 
switcher on site.

	 •	 Simple Instruction Set (SIS™) — The remote control protocol uses Extron’s 
SIS for easy programming and operation.

	 •	 Remote control panels and keypads — The switcher is remote controllable, 
using the optional MKP 2000 and MKP 3000 remote control panels.  The 
remote control devices are easy to use and provide tactile buttons for quick 
selection.  Each MKP can be used for input-to-output switching or one-touch 
switching for a particular output and selecting presets.

Upgradeable firmware — The firmware that controls all switcher operation can be 
upgraded in the field via RS-232 or Ethernet, without taking the switcher out 
of service.  Firmware upgrades are available for download on the Extron Web 
site, www.extron.com, and they can be installed using the Windows-based 
control program.

Labeling — Extron’s included label software lets you create labels to place in the 
front panel I/O buttons, with names, alphanumeric characters, or color 
bitmaps for easy and intuitive input and output selection.  Alternatively, 
labels can be made with any Brother™ P-Touch™ or comparable labeler.

Global memory presets — 32 global memory presets are a time-saving feature that 
lets you set up and store input/output configurations in advance.  You can 
then recall those configurations, when needed, with a few simple steps.
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Rack mounting — Rack mountable in any conventional 19" wide rack.

Three front panel security lockout modes (Executive modes) — If a matrix 
switcher is installed in an open area, where operation by unauthorized 
personnel may be a problem, either of two security lockout modes can be 
implemented (the third mode is unlocked).  When a front panel locked mode 
is enabled, a special button combination or SIS command is required to 
unlock the front panel controller and make the front panel fully operational.

Power — The matrix switcher’s 100 VAC to 240 VAC, internal power supply 
provides worldwide power compatibility.
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Mounting the Switcher

UL guidelines
The following Underwriters Laboratories (UL) guidelines pertain to the installation 
of the MPX switcher into a rack (figure 2-1).

1.	 Elevated operating ambient temperature — If installed in a closed or 
multi-unit rack assembly, the operating ambient temperature of the rack 
environment may be greater than room ambient.  Therefore, consider 
installing the equipment in an environment compatible with the 104 °F
(+40 °C) maximum ambient temperature (Tma) specified by Extron.

2.	 Reduced air flow — Installation of the equipment in a rack should be such 
that the amount of air flow required for safe operation of the equipment is not 
compromised. 

3.	 Mechanical loading — Mounting of the equipment in the rack should be such 
that a hazardous condition is not achieved due to uneven mechanical loading. 

4.	 Circuit overloading — Consideration should be given to the connection of the 
equipment to the supply circuit and the effect that overloading of the circuits 
might have on overcurrent protection and supply wiring.  Appropriate 
consideration of equipment nameplate ratings should be used when 
addressing this concern. 

5.	 Reliable earthing (grounding) — Reliable earthing of rack-mounted 
equipment should be maintained.  Particular attention should be given to 
supply connections other than direct connections to the branch circuit (e.g. use 
of power strips.

Mounting instructions
If desired, rack mount the switcher as follows:

1.	 Insert the switcher into the rack, aligning the holes in the mounting bracket 
with those in the rack (figure 2-1).

2.	 Secure the switcher to the rack using the supplied bolts.

	

Figure 2-1 — Installing the switcher in a rack
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Rear Panel Connection and Settings
All switcher connectors are on the rear panel (figure 2-2).

C	 Use electrostatic discharge precautions (be electrically grounded) 
when making connections.  Electrostatic discharge (ESD) can damage 
equipment, even if you cannot feel, see, or hear it.

C	 Remove system power before making all connections.
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Figure 2-2 — MPX Plus 866 A Media Presentation Matrix Switcher

Video input and output connections

Computer video group
N	 The switcher does not alter the computer video inputs in any way.  The signal 

output is in the same format as the input.

The switcher can connect to up to as many as eight computer video sources and 
output to as many as six video devices.

a	 RGB video inputs — Connect the analog computer-video 
sources to the Computer Input 1 through Computer Input 8 
female 15-pin HD connectors.

N	 Most laptop or notebook computers have an external video port, but they 
require special commands to output the video to that connector.  Also, a laptop’s 
screen shuts off once that port is activated.  See the computer’s user’s guide for 
details, or visit the Extron Web site, www.extron.com, and search for “laptop 
commands”.

b	 RGB video outputs — Connect RGBHV video displays to 
the Computer Output 1 through Computer Output 6 female 
15-pin HD connectors.

1

1
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Low resolution video group
The switcher can connect to up to as many as six S-video and/or composite video 
sources and output to as many as six video devices.

c	 Video Input 9 and Video Input 10 (composite video inputs) — 
Connect composite video sources to these female BNC connectors.

N	 Video Input 9 serves as a timing reference for all other low 
resolution video group inputs.  If one of the inputs is synced to a 
blackburst generator, connect that source to input 9.

d	 Input 11 through Input 14 —

	 S-video inputs — Connect an S-video source to a pair of female 
BNC connectors.  Connect luma (Y) and chroma (C) as shown at 
right.

	 Composite video inputs — Connect a composite video source to 
the Video (top) connector in a pair of female BNC connectors as 
shown at right.

e	 Composite video outputs (Output 7 and Output 8) — 
Connect composite video displays to these female BNC connectors.

N	 If the input tied to Output 7 or Output 8 is S-video, the switcher 
encodes the input to composite video. 
If the tied input is composite video, the switcher passes it through to the output 
with no processing.

f	 S-video outputs (Output 9 and Output 10) — 
Connect S-video displays to these female BNC connectors.

N	 If the input tied to Output 9 or Output 10 is composite video, the 
switcher decodes the input to S-video. 
If the tied input is S-video, the switcher passes it through to the 
output with no processing.

g	 Pass-through outputs (Output 11 and Output 12) — 
Connect S-video or composite video displays to these 
female BNC connectors.  Connect S-video Y and C or 
composite video as shown at right.

N	 The switcher passes the tied input to these outputs with no 
signal processing; an S-video input is output as S-video, a 
composite video input is output as composite video.

Audio input and output connections
By default, the audio ties follow the video ties.  Audio breakaway, which can 
be activated via the optional front panel or under Ethernet or RS-232 control, 
allows you to select from any one of the audio input sources, regardless of video 
group, and route it separately from its corresponding video source.

N	 Audio ties can be made only to outputs in the computer/audio group (outputs 1 
through 6).

The audio level for each input and the volume level for each output can be 
individually set via the front panel or Ethernet or RS-232 control.  See chapter 3, 
“Operation”, chapter 4, “SIS Programming and Control”, chapter 5, “Switcher 
Software”, and chapter 6, “HTML Operation” for details.

9

10

GENLOCK

VIDEO

VIDEO

11

Y/VID

C
12

Y/VID

C

7

Y

C

9

12

Y/VID

S-video Composite
video

C

11
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Audio inputs (both input groups)

h	 Connections for balanced and unbalanced audio inputs — Each input has a 
5-pole, 3.5 mm captive screw connector for balanced or unbalanced stereo or 
mono audio input.  Connectors are included with the switcher, but you must 
supply the audio cable.

	 See figure 2-3 to wire a connector for the appropriate input type.  Use 
the supplied tie-wrap to strap the audio cable to the extended tail of the 
connector.

	

L
R

L
R

Unbalanced Stereo Input Balanced Stereo Input
Do not tin the wires!

Ring
Sleeve (s)

Tip
Sleeve

Tip
Sleeve

Tip

Tip
Ring

Figure 2-3 — Captive screw connector wiring for stereo audio inputs

C	 The captive screw audio connector can easily be inadvertently plugged 
partially into one receptacle and partially into an adjacent receptacle.  This 
misconnection could damage the audio circuits.  Ensure that the connector 
is plugged fully and only into the desired input or output.

N	 The length of exposed wires is critical.  The ideal length is 3/16" (5 mm).

•	 If the stripped section of wire is longer than 3/16", the exposed wires may 
touch, causing a short circuit between them.

•	 If the stripped section of wire is shorter than 3/16", wires can be easily pulled 
out even if tightly fastened by the captive screws.

	 See figure 2-4 to identify the tip, ring, and sleeve when you are making 
connections for the switcher from existing audio cables.  A mono audio 
connector consists of the tip and sleeve.  A stereo audio connector consists of 
the tip, ring and sleeve.  The ring, tip, and sleeve wires are also shown on the 
captive screw audio connector diagrams, figure 2-3, figure 2-5, and figure 2-6.

	

Tip (+)

Sleeve (   ) Sleeve (   )

Ring (-)

Tip (+)

RCA Connector 3.5 mm Stereo Plug Connector
(balanced)

Figure 2-4 — Typical audio connectors
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Mic/line audio input group

i	 Connections for mono audio inputs — Each input, numbered 15 through 
18, has a 3-pole, 3.5 mm captive screw connector for mono audio input.  
Connectors are included with the switcher, but you must supply the audio cable.

	 See figure 2-5 to wire a connector for mono audio input.  Use the supplied tie-
wrap to strap the audio cable to the extended tail of the connector.

	
Mic Input Wiring
(balanced, mono)

Mic Input Wiring
(unbalanced, mono)

Tip (+)

Jumper

Gnd (Sleeve,   )
Tip (+)

Ring (–)
Gnd (Sleeve,   )

Do not tin the wires!

Figure 2-5 — Captive screw connector wiring for mono audio inputs

N	 The length of exposed wires is critical.  The ideal length is 3/16” (5 mm).

•	 If the stripped section of wire is longer than 3/16”, the exposed wires may 
touch, causing a short circuit between them.

•	 If the stripped section of wire is shorter than 3/16”, wires can be easily pulled 
out even if tightly fastened by the captive screws.

j	 Phantom +48 V LEDs — These four LEDs, numbered 15 through 
18, light to indicate that +48 V phantom power is applied to the 
associated mic/line inputs.

Audio outputs

k	 Connections for balanced and unbalanced audio outputs — These 5-pole, 
3.5 mm captive screw connectors output the selected unamplified, line level 
audio.  Connect audio devices, such as an audio amplifier or powered speakers.

	 See figure 2-6 to properly wire an output connector.  Use the supplied tie-
wrap to strap the audio cable to the extended tail of the connector.

	 Unbalanced Stereo Output Balanced Stereo Output

L
R

Do not tin the wires!

Ring
Sleeve(s)

Tip

Tip
Ring

Sleeve(s)

Tip

Tip

NO GROUND HERE.

NO GROUND HERE.

Figure 2-6 — Captive screw connector wiring for stereo audio output

C	 For unbalanced audio, connect the sleeve(s) to the ground contact.  DO 
NOT connect the sleeve(s) to the negative (-) contacts).

N	 The length of exposed wires is critical.  The ideal length is 3/16” (5 mm).

•	 If the stripped section of wire is longer than 3/16”, the exposed wires may 
touch, causing a short circuit between them.

•	 If the stripped section of wire is shorter than 3/16”, wires can be easily pulled 
out even if tightly fastened by the captive screws.

PHANTOM
+48V

15 16

17 18
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Serial connections

l	 RS-232 connectors — Connect one or two host devices, such as computers, 
touch panel controls, or RS-232 capable PDAs to the switcher via these 
3-pole captive screw connectors for serial RS-232 control (figure 2-7).  Use the 
supplied tie-wrap to strap the serial cable to the extended tail of the connector.

	

FunctionPin
TX
RX
Gnd

Transmit data
Receive data
Signal ground

RS-232
PRIMARY

RS-232
SECONDARY

Tx  Rx

Tx  Rx

Controlling
Device

Ground (    )
Receive (Rx)
Transmit (Tx)

Ground (    )
Receive (Rx)
Transmit (Tx)

Bidirectional

Do not tin the wires!

Figure 2-7 — RS-232 connector

N	 The length of exposed wires is critical.  The ideal length is 3/16” (5 mm).

•	 If the stripped section of wire is longer than 3/16”, the exposed wires may 
touch, causing a short circuit between them.

•	 If the stripped section of wire is shorter than 3/16”, wires can be easily pulled 
out even if tightly fastened by the captive screws.

N	 These two ports are hardwired for RS-232 only.

	 The RS-232 Secondary port is active only if the front panel Configuration port 
is not in use.  If a front panel configuration connection is made, the rear panel 
RS-232 Secondary port becomes inactive and the front panel Configuration port 
is active.

N	 The switcher can operate at 9600, 19200, 38400, or 115200 baud rates. 
See “Selecting the RS-232 Primary port’s baud rate” in chapter 3, “Operation”, 
to configure the RS-232 Primary port from the front panel. 
See “Command/Response table for IP SIS commands”, in chapter 4, 
“SIS Programming and Control”, to configure all ports under SIS control.

	 If desired, connect an MKP 2000 or MKP 3000 remote control panel to the 
switcher’s RS-232 connector.  Refer to the MKP 2000 Remote Control Panel 
User’s Manual or the MKP 3000 Remote Control Panel User’s Manual for details.
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Ethernet connection

m	 LAN port — If desired, for IP control of the system, connect the 
matrix switcher to a PC or to an Ethernet LAN via this RJ-45 
connector.  You can use a PC to control the networked switcher 
with SIS commands from anywhere in the world.  You can also 
control the switcher from a PC that is either running Extron’s 
Windows-based control program or that has downloaded HTML 
pages from the switcher.

	 Ethernet connection indicators — The Link and Act LEDs indicate the status 
of the Ethernet connection.  The Link LED indicates that the switcher is 
properly connected to an Ethernet LAN.  This LED lights steadily.  The Act 
LED indicates transmission of data packets on the RJ-45 connector.  This LED 
flickers as the switcher communicates.

Cabling and RJ-45 connector wiring
It is vital that your Ethernet cables be the correct type cables, and that they be 
properly terminated with the correct pinout.  Ethernet links use Category (CAT) 3, 
CAT 5e or CAT 6, unshielded twisted pair (UTP) or shielded twisted pair (STP) 
cables, terminated with RJ-45 connectors.  Ethernet cables are limited to a length of 
328' (100 m).

N	 Do not use standard telephone cables.  Telephone cables will not support 
Ethernet or Fast Ethernet.

	 Do not stretch or bend cables.  Transmission errors can occur.

The cable used depends on your network speed.  The switcher supports both 
10 Mbps (10Base-T — Ethernet) and 100 Mbps (100Base-T — Fast Ethernet), 
half-duplex and full-duplex, Ethernet connections.

	 •	 10Base-T Ethernet requires CAT 3 UTP or STP cable at minimum.

	 •	 100Base-T Fast Ethernet requires CAT 5e UTP or STP cable at minimum.
The Ethernet cable can be terminated as a straight-through cable or a crossover 
cable and must be properly terminated for your application (figure 2-8).

	 •	 Crossover cable — Direct connection between the computer and the 
matrix switcher.

	 •	 Patch (straight) cable — Connection of the matrix switcher to an Ethernet 
LAN.

A cable that is wired as T568A at one end
and T568B at the other (Tx and Rx pairs
reversed) is a "crossover" cable.

A cable wired the same at both ends is
called a "straight-through" cable, because
no pin/pair assignments are swapped.

12345678

RJ-45
Connector

Insert Twisted
Pair Wires

Pins: Crossover Cable Straight-through Cable

Pin

1

2

3

4

5

6

7

8

Wire color

White-green

Green

White-orange

Blue

White-blue

Orange

White-brown

Brown

Wire color

T568A T568B

End 1 End 2 End 1 End 2

White-orange

Orange

White-green

Blue

White-blue

Green

White-brown

Brown

Pin

1

2

3

4

5

6

7

8

Wire color

White-orange

White-green

Blue

White-blue

White-brown

Brown

Wire color

T568BT568B

White-orange

OrangeOrange

White-green

Blue

White-blue

GreenGreen

White-brown

Brown

Figure 2-8 — RJ-45 connector and pinout tables

Link
LED

Activity
LED
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Reset button

n	 Reset button and LED — The Reset button initiates four levels 
of reset to the matrix switcher.  The LED indicates the reset mode 
activated.  Press and hold the button while the switcher is running or 
while you power up the switcher for different reset levels.

	 See “Rear panel Operations” in chapter 3, “Operation”, for details.

•	 Events (mode 3) reset — Toggles events monitoring on and off.

•	 IP settings (mode 4) reset — Resets the switcher’s IP functions.

N	 IP settings reset does not replace any user-installed firmware.

•	 Absolute (mode 5) reset — Restores the switcher to the default factory 
conditions.

•	 Hard (mode 1) reset — Restores the switcher to the base firmware.

N	 Hard reset does not clear the current configuration.

Power

o	 AC power connector — Plug a standard IEC power cord into this connector to 
connect the switcher to a 100 VAC to 240 VAC, 50-60 Hz power source.

RESET
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Front Panel Configuration Port

AUDIOVIDEO

I/OCONTROL

ENTER PRESET VIEW ESC

PRESENTATION MATRIX SWITCHER

MPX PLUS 866 A

CONFIG

1

Figure 2-9 — Front panel configuration port

a	 Configuration port — This 2.5 mm mini stereo jack serves the same serial 
communications function as the rear panel Remote port, but it is easier to 
access than the rear port after the matrix switcher has been installed and 
cabled.  The optional 9-pin D to 2.5 mm stereo mini TRS RS‑232 cable, 
part #70-335-01 (figure 2-10) can be used for this connection.

6 feet
(1.8 m)

Part #70-335-01

5

1

9

6

Sleeve (Gnd)

Ring

Tip

 9-pin D Connection TRS Plug

 Pin 2 Computer's RX line Tip
 Pin 3 Computer's TX line Ring
 Pin 5 Computer's signal ground Sleeve

Figure 2-10 — Optional 9-pin TRS RS-232 cable

N	 This port is completely separate from the rear panel Remote port and is not 
affected by changes to the rear panel port’s protocol.  This front panel port’s 
protocol can be changed, under SIS command control only.

	 This port is RS-232 only, with its default protocols as follows:

•	 9600 baud	 •	 no parity	 •	 8-bit
•	 1 stop bit	 •	 no flow control

N	 The Configuration port can operate at 9600, 19200, 38400, or 115200 baud 
rates.  See “Command/Response table for IP SIS commands”, in chapter 4, “SIS 
Programming and Control”, to configure all ports under SIS control.

N	 The maximum distances from the matrix switcher to the controlling device 
can vary up to 200 feet (61 m).  Factors such as cable gauge, baud rates, 
environment, and output levels (from the switcher and the controlling device) 
all affect transmission distance.  Distances of about 50 feet (15 m) are typically 
not a problem.  In some cases the matrix switcher may be capable of serial 
communications via RS‑232 up to 250 feet (76 m) away.
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Front Panel Controls and Indicators
The front panel controls (figure 3-1) are grouped into two sets.  The input and 
output buttons are grouped on the left side of the control panel.  The control 
buttons and video/audio (I/O) selection buttons are grouped on the right side of 
the panel.

The illuminated pushbuttons can be labeled with text and/or graphics.  The 
buttons can be set to provide amber background illumination all the time or 
the background illumination can be turned off (see “Background illumination”, 
on page 3-45).  The buttons blink or are lit at full intensity (depending on the 
operation) when selected.

AUDIOVIDEOENTER PRESET VIEW ESC

PRESENTATION MATRIX SWITCHER

MPX PLUS 866 A

COMPUTER INPUTS

1 2 3 4 5 6 7 8 9 10 11 12 13 14

1 2 3 4 5 6 7 8 9 10 11 12

VIDEO INPUTS

VIDEO OUTPUTS

CONFIG

COMPUTER/AUDIO OUTPUTS

I/OCONTROL

1 2

3 4 1098765

Figure 3-1 — MPX Plus 866 A

a	 Computer Inputs buttons — See page 3-4.

b	 Video Inputs buttons — See page 3-4.

c	 Computer/Audio Outputs buttons — See page 3-4.

d	 Video Output buttons — See page 3-4.

e	 Enter button — See page 3-5.

f	 Preset button — See page 3-6.

g	 View button — See page 3-6.

h	 Esc button — See page 3-6.

i	 Video button — See page 3-7.

j	 Audio button — See page 3-7.
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Input and output buttons

Primary functions
Action: Select input or output for tie being created.

Indications: Blinking: potential tie/untie 
Lit: current tie 

Amber: video and audio tie 
Green: video only tie 
Red: audio only tie

1 2 3
     

through 7 8
 
14

Secondary functions
Presets Action/ 

indication:
Select a preset in Preset mode. 

Lit: A preset has already been saved to this location. 
Blinking: Preset location is selected to be saved.

RGB Delay Indication: Output 1 through 10: Indicate the RGB delay.

Input 
configuration

Action/ 
indication: 
(outputs)

Select/
indicate 

composite 
video

Select/
indicate 
S-video

Input audio 
level

Action/ 
indication: 
(inputs)

Inputs: Select the input’s audio for gain or attenuation adjustment. 
Lit: Input’s audio is selected for adjustment.

Indication: 
(outputs)

Indicate the input gain or attenuation level.

Output audio 
volume

Action/ 
indication: 
(outputs)

Outputs: Select the output’s audio for volume adjustment. 
Lit: Output’s audio is selected for adjustment.

Indication: 
(inputs)

Inputs 1 through 12: Indicate the output volume level.

Mutes Action/
indication:

Outputs: Press and hold to mute the video and audio, video, or audio output. 
Outputs blink: Output is muted.

Background 
illumination

Action: Press and hold to toggle 
between background 

illumination or buttons 
unlit.
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Input buttons

a	 Computer video inputs 1 through 8 — Select and identify computer video 
group inputs.

b	 Low resolution video inputs 9 through 14 — Select and identify low 
resolution video group inputs.

	 The input buttons have one primary function (•) and four secondary (❏) 
functions:

•	 Select and identify an input.

N	 •	 Computer inputs 1 through 8 video can be tied only to outputs 1 through 6.
•	 Video inputs 9 through 14 video can be tied only to outputs 7 through 12.
•	 Audio can be tied only to outputs 1 through 6.  If you make a video and audio 

tie from the low resolution video group (inputs 9 through 14), audio is tied to 
an output in the computer group (outputs 1 through 6).

•	 “Input selection” includes selecting Video inputs 11 through 14 for video 
configuration (S-video or composite).

❏	 Select a preset.  See “Using presets” on page 3-28.

❏	 Display the RGB delay.  See “Setting RGB delay (computer video group 
only)” on page 3-23.

N	 Although the low resolution video input buttons display part of the RGB delay 
value, the delay itself is applied only to ties within the computer video group.

❏	 Display the output volume level.  See “Viewing and adjusting the output 
volume” on page 3-38.

❏	 (Input 1 and Input 2) Toggle background illumination of the buttons on 
and off.  See “Background illumination” on page 3-45.

Output buttons

c	 Computer/Audio outputs 1 through 6 — Select and identify computer video 
group outputs.

d	 Low resolution video outputs 7 through 12 — Select and identify low 
resolution video group outputs.

	 The output buttons have one primary function (•) and four secondary (❏) 
functions:

•	 Select and identify one or more output(s).

N	 •	 Computer outputs 1 through 6 can accept a video tie only from inputs 1 
through 8.

•	 Video outputs 7 through 12 video can accept a video tie only from inputs 9 
through 14.

❏	 Select a preset.  See “Using presets” on page 3-28.

❏	 Mute the output.  See “Muting and unmuting video and/or audio 
outputs” on page 3-31.

❏	 (Output 7 and Output 8) select S-video or composite video for inputs 11 
through 14.  See “Selecting S-video composite or video” on page 3-26.

❏	 Display the audio level of the selected input.  See “Viewing and adjusting 
the input audio level” on page 3-34.
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Control buttons

Primary functions
Action: Save changes Select Preset mode Select View mode Cancel/escape

Indication: Blinking: save needed Blinking: Save preset 
Lit: Recall preset

View mode selected Flashes once

ENTER PRESET VIEW ESC

Secondary functions
Port 

configuration
Action 1: Select Configuration mode

Action 2/
indication:

Select 9600 baud. 
Blinking: selected

Select 19200 baud. 
Blinking: selected

Select 38400 baud. 
Blinking: selected

Select 115200 baud. 
Blinking: selected

Front panel 
locks

Action: With Video and 
Audio buttons, select 
Lock mode 2 and/or 

toggle between mode 
0 and mode 2.

RGB delay Action: Computer video output group:

In Video mode, 
decrease the 

switching interval.

In Video mode, 
increase the 

switching interval.

Audio Action: In Audio mode, 
decrease input level 
or output volume.

In Audio mode, 
increase input level 
or output volume.

e	 Enter button — The Enter button has one primary function (•) and three 
secondary (❏) functions:

•	 Save configuration or preset changes that you make on the front panel 
and indicate that a potential change has been created but not saved.  To 
create a simple configuration:

	 Specify video, audio, or both (see I/O selection buttons [i] and [j])
	 Press the desired input button (a or b)
	 Press the desired output button(s) (c or d)
	 Press the Enter button.

N	 •	 Video outputs in the computer video group (c) can be tied only to a 
computer video input (a).

•	 Video outputs in the low resolution video group (d) can be tied only to a 
low resolution video input (b).

•	 Audio can be tied only to outputs 1 through 6.  If you make a video and 
audio tie from the low resolution video group (inputs 9 through 14), audio is 
automatically tied to an output in the computer group (outputs 1 through 6).

❏	 With the Preset, View, and Esc buttons, select Serial Port Selection and 
Configuration mode.  See “Selecting the RS-232 Primary port’s baud rate” 
on page 3-42.

❏	 Select 9600 baud for the rear panel RS-232 port in Serial Port Selection and 
Configuration mode and indicate the selection.  See “Selecting the RS-232 
Primary port’s baud rate” on page 3-42.

❏	 With the Video and Audio buttons, select front panel security 
Lock mode 2 or toggle between mode 0 (unlocked) and mode 2.  See 
“Setting the front panel locks (Executive modes)” on page 3-44.
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f	 Preset button — The Preset button has two primary functions (•) and two 
secondary (❏) functions:

•	 Activates Save Preset mode to save a configuration as a preset and blinks 
to indicate the selection.

•	 Activates Recall Preset mode to activate a previously-defined preset and 
lights steadily to indicate the selections.

❏	 With the Enter, View, and Esc buttons, select Serial Port Selection and 
Configuration mode.  See “Selecting the RS-232 Primary port’s baud rate” 
on page 3-42.

❏	 Select 19200 baud for the RS-232 Primary port in Serial Port Selection and 
Configuration mode and indicate the selection.  See “Selecting the RS-232 
Primary port’s baud rate” on page 3-42.

g	 View (<) button — The View (<) button has one primary function (•) and 
five secondary (❏) functions:

•	 Select View-Only mode, which displays the current configuration and 
indicates the selection.

N	 View-only mode also provides a way to mute and unmute the outputs.  See 
“Muting and unmuting video and/or audio outputs” on page 3-31.

❏	 Decrease the RGB delay of switches to the selected output.  See “Setting 
RGB delay (computer video group only)” on page 3-23.

❏	 Decrease the audio level of the selected input.  See “Viewing and 
adjusting the input audio level” on page 3-34.

❏	 Decrease the volume of the selected output.  See “Viewing and adjusting 
the output volume” on page 3-38.

❏	 With the Enter, Preset, and Esc buttons, select Serial Port Configuration 
mode.  See “Selecting the RS-232 Primary port’s baud rate” on page 3-42.

❏	 Select 38400 baud for the RS-232 Primary port in Serial Port Selection and 
Configuration mode, and indicate the selection  See “Selecting the RS-232 
Primary port’s baud rate” on page 3-42.

h	 Esc (>) button — The Esc (>) button has one primary function (•) and five 
secondary (❏) functions:

•	 Cancel operations or selections in progress and reset the front panel 
indicators and flashes once to indicate that the function has been activated.

N	 The Esc (>) button does not reset the current configuration, the Video selection 
button and Audio selection button, any presets, or any audio gain or attenuation 
or volume settings.

❏	 Increase the RGB delay of switches to the selected output.  See “Setting 
RGB delay (computer video group only)” on page 3-23.

❏	 Increase the audio level of the selected input.  See “Viewing and adjusting 
the input audio level” on page 3-34.

❏	 Increase the volume of the selected output.  See “Viewing and adjusting 
the output volume” on page 3-38.

❏	 With the Enter, Preset, and View buttons, select Serial Port Configuration 
mode.  See “Selecting the RS-232 Primary port’s baud rate” on page 3-42.

❏	 Select 115200 baud for the RS-232 Primary port in Serial Port Selection and 
Configuration mode, and indicate the selection  See “Selecting the RS-232 
Primary port’s baud rate” on page 3-42.
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I/O controls

Primary functions
Action/ 
indication:

Select video. 
Green when selected

Select audio. 
Red when selected

VIDEO AUDIO

Secondary functions
Front panel 

locks
Action 1: With Enter, select Lock mode 2 and/or toggle between mode 0 and mode 2.

Action 2: Select Lock mode 1 and/or toggle between mode 2 and mode 1.

RGB delay/ 
Input 11 - 14 

format

Action/
indication:

Select Video mode. 
Blinks green.

Resets Action: Perform a system reset

Audio Action/
indication:

Select Audio mode. 
Blinks red.

i	 Video button — The Video button has one primary function (•) and four 
secondary (❏) functions:

•	 Selects and deselects video for a configuration that is being created or 
viewed and lights to indicate the selection.

❏	 With the Enter button and Audio button, selects between front panel 
locks (Lock mode 2 and Lock mode 0).  See “Setting the front panel locks 
(Executive modes)” on page 3-44.

❏	 With the Audio button, selects between front panel locks (Lock mode 2 
and Lock mode 1).  See “Setting the front panel locks (Executive modes)” 
on page 3-44.

❏	 With the Audio button, commands the front panel system reset.  See 
“Performing a system reset from the front panel” on page 3-46.

❏	 Selects the Video mode, in which you can set the RGB delay and select 
the input formats for inputs 11 through 14.  See “Setting RGB delay 
(computer video group only)” on page 3-23.

j	 Audio button — The Audio button has one primary function (•) and four 
secondary (❏) functions

•	 Selects and deselects audio for a configuration that is being created or 
viewed and lights to indicate the selection.

❏	 Selects the Audio mode, in which you can adjust the input audio level and 
the output audio volume.  See “Viewing and adjusting the input audio 
level” on page 3-34 and “Viewing and adjusting the local output volume” 
on page 3-38.

❏	 With the Enter button and RGBHV/Video button, selects between front 
panel locks (Lock mode 2 and Lock mode 0).  See “Setting the front panel 
locks (Executive modes)” on page 3-44.

❏	 With the RGBHV/Video button, selects between front panel locks (Lock 
mode 2 and Lock mode 1).  See “Setting the front panel locks (Executive 
modes)” on page 3-44.

❏	 With the Video button, commands the front panel system reset. 
See “Performing a system reset from the front panel” on page 3-46.
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Button icons
The numbered translucent covers on the input and output pushbuttons can be 
removed and replaced to insert labels behind the covers.

Input and output labels can be created easily with Extron’s Button-Label Generator 
software, which ships with every Extron matrix switcher.  Each input and output 
can be labeled with names, alphanumeric characters, or even color bitmaps 
for easy and intuitive input and output selection (figure 3-2).  See chapter 5, 
“Switcher Software”, for details on using the labeling software.  See appendix C, 
“Reference Information”, for blank labels and a procedure for removing and 
replacing the translucent covers.

9 11 13 14

7 9 10 11 12

VIDEO INPUTS

VIDEO OUTPUTS

VCR DVD

Document
Camera

Figure 3-2 — Sample button icons

Front Panel Operations
The following paragraphs detail the power-up process and then provide sample 
procedures for the following actions:

	 •	 Creating ties, sets of ties, and configurations

	 •	 Changing a configuration

	 •	 Viewing ties, sets of ties, and configurations

	 •	 Setting RGB delay for ties to outputs 1 through 6

	 •	 Selecting the composite or S-video formats for inputs 11 through 14

	 •	 Saving a preset

	 •	 Recalling a preset

	 •	 Muting and unmuting outputs

	 •	 Viewing and adjusting the input audio level

	 •	 Viewing and adjusting the output volume

	 •	 Reading and setting the RS-232 Primary port settings

	 •	 Locking the front panel

	 •	 Setting background illumination

	 •	 Performing front panel resets
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Definitions
The following terms, which apply to Extron matrix switchers, are used throughout 
this manual:

	 Tie — An input-to-output video and/or line audio connection.

	 Set of ties — An input tied to two or more outputs.  (An output can never be tied 
to more than one input.)

	 Configuration — One or more ties, one or more sets of ties, and/or  some or all of 
the signal processor settings made in the DSP Configurator program.

	 Current configuration — The configuration that is currently active in the 
switcher (also called configuration 0)

	 Partial (DSP-Configurator-created) preset — A partial configuration (a subset of 
ties and/or sets of ties and/or signal processor settings) that has been stored.

N	 Partial presets can be created only by using the DSP Configurator program.  
They can be recalled via any means.  When recalled (by any means), partial 
presets overwrite only a portion of the current configuration, leaving other ties 
and settings unchanged.

	 Global ties preset — A full, ties only, configuration that has been created via the 
front panel, SIS commands, or the Matrix Switchers Control Program.

N	 Up to 32 partial or global ties presets can be stored in memory.  Preset locations 
are assigned to the input buttons and output buttons.  Up to 26 preset locations 
can be selected from the front panel for either saving or retrieving.  When a 
preset is retrieved from memory, it becomes the current configuration (global 
ties preset) or part of the current configuration (partial preset).  Preset numbers 
larger than 26 are accessible under RS-232 or Ethernet control.

Front panel security lockouts
In the procedural descriptions that follow, it is assumed that the switcher is in Lock 
mode 0 (fully unlocked).  The following two Lock modes are also available:

	 •	 Lock mode 1 — All changes are locked from the front panel (except for setting 
Lock mode 2).  Some functions can be viewed.

	 •	 Lock mode 2 — Advanced features are locked and can be viewed only.  Basic 
functions, such as tie creation, are unlocked.

N	 The switcher is shipped from the factory in Lock mode 2.

See “Setting the front panel locks (Executive modes)” on page 3-44 for a detailed list 
of basic and advanced functions and the procedure to set the various front panel 
locks.
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Power
Apply power by connecting a power cord between an AC source and the rear panel 
power connector.  The switcher performs a self-test that flashes the front panel 
button indicators green, red, and amber and then turns them off.  An error-free 
power up self-test sequence leaves all input, output, and control buttons either unlit 
or showing background illumination and the Video button and the Audio button 
lit.

The current configuration and all presets are saved in non-volatile memory.  When 
power is applied, the most recent configuration is retrieved.  The previous presets 
remain intact.

If an error occurs during the self-test, the switcher locks up and does not operate.  
If your switcher locks up on power-up, call the Extron S3 Sales & Technical Support 
Hotline.  See the rear cover of this manual for the phone number in your region of 
the world.

Creating a configuration
The current configuration can be changed using the front panel buttons.  Change 
the current configuration as follows:

1.	 Press the Esc button to clear any input button indicators, output button 
indicators, or control button indicators that may be lit.

2.	 Select to configure video, audio, or both by pressing the Video button and/or 
Audio button.

3.	 Select the desired input and output(s) by pressing the input and output buttons.

	 The input button lights.  The output buttons light or blink as follows:

•	 Amber to indicate video and audio ties

•	 Green to indicate video only ties

•	 Red to indicate audio only ties.

	 To indicate tentative ties, output buttons blink the appropriate color when an 
input is selected.

	 To indicate current ties, output buttons light steadily the appropriate color 
when an input is selected.

	 To clear unwanted outputs, press and release the associated lit output buttons.  
To indicate tentative unties, output buttons blink the appropriate color when 
an output is deselected but not untied from the input.

4.	 Press and release the Enter button to accept the tie.

5.	 Repeat steps 1 through 4 to create additional ties until the desired 
configuration is complete.
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N	 •	 Video ties cannot be made between the computer video group and the low 
resolution video group (figure ).

	

AUDIOVIDEO

COMPUTER INPUTS

1 2 3 4 5 6 7 8 9 10 11 12 13 14

1 2 3 4 5 6 7 8 9 10 11 12

VIDEO INPUTS

VIDEO OUTPUTSCOMPUTER/AUDIO OUTPUTS

I/O

		  Figure 3-3 — Video ties

•	 Audio ties can only be made to the computer video/audio group 
(outputs 1 through 6) (figure ).

	

AUDIOVIDEO

COMPUTER INPUTS

1 2 3 4 5 6 7 8 9 10 11 12 13 14

1 2 3 4 5 6 7 8 9 10 11 12

VIDEO INPUTS

VIDEO OUTPUTSCOMPUTER/AUDIO OUTPUTS

I/O

		  Figure 3-4 — Audio ties

•	 Video and audio ties between the low resolution video input group and the 
low resolution video output group are always made with the audio redirected.  
In such an operation, the switcher automatically ties the audio to an output 
in the computer video/audio outputs group (outputs 1 through 6) as follows:

	 If the video is tied to output 7, the audio is tied to output 1. 
	 If the video is tied to output 8, the audio is tied to output 2. 
	 If the video is tied to output 9, the audio is tied to output 3. 
	 If the video is tied to output 10, the audio is tied to output 4. 
	 If the video is tied to output 11, the audio is tied to output 5. 
	 If the video is tied to output 12, the audio is tied to output 6.

•	 If video is selected for configuration (the Video LED is lit) and you press the 
input button for an input in one group and then try to select an output in the 
other group, the associated output button cannot be selected.  The associated 
input LED remains lit.

•	 Audio from the mic group cannot be selected from the front panel.  Audio in 
this group can be selected only under serial port or Ethernet control.

•	 Only one video input and one audio input can be tied to an output.

•	 If a tie is made between an input and an output, and the selected output was 
previously tied to another input, the older tie is broken in favor of the newer 
tie.

•	 If an input with no tie is selected, only that input’s button lights.

•	 When the Video button and Audio button are lit, if an input with an audio 
tie but no video tie is selected, the output button lights the appropriate color 
(amber, green, or red).

•	 As each input and output is selected, the associated output button blinks the 
appropriate color to indicate a tentative tie.  Buttons for output(s) that were 
already tied to the input light the appropriate color steadily.  Outputs that are 
already tied can be left on, along with new blinking selections, or toggled off 
by pressing the associated output button.
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Example 1: Creating a set of computer video and audio ties
In the following example, input 5 is tied to outputs 3, 4, and 6.  The steps show the 
front panel indications that result from your action.

N	 This example assumes that there are no ties in the current configuration.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select video and audio for the tie: If necessary, press and release the Video 
button and the Audio button until the buttons light.

	

I / O

VIDEO AUDIO

Press the Video button to toggle on and off.

The button lights green when selected.

Press the Audio button to toggle on and off.

The button lights red when selected.

3.	 Select an input: Press and release the input 5 button.

	

COMPUTER INPUTS

1 2 3 4 5 6 7 8

Press and release the Input 5 button.
The button lights amber to indicate that the video and audio 
signals on this input will be tied to the output(s) you select next.

4.	 Select the outputs: Press and release the output 3, output 4, and output 6 
buttons.

	

C O N T R O L

PRESETENTER ESCVIEW
1 2 3 4 5 6

COMPUTER/AUDIO OUTPUTS

Press and release the Output 3, Output 4, and Output 6 buttons.
The buttons blink amber to indicate that the video and audio 
signals on the selected input will be tied to these outputs.

The Enter button blinks 
green to indicate the need to 
confirm the change.

N	 The entire set of potential ties can be canceled at this point by pressing and 
releasing the Esc button.  The Esc button flashes green once.
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5.	 Confirm the change: Press and release the Enter button.

	

ENTER All input buttons and output buttons
return to unlit or background illumination.

Press the Enter button to 
confirm the configuration 
change.

The Enter button returns to 
unlit or background 
illumination.

	 The current configuration is now:

•	 Input 5 video and audio tied to output 3, output 4, and output 6

		

Input 5 (video/audio) tied
to outputs 3, 4, and 6.

Input

Output
3
4

6

5

Video
Audio
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Example 2: Adding a tie to a set of computer video and audio ties
In the following example, a new video tie is added to the current configuration.  
The steps show the front panel indications that result from your action.

N	 This example assumes that you have performed example 1.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select video only for the tie: If necessary, press and release the Video button 
and the Audio button.

I / O

VIDEO AUDIO

Press the Video button to toggle on and off.
The button lights green when selected.

Press the Audio button to toggle on and off.
The button is unlit or background illuminated when deselected.

3.	 Select an input: Press and release the input 5 button.

COMPUTER INPUTS

1 2 3 4 5 6 7 8 1 2 3 4 5 6
COMPUTER OUTPUTS

Press and release the Input 5 button.
The button lights green to indicate that the video signal on this 
input will be tied to or untied from the output(s) you select next.

The Output 3, Output 4, and Output 6 
buttons light green to indicate the 
video ties created in example 1.

4.	 Select the output: Press and release the output 1 button.

	

1 2 3 4 5 6

The Enter button blinks 
green to indicate the need to 
confirm the change.

C O N T R O L

PRESETENTER ESCVIEW

COMPUTER/AUDIO OUTPUTS

Press and release the Output 1 button.
The button blinks green to indicate that the selected 
RGBHV input only will be tied to this output.
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5.	 Confirm the change: Press and release the Enter button.

	

ENTER All input buttons and output buttons
return to unlit or background illumination.

Press the Enter button to 
confirm the configuration 
change.

The Enter button returns to 
unlit or background 
illumination.

	 The current configuration is now:

•	 Video — Input 5 video tied to output 1, output 3, output 4, and output 6

•	 Audio — Input 5 audio tied to output 3, output 4, and output 6

		

Input 5 video tied
to outputs 1, 3, 4, and 6.

Input 5 audio tied
to outputs 3, 4, and 6.

Input

Output

1

3
4

6

5

Video
Audio
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Example 3: Removing a tie from a set of video and audio ties
In the following example, an existing audio tie is removed from the current 
configuration.  The steps show the front panel indications that result from your 
action.

N	 This example assumes that you have performed example 1 and example 2.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select audio only for the tie: If necessary, press and release the Video button 
and the Audio button.

	

I / O

VIDEO AUDIO

Press the Video button to toggle on and off.

The button is unlit or background illuminated
when deselected.

Press the Audio button to toggle on and off.
The button lights red when selected.

3.	 Select an input: Press and release the input 5 button.

	

1 2 3 4 5 6

COMPUTER INPUTS

1 2 3 4 5 6 7 8

COMPUTER/AUDIO OUTPUTS

The Output 1 button does not light to indicate the tie 
created in example 2 because that tie is video only.

The Output 3, Output 4, and Output 6 buttons light 
red to indicate the audio ties created in example 1.

Press and release the Input 5 button.
The button lights red to indicate that the audio signal on this 
input will be tied to or untied from the output(s) you select next.

4.	 Select the output: Press and release the output 4 button.

	

C O N T R O L

PRESETENTER ESCVIEW

1 2 3 4 5 6
COMPUTER OUTPUTS

Press and release the Output 4 button.
The button blinks red to indicate the pending change:  
audio input will be untied.

The Enter button blinks 
green to indicate the need to 
confirm the change.
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5.	 Confirm the change: Press and release the Enter button.

	

ENTER All input buttons and output buttons
return to unlit or background illumination.

Press the Enter button to 
confirm the configuration 
change.

The Enter button returns to 
unlit or background 
illumination.

	 The current configuration is now:

•	 Video — Input 5 video tied to output 1, output 3, output 4, and output 6
•	 Audio — (audio models) Input 5 audio tied to output 3 and output 6

		

Input 5 video tied
to outputs 1, 3, 4, and 6.

Input 5 audio tied
to outputs 3 and 6.

Input

Output

1

3
4

6

5

Video
Audio
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Example 4: Creating a set of low resolution video and audio ties
N	 This example shows the unusual indications that occur when you make video 

and audio ties in the low resolution video group.

In the following example, low resolution input 12 is tied to outputs 7 and 8. 
The steps show the front panel indications that result from your action.

N	 This example does not build on examples 1, 2, and 3.  It assumes that there are 
no ties in the current configuration.

N	 When creating video and audio ties in the low resolution video group, audio 
must be redirected (tied to a different, but corresponding, output than the video) 
because there are only audio outputs 1 through 6.  In this case, the audio is tied 
to an output in the computer video/audio group.

	 •	 If the video is tied to output 7, the audio is tied to output 1. 
•	 If the video is tied to output 8, the audio is tied to output 2. 
•	 If the video is tied to output 9, the audio is tied to output 3. 
•	 If the video is tied to output 10, the audio is tied to output 4. 
•	 If the video is tied to output 11, the audio is tied to output 5. 
•	 If the video is tied to output 12, the audio is tied to output 6.

N	 If you select an input in the low resolution video input group (inputs 9 through 
14), you can select outputs only in the low resolution video output group 
(outputs 7 through 12).  The switcher automatically redirects the audio.  This 
restriction applies to tying and untying,

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select video and audio for the tie: If necessary, press and release the Video 
button and the Audio button until the LEDs light.

	

I / O

VIDEO AUDIO

Press the Video button to toggle on and off.

The button lights green when selected.

Press the Audio button to toggle on and off.

The button lights red when selected.

3.	 Select an input: Press and release the low resolution Input 12 button.

	
9 10 11 12 13 14

VIDEO INPUTS

Press and release the Input 12 button.
The button lights amber to indicate that the video signal on this 
input will be tied to or untied from the output(s) you select next.
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4.	 Select the outputs: Press and release the low resolution Output 7 and 
Output 8 buttons.

	

C O N T R O L

PRESETENTER ESCVIEW
7 8 9 10 11 12

VIDEO OUTPUTS

1 2 3 4 5 6
COMPUTER/AUDIO OUTPUTS

Press and release the Video Output 7 and Output 8 buttons.
The buttons blink green to indicate that the selected low 
resolution video input will be tied to these outputs.

The Enter button blinks 
green to indicate the need to 
confirm the change.

The Computer Output 1 and Output 2 
buttons blink red to indicate that the selected 
audio input will be tied to these outputs.

5.	 Confirm the change: Press and release the Enter button.

	

ENTER All input buttons and output buttons
return to unlit or background illumination.

Press the Enter button to 
confirm the configuration 
change.

The Enter button returns to 
unlit or background 
illumination.

	 The current configuration is now:

•	 Video — Input 12 video tied to output 7 and output 8

•	 Audio — Input 12 audio tied to output 1 and output 2

		

Input 12 video tied
to outputs 7 and 8.
Input 12 audio tied
to outputs 1 and 2.

Output

1
2

7
8

Video
Audio

Input
12
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Viewing a configuration
The current configuration can be viewed using the front panel buttons.  The 
View-Only mode prevents inadvertent changes to the current configuration.  
View-Only mode also provides a way to mute video and audio outputs (see 
“Muting and unmuting video and/or audio outputs” on page 3-31.

View the current configuration as follows:

1.	 Press the Esc button to clear any input button indications, output button 
indications, or control button indications that may be on.

2.	 Press and release the View button.  All of the buttons for outputs that are not 
tied light:

	 •	 Amber: No tied video or audio input
	 •	 Green: No tied video input
	 •	 Red: No tied audio input

3.	 Select video, audio, or both to view by pressing the Video button and/or the 
Audio button.

4.	 Select the desired input or output(s) whose ties you wish to view by pressing 
the input and output buttons.

N	 •	 When you enter View-Only mode, the output buttons light for all outputs 
without ties.  Likewise, when an output button for which there are no ties is 
pushed, the output buttons turn on for all outputs without ties.

•	 To see all ties of the current configuration, press and release each input and 
output button, one at a time, with the Video button and the Audio button lit.

•	 In View-Only mode, you can view video and audio, video-only, or audio-only 
ties.  Pressing and releasing the Video button and the Audio button toggles 
each on and off.

•	 When you view video and audio ties, the Video button is lit green and the 
Audio button is lit red.  After you select an input or output, the output 
buttons light different colors to show where video and audio ties are not the 
same (audio is broken away) as follows:

	 Amber = video and audio 
	 Green = video only 
	 Red = audio only

Example 5: Viewing video and audio, audio only, and video only ties
The following example shows the viewing of the video and audio, audio-only, 
and video-only ties in the current configuration.  The steps show the front panel 
indications that result from your action.

N	 This example assumes that you have performed example 1, example 2, and 
example 3.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.
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2.	 Select View-only mode: Press and release the View button.  The View button 
lights red.

3.	 Select video and audio for viewing: If necessary, press and release the Video 
button and the Audio button.

	

I / O

VIDEO AUDIO

7 8 9 10 11 12
VIDEO OUTPUTS

1 2 3 4 5 6
COMPUTER/AUDIO OUTPUTS

Until you select an input, the buttons for all untied outputs light the appropriate color:
•   Amber if no inputs are tied
•   Green if no video inputs are tied (only audio is tied)
•   Red if no audio inputs are tied (only video is tied).

NOTE   Video Outputs buttons can only 
light green when no input is tied 
because audio cannot be tied to 
the low resolution video outputs.

Press the Audio button 
to toggle on and off.

The button lights red 
when selected.

Press the Video button 
to toggle on and off.

The button lights 
green when selected.

4.	 Select an input: Press and release the input 5 button.

	

1 2 3 4 5 6

COMPUTER INPUTS

1 2 3 4 5 6 7 8

COMPUTER/AUDIO OUTPUTS

The output buttons for outputs that are not tied to 
Input 5 are either unlit or background illuminated.

NOTE   Video Outputs buttons not shown;
all are unlit or background illuminated.

The output buttons for outputs that are tied to Input 5 
light the appropriate color:
•   Amber if video and audio are tied
•   Green if only video inputs are tied (no audio is tied)
•   Red if only audio inputs are tied (no video is tied).

Press and release the Input 5 button.
The button lights amber.

N	 A set of ties can also be viewed by selecting a tied output.  To demonstrate this, 
note the number of a lit output button, and then press and release the output 
button for an untied (unlit or background illumination) output.  Observe that 
all of the untied outputs light.  Then press the output button that you noted 
previously and observe that the selected output button, the tied input button 
(input 5), and the output buttons light for all of the outputs that are tied to the 
input.
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5.	 Deselect video (select audio only): Press and release the Video button.

	

1 2 3 4 5 6

I / O

VIDEO AUDIO

COMPUTER/AUDIO OUTPUTS

The output buttons for outputs that are not tied to 
Input 5 are either unlit or background illuminated.

NOTE   Video Outputs buttons not shown;
all are unlit or background illuminated.

Press the Video button to 
deselect it.

The button is unlit or 
background illuminated 
when deselected.

The Audio button 
remains lit red to 
indicate that only 
audio is selected.

The output buttons for outputs that are tied to Input 5 light red 
to indicate audio ties (audio breakaway).

6.	 Deselect audio (select video only): Press and release the Video button and the 
Audio button.

	

I / O

VIDEO AUDIO

1 2 3 4 5 6
COMPUTER/AUDIO OUTPUTS

The output buttons for outputs that are tied to Input 5 
light green to indicate video ties (audio breakaway).

Press the Video 
button to select it.

The button lights 
green when selected.

Press the Audio 
button to deselect it.

The button is unlit 
or background 
illuminated when 
deselected.

The output buttons for outputs that are not tied to 
Input 5 are either unlit or background illuminated.

NOTE   Video Outputs buttons not shown;
all are unlit or background illuminated.

	 If video ties are established for input 5, the output buttons for all video 
outputs tied to input 5 light green.  If no ties are established for input 5, all 
output buttons return to either unlit or to background illumination.

7.	 Exit View-only mode: Press and release the View button.

	

All input buttons and output buttons
return to unlit or background illumination.

VIEW

Press the View button 
to exit View-Only mode.

The View button returns to 
unlit or background 
illumination.
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Setting RGB delay (computer video group only)
The switcher can briefly blank the red, green, and blue planes of a Computer Video 
output while a tie is made to it.  This allows a brief delay for the display to adjust 
to the tied input’s sync timing before displaying the new picture, which will appear 
without glitches.  RGB delay, also known as Triple-Action Switching™ or video 
mute switching, is user selectable from 0 to 5 seconds, in half-second increments.

The RGB delay interval can be set on the front panel or by using the RS-232 and 
Ethernet ports and either the SIS, Windows control program, or HTML pages (see 
chapter 4, “SIS Programming and Control”, chapter 5, “Switcher Software”, and 
chapter 6, “HTML operation”.  Specify the RGB delay interval for a specific output 
on the front panel as follows:

N	 RGB delay is protected when front panel lock mode 2 is selected.  You can view 
the delay in lock mode 2, but not change it from the front panel.  See “Setting 
the front panel Locks (Executive modes)” on page 3-44.

1.	 Press the Esc button to clear any input buttons, output buttons, or control 
buttons that may be lit.

2.	 To enter Video mode, press and hold the Video button until the button begins 
to blink green, then release the button.

3.	 Press and release an output button to select an output.  Each lit input button, 
from Input 1 through Input 10, indicates a half second of RGB delay interval 
for the selected output.

4.	 Press and release the Esc (>) and View (<) buttons to increase and decrease 
the interval.

5.	 Press and release the Video button to exit the Video mode.  The Video button 
stops blinking.

N	 •	 Video Inputs buttons 9 and 10 display part of the RGB delay value, but the 
delay is not applied to low resolution video ties.

•	 Pressing the Enter or Preset button also exits Video mode.  Pressing the 
Preset button changes to Recall Preset mode.

•	 The RGB delay period for each output is stored in non-volatile memory.  
When power is removed and restored, the delay settings are retained.

•	 Exiting Video mode by pressing the Video button always returns the I/O 
configuration to video and audio selected for configuration (Video button and 
Audio button both lit).
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Example 6: Setting the RGB delay for an output
In the following example, the RGB delay is increased for ties to output 1.  The steps 
show the front panel indications that result from your action.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select Video mode: Press and hold the Video button for approximately 2 
seconds.

	

VIDEO VIDEO

Press and hold the Video 
button until it blinks.

Release the button.

2 seconds

3.	 Select an input: Press and release the output 1 button.

N	 An output from the low resolution video group cannot be selected.

COMPUTER INPUTS

1 2 3 4 5 6 7 8 9 10 11 12 13 141 2 3 4
VIDEO INPUTS

COMPUTER/AUDIO O

Press and release the 
Output 1 button.
The button lights green.

The input buttons 1 through 10 display the selected output's RGB delay.

Each lit input button indicates half a second of delay.

In this example, the green input buttons display 3.5 seconds of RGB delay.

3.53.02.52.01.51.00.5

N	 The RGB delay is protected when front panel lock mode 2 is selected.  You 
can view the delay in lock mode 2, but not change it from the front panel.  See 
“Setting the front panel Locks (Executive modes)” on page 3-44.

	 If front panel lock mode 2 is selected and you try to perform steps 4, the actions 
are ignored and the Enter, Video, and Audio buttons flash.
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4.	 Change the RGB delay: Press and release the Esc (>) button once to increase 
the RGB delay by a half second.

	 Press and release the Esc (>) button twice more to increase the RGB delay by a 
whole second.  Note the input button indication changes that occur each time 
the Esc (>) button is pressed and released.

	 The figure below show the result of pressing the Esc (>) button a total of 3 
times.

 ESC  ESC  ESC 

COMPUTER INPUTS

1 2 3 4 5 6 7 8 9 10 11 12 13 14
VIDEO INPUTS

Press the Esc button to increase
the RGB interval that is applied to
ties to the selected output by
a half second per button push.

The input buttons 1 through 10 display the selected output's RGB delay.

Each lit input button indicates half a second of delay.

In this example, the green input buttons display 5.0 seconds of RGB delay.

3.5 4.0 4.5 5.03.02.52.01.51.00.5

5.	 Deselect Video mode: Press and release the Video button.

	

I / O

VIDEO AUDIO The Audio button lights red.

Press the Video button 
to exit Video mode.

All input buttons and output buttons
return to unlit or background illumination.

The Video button stops 
blinking and lights green.
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Selecting S-video or composite video
Low resolution video inputs 11 through 14 are individually configurable as either 
composite video or S-video.  View and change this variable from the front panel as 
follows:

N	 The input video format is protected when front panel Lock mode 2 is selected.  
You can view the selected form of the input in Lock mode 2 but you cannot 
change it from the front panel.  See “Setting the front panel Locks (Executive 
modes)” on page 3-44.

1.	 Press the Esc button to clear any input buttons, output buttons, or control 
buttons that may be lit.

2.	 To enter Video mode, press and hold the Video button until the button begins 
to blink green, then release the button.

3.	 Press and release one of Video Input buttons 11 through 14 to select that input.  
Either Video Output button 7 or 8 lights to indicate the video format.  Video 
Output 7 indicates composite video and Video Output 8 indicates S-video.

4.	 Press and release the Video Output 7 or 8 button to select the associated video 
format.

5.	 Press and release the Video button to exit the Video mode.  The Video button 
stops blinking.

N	 •	 Pressing the Enter or Preset button also exits Video mode.  Pressing the 
Preset button changes to Recall Preset mode.

•	 For the switcher to recognize the change and create a new configuration map, 
you must create a new tie for the input whose format was changed.

•	 Exiting Video mode by pressing the Video button always returns the I/O 
configuration to video and audio selected for configuration.

Example 7: Selecting the video format for a configurable output
In the following example, the S-video format is selected for video input 13. 
The steps show the front panel indications that result from your action.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select Video mode: Press and hold the Video button.

	

VIDEO VIDEO

Press and hold the Video 
button until it blinks.

Release the button.

2 seconds
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3.	 Select a configurable input: Press the Video Input button for one of inputs 11 
through 14.

	

9 10 11 12 13 14
VIDEO INPUTS

7 8 9 10 11 12
VIDEO OUTPUTS

Either the Video Output 7 button or 
the Output 8 button lights green to 
indicate the video format as follows:
7 — Composite 8 — S-video

Press and release the Video Input 13 button.
The button lights.

N	 The input video format is protected when front panel Lock mode 2 is selected.  
You can view the selected formats in Lock mode 2 but you cannot change them 
from the front panel.  See “Setting the front panel Locks (Executive modes)” on 
page 3-44.

	 If front panel Lock mode 2 is selected and you try to perform step 4, the action is 
ignored.

4.	 Change the format: Press and release the unlit Video Output button, 7 or 8, 
that relates to the desired format.

	

7 8 9 10 11 12
VIDEO OUTPUTS

Press and release the Video Output button 
to change the video format as follows:
7 — Composite 8 — S-video

In this example, the input is set to S-video.

N	 If desired, select another of configurable video inputs 11 through 14 to view or 
change the video format for that input.

5.	 Deselect Video mode: Press and release the Video button.

	

I / O

VIDEO AUDIO The Audio button lights red.

Press the Video button 
to exit Video mode.

All input buttons and output buttons
return to unlit or background illumination.

The Video button stops 
blinking and lights green.

N	 For the switcher to recognize the change and create a new configuration map, 
you must create a new tie for the input whose format was changed.
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Using presets
The current configuration (configuration 0) can be saved as a preset in any one of 
32 preset memory addresses.  Up to 26 of those presets can be selected from the 
front panel to be either saved or retrieved.  Global preset locations 1 through 14 
are assigned to the input buttons.  Global presets 15 through 26 are assigned to 
the output buttons.  Global presets 27 through 32 are available via the RS-232 and 
Ethernet links only.  

Figure 3-5 shows the presets associated with the input and output button 
configuration of the MPX Plus 866 A.

Input 
buttons 

Output 
buttons 

Preset
1

Preset
5

Preset
10

Preset
2

Preset
11

Preset
3

Preset
8

Preset
12

Preset
6

Preset
7

Preset
4

Preset
15

Preset
19

Preset
16

Preset
17

Preset
26

NOTE   Presets 27 through 32 are available via RS-232 and Ethernet control only .

Preset
20

Preset
25

Preset
24

Preset
23

Preset
22

Preset
21

Preset
18

Preset
9

Preset
14

Preset
13

COMPUTER INPUTS

1 2 3 4 5 6 7 8 9 10 11 12 13 14

1 2 3 4 5 6 7 8 9 10 11 12

VIDEO INPUTS

VIDEO OUTPUTSCOMPUTER/AUDIO OUTPUTS

Figure 3-5 — Preset locations

When a preset is retrieved from memory, it becomes the current configuration if it is 
a global ties preset or part of the current configuration if a partial preset.

N	 •	 When presets are saved from the front panel, only the audio and video ties 
are stored.

	 Audio gain and volume settings are not saved as a global ties preset.
	 The video format (composite or S-video) for outputs 11 through 14 are 

not saved as a global ties preset.

•	 Saving global ties presets is protected when front panel lock mode 2 
is selected.  See “Setting the front panel Locks (Executive modes)” on 
page 3-44.

•	 When presets are recalled from the front panel, any signal processing 
adjustments that were saved as part of the preset (under DSP Configurator 
control only) are recalled and overwrite the current audio settings.

•	 Presets cannot be viewed from the front panel unless recalled as the current 
configuration.  Presets can be viewed using Extron’s Windows-based DSP 
Configurator program or Matrix Switchers Control Program.  See chapter 5, 
“Switcher Software”, for more details.

•	 The current configuration and all presets are stored in non-volatile memory.  
When power is removed and restored, the current configuration is still active 
and all presets are retained.

•	 When a global ties preset is recalled, it replaces the current configuration, 
which is lost unless it is also stored as a preset.  The recalled preset overwrites 
all of the current configuration ties in favor of the preset configuration ties.

•	 When a partial preset is recalled, it overwrites that portion of the current 
configuration addressed by the preset, leaving the rest unchanged.
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Example 8: Saving a global ties preset
In the following example, the current configuration is saved as a global ties preset.  
The steps show the front panel indications that result from your actions.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select Save Preset mode: Press and hold the Preset button for approximately 
2 seconds until it blinks.

PRESET PRESET

COMPUTER INPUTS

1 2 3 4 5 6 7 8

1 2 3 4 5 6

Press and hold the Preset button until it blinks.

Release the button.

2 seconds All input and output buttons with 
assigned presets light red.

If you then save the configuration 
to a lit preset number, the 
configuration data at that preset 
location will be overwritten.

Preset Assigned

COMPUTER/AUDIO OUTPUTS

No Preset Assigned

3.	 Select the preset number: Press and release the input or output button for the 
desired preset.

	

C O N T R O L

PRESETENTER ESCVIEW

COMPUTER INPUTS

1 2 3 4 5 6 7 8

•   The Enter button blinks to 
indicate the need to save 
the preset.

•   The Preset button 
continues to blink.

Press and release the Input 1 button.

The button blinks red to indicate that this 
preset number is selected but not saved.

4.	 Confirm the preset save: Press and release the Enter button.  The current 
configuration is now stored in the selected memory location.

	

C O N T R O L

PRESETENTER ESCVIEW

The Enter and Preset buttons return 
to unlit or background illumination.

Press the Enter button to 
save the preset.

All input buttons return to unlit 
or background illumination.
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Example 9: Recalling a global or partial preset
In the following example, a preset is recalled to become the current configuration.  
The steps show the front panel indications that result from your actions.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select Recall Preset mode: Press and release the Preset button.

PRESET PRESET

COMPUTER INPUTS

1 2 3 4 5 6 7 8

1 2 3 4 5 6

Press and release the Preset button.

All input and output buttons with 
assigned presets light red.

Preset Assigned

COMPUTER/AUDIO OUTPUTS

No Preset Assigned

3.	 Select the preset number: Press and release the input or output button for the 
desired preset.

	

C O N T R O L

PRESETENTER ESCVIEW

COMPUTER INPUTS

1 2 3 4 5 6 7 8

The Enter button blinks to 
indicate the need to recall 
the preset.

Press and release the Input 1 button.

The button blinks red to indicate that this 
preset number is selected but not recalled.

4.	 Confirm the recalled preset: Press and release the Enter button.  The 
configuration stored in the selected memory location is now the current 
configuration and can be viewed in the View-Only mode (see example 4).

	

C O N T R O L

PRESETENTER ESCVIEW

Press the Enter button to 
recall the preset.

The Enter and Preset buttons return 
to unlit or background illumination.

All input buttons return to unlit 
or background illumination.
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Muting and unmuting video and/or audio outputs
Individual outputs can be muted or unmuted as follows:

N	 Mutes are protected when front panel Lock mode 2 is selected.  You can view the 
status of the output (muted or unmuted) in Lock mode 2 but you cannot change 
it from the front panel.  See “Setting the front panel Locks (Executive modes)” 
on page 3-44.

1.	 Press the Esc button to clear any input button indications, output button 
indications, or control button indications that may be on.

2.	 Select video or audio only to mute or unmute by pressing the Video 
button and/or the Audio button.

3.	 Press and release the View button.

4.	 One at a time, press and hold the output button(s) for the desired output(s) 
for approximately 2 seconds.  The output LED(s) for the selected output(s) 
blink to indicate the mute or return to their previous state to indicate the 
unmute.

5.	 Press and release the View button to return to normal switcher operation.

N	 •	 Video and audio can both can be muted, but in separate operations; one and 
then the other..  Press and release the Video button and the Audio button to 
select each for muting or unmuting.

•	 If you select Video and Audio in View-Only mode and then attempt to mute 
an output, the mute function will not work.

•	 Video can be muted or unmuted on outputs 1 through 12.  Audio is not 
preset on output 7 through 12, so it cannot be muted or unmuted on those 
outputs.

•	 The audio mute is the same mute function that is available via the DSP 
Configurator program.  See chapter 5, “Switcher Software”.

•	 When you enter View-Only mode, the output LEDs turn on for all outputs 
without ties.

•	 In the computer video group, the video mute function mutes the R, G, and B 
planes only; the sync (H and V planes) are still active.  In the low resolution 
video group, the video mute function mutes all composite video and/or 
S-video planes.

•	 Mutes are saved to non-volatile memory.  When power is removed and 
restored, the mute settings are retained.
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Example 10: Muting and unmuting an output
In the following example, several switcher outputs are muted and unmuted.  The 
steps show the front panel indications that result from your action.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select video and audio, video only, or audio only: If necessary, press and 
release the Video button and/or Audio button.

	

I / O

VIDEO AUDIO

NOTE   Video is selected in this example.

Press the Audio button 
to toggle on and off.

The button lights red 
when selected, is unlit 
when deselected.

Press the Video button 
to toggle on and off.

The button lights green 
when selected, is unlit 
when deselected.

3.	 Select View-only mode: Press and release the View button.

N	 This example shows the front panel indications if example 1, example 2, and 
example 3 have been completed.

	

1 2 3 4 5 6
COMPUTER/AUDIO OUTPUTS

C O N T R O L

PRESETENTER ESCVIEW

Until you select an input, the buttons for all untied outputs light the appropriate color:
•   Green if video is selected in step 2.
•   Red if audio is selected in step 2.

NOTE   Video Outputs buttons 7 through 12 
can only light green because audio 
cannot be tied to the low resolution 
video outputs.

Press the View button.

The button lights red.

N	 Output mutes are protected when front panel Lock mode 2 is selected.  You 
can view the mutes in Lock mode 2 but you cannot change them from the front 
panel.  See “Setting the front panel Locks (Executive modes)” on page 3-44.

	 If front panel Lock mode 2 is selected and you try to perform steps 4 and 5, the 
actions are ignored.
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4.	 Mute the output: One at a time, press and hold the Output 3 and then the 
Output 4 buttons for approximately 2 seconds until the button starts to blink.

3

4

3

4

The button blinks indicate 
that the output is muted.

The button blinks indicate 
that the output is muted.

Mute outputs one at a time.

2 seconds

2 seconds

Press and hold the Output 3 button.

Press and hold the Output 4 button.

Green = Video is muted.
Red = Audio is muted.
Amber = Video and audio are muted.  (Amber is visible only 

after you have selected the Video and Audio buttons).

NOTE   Video is muted in this example.

N	 If both video and audio are selected and only video is muted, the output button 
flashes between green and amber.  If only audio is muted, the output button 
flashes between red and amber.

N	 Video and audio ties between the low resolution video input group and the low 
resolution video output group are always made with the audio redirected.  To 
mute video and audio, you must mute both the low resolution video output (in 
outputs 7 through 12) and the computer video/audio outputs group output (in 
outputs 1 through 6) as follows:

	 •	 If you mute output 7 video, you must also mute output 1 audio.
	 •	 If you mute output 8 video, you must also mute output 2 audio.
	 •	 If you mute output 9 video, you must also mute output 3 audio.
	 •	 If you mute output 10 video, you must also mute output 4 audio.
	 •	 If you mute output 11 video, you must also mute output 5 audio.
	 •	 If you mute output 12 video, you must also mute output 6 audio.

5.	 Unmute the output: One at a time, press and hold the Output 3 and then the 
Output 4 buttons for approximately 2 seconds until the button changes state.

	

3

4

3

4

Unmute outputs one at a time.

2 seconds

2 seconds

Press and hold the Output 3 button.

Press and hold the Output 4 button. The button returns to its previous indication 
(either lit, background illuminated, or unlit) 
to indicate that the output is unmuted.

The button returns to its previous indication 
(either lit, background illuminated, or unlit) 
to indicate that the output is unmuted.

6.	 Exit View-only mode: Press and release the View button.

	

All input buttons and output buttons
return to unlit or background illumination.

VIEW

Press the View button 
to exit View-Only mode.

The View button returns to 
unlit or background 
illumination.
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Viewing and adjusting the input audio level
The audio level of each input can be displayed and adjusted through a range of 
-18 dB to +24 dB to ensure that there is no noticeable volume difference among 
sources (figure 3-6).  The audio level can be adjusted from the front panel or under 
serial port or Ethernet control.

Audio 
Inputs 

Audio 
Inputs 

VCR 

No noticeable 
volume differences 
between sources 

Audio System 

CD Jukebox 

MPX  Plus 866 A

0 
-3 
-6 
-9 
-12 
-15 

Low Audio 
Output Level 

+4 
+1 
-2 
-5 
-8 
-12 

-18 
-21 

-15 
-18 

3 +7 
6 +10 
9 +13 

12 +16 
15 +19 
18 +21 
21 +24 
VU dBu 

0 
-3 
-6 
-9 
-12 
-15 

High Audio 
Output Level 

+4 
+1 
-2 
-5 
-8 
-12 

-18 
-21 

-15 
-18 

3 +7 
6 +10 
9 +13 
12 +16 
15 +19 
18 +21 
21 +24 
VU dBu 

0 
-3 
-6 
-9 

-12 
-15 

Output 
Level 

+4 
+1 
-2 
-5 
-8 

-12 
-18 
-21 

-15 
-18 

3 +7 
6 +10 
9 +13 
12 +16 
15 +19 
18 +21 
21 +24 
VU dBu 

AUDIOVIDEO

I/OCONTROL

ENTER PRESET VIEW ESC

PRESENTATION MATRIX SWITCHER

MPX PLUS 866 A

COMPUTER INPUTS

1 2 3 4 5 6 7 8 9 10 11 12 13 14

1 2 3 4 5 6 9 10 11 12 13 14

VIDEO INPUTS

COMPUTER OUTPUTS VIDEO OUTPUTS

CONFIG

Figure 3-6 — Audio gain and attenuation

1.	 Press the Esc button to clear any input buttons, output buttons, or control 
buttons that may be lit.

2.	 To enter Audio mode, press and hold the Audio button until the button begins 
to blink red, then release the button.

3.	 Press and release an input button to select an input.  The output buttons 
display audio level and polarity (+ or –) for the selected input.  Each output 
button indicates 1 dB of gain or attenuation when blinking slowly, 2 dB when 
blinking quickly, and 3 dB when lit steadily.  Green output buttons indicate a 
gain (+) audio level and red buttons indicate an attenuation (–) level.  See the 
table on the next page.

4.	 Press and release the Esc (>) and View (<) buttons to increase and decrease 
the audio level.

5.	 Press and release the Audio button to exit the Audio mode.  The Audio button 
stops blinking.
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dB dB

9

8

10

12

14

16

18

20

22

7

6

5

4

3

2

1

0

17

15

13

11

24

23

21

19

9

8

10

12

14

16

18

20

22

7

6

5

4

3

2

1

0

17

15

13

11

24

23

21

19

21 3 4 5 6 7 8

= Unlit button = Blinking button

= Lit button

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

21 3 4 5 6 7 8

= Fast blinking button
F

= Slow blinking button
S

S

F

S

F

S

F

S

F

S

F

S

F

S

F

S

F

Green indicates a positive (gain) level,
red indicates a negative (attenuation) level.

Input audio level adjustment displays
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N	 •	 Pressing the Enter or Preset button also exits Audio mode.  Pressing the 
Preset button changes to Recall Preset mode.

•	 When adjusted from the front panel, there is one audio level setting per input.  
The audio level setting is shared by the left and right audio inputs.

•	 Individual controls, offering finer trim adjustments (in 0.1 dB increments) 
for the right and left channels and group master offsets are present in 
the DSP and available through software control (see “DSP Configurator 
Program”, in chapter 5, “Switcher Software“).  These controls are not shown 
in the front panel display.

•	 The audio level settings are stored in non-volatile memory.  When power is 
removed and restored, the audio level settings are retained.

•	 Pressing the Audio button always returns the I/O buttons to Video lit green 
and Audio lit red (video and audio selected for configuration).

Example 11: Viewing and adjusting an input audio level
In the following example, an audio level is viewed and adjusted.  The steps show 
the front panel indications that result from your action.

The output buttons display the level as shown in the table on page 3-35.  Output 
buttons lit green indicate gain; output buttons lit red indicate attenuation.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select Audio mode.  Press and hold the Audio button for approximately 2 
seconds.

	

AUDIO AUDIOPress and hold the Audio button until it blinks.

Release the button.

2 seconds

3.	 Select an input: Press and release the input 5 button.

	

COMPUTER INPUTS

1 2 3 4 5 6 7 8

1 2 3 4 5 6
COMPUTER/AUDIO OUTPUTS

7 8 9 10 11 12
VIDEO OUTPUTS

Press and release the Input 5 button.
The button lights green.

The output buttons display the selected input’s audio level and polarity (gain or attenuation).

• Each output button indicates 1 dB when blinking slowly, 2 dB when blinking quickly, and 3 dB when lit.

When the buttons are lit or blinking green, they indicate a gain (+) audio level.

When the output buttons are lit or blinking red, they indicate an attenuation (-) level.

• In this example, the output buttons display an audio gain level of +8 dB.

F
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4.	 Change the audio level: Press and release the View (<) button once to 
decrease the input audio level by 1 dB.

	 Press and release the View (<) button several more times to decrease the input 
audio level by 1 dB per push of the  button.  Note the output button indication 
changes that occur each time the View (<) button is pressed.

	 The figure below shows the result of pressing the View (<) button a total of 9 
times.  Note that the level is now displayed in red to indicate a negative level.

	

VIEW

1 2 3 4 5 6
COMPUTER/AUDIO OUTPUTS

7 8 9 10 11 12
VIDEO OUTPUTS

Press the View button to decrease the input 
audio level by 1 dB per button push.

The output buttons display the selected input’s audio level and polarity (gain or attenuation).

• Each output button indicates 1 dB when blinking slowly, 2 dB when blinking quickly,
and 3 dB when lit.

When the buttons are lit green, they indicate a gain (+) audio level.

When the output buttons are lit red, they indicate an attenuation (-) level.

• In this example, the output buttons display an audio attenuation level of -1 dB.

S

5.	 Deselect Audio mode: Press and release the Audio button.

	

I / O

VIDEO AUDIO The Audio button stops 
blinking and lights.

Press the Audio button 
to exit audio mode.

All input buttons and output buttons
return to unlit or background illumination.

The Video button 
lights green.
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Viewing and adjusting the output volume
The audio level of each output can be displayed and adjusted through a range of 
100% (no attenuation) to 0% (maximum [100 dB] attenuation).  The audio level can 
be adjusted from the front panel or under RS-232 or Ethernet control.

N	 Output volume is protected when front panel Lock mode 2 is selected.  You can 
view the volume in Lock mode 2 but you cannot adjust it from the front panel.  
See “Setting the front panel Locks (Executive modes)” on page 3-44.

1.	 Press the Esc button to clear any input buttons, output buttons, or control 
buttons that may be lit.

2.	 To enter Audio mode, press and hold the Audio button until the button begins 
to blink red, then release the button.

3.	 Press and release an output button in the computer video/audio output 
group to select an output.  The input buttons display the volume level for 
the selected output; the more buttons that are lit, the higher the volume.  The 
fewer buttons that are lit, the lower the volume.

	 For a more detailed analysis of decoding the displayed value, see “Reading 
the displayed volume” on the next page.

4.	 Press and release the Esc (>) and View (>) buttons to increase and decrease 
the audio volume.

5.	 Press and release the Audio button to save the audio settings and exit the 
Audio mode.  The Audio button stops blinking.

N	 •	 When adjusted from the front panel, there is one audio level setting per input.  
The audio level setting is shared by the left and right audio outputs.

	 •	 Individual controls, offering finer trim adjustments (in 0.1 dB increments) 
for the right and left channels and group master offsets are present in 
the DSP and available through software control (see “DSP Configurator 
Program”, in chapter 5, “Switcher Software“).  These controls are not shown 
in the front panel display.

	 •	 The audio volume levels are stored in non-volatile memory.  When power is 
removed and restored, the audio level settings are retained.

•	 Exiting Audio mode by pressing the Audio button always returns the I/O 
buttons to Video lit green and Audio lit red (video and audio selected for 
configuration).

•	 Pressing the Enter or Preset button also exits Audio mode.  Pressing the 
Preset button changes to Recall Preset mode.
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Reading the displayed volume
N	 This section is a detailed look at reading the output volume display on the 

switcher’s front panel.  If you do not need to read the exact value of the volume 
setting, skip this section.

There are 65 steps of volume attenuation, with 1 dB per step (button push), except 
for step 0-to-1, which is 37 dB.  At maximum attenuation, no input buttons are lit, 
100 dB of attenuation is applied, and the audio output is effectively muted.  At no 
attenuation, input buttons 1 through 12 are lit and the output volume is equal to the 
input signal plus any gain or attenuation that is applied to that specific input using 
the input audio level adjustment.  See “Viewing and adjusting the input audio level”.

See the table on the next page.  The input buttons blink or light sequentially to 
indicate the approximate volume of the selected output.  Volume is defined as 
a percentage of the input audio signal that is applied to the output.  From 0% of 
volume, the first Esc (>) button push applies 5.5% of the input audio signal.  From 
5.5% on, each Esc (>) push applies 1.5% more of the input audio signal to the output:

	 •	 Push Esc (>) button again — 5.5% + 1.5% = 7% volume, indicated by the 
Input 1 button blinking slowly.

	 •	 Push Esc (>) button twice more — 7% + 1.5% + 1.5% = 10% volume, 
indicated by the Input 1 button blinking quickly.

	 •	 Push Esc (>) button nineteen times more — 10% + (19•1.5%) = 38.5% 
volume, indicated by the Input 1 through 4 buttons lit steadily.

When 12 input buttons are lit, the audio output is 100% of the audio input level.

Another way to view the volume level is to think in terms of the attenuation that is 
applied to the output.  Attenuation is indicated by the lit or blinking input buttons: 
when fewer input buttons are lit, attenuation is greater (and the volume is quieter).

	 •	 At minimum volume all input buttons are unlit or background illuminated 
and the audio output is effectively muted.

	 •	 The first step of volume increase causes the Input 1 button to blink slowly.  
Attenuation is reduced by 37 dB (63 dB of attenuation is applied to the output).

	 •	 The second step of volume increase reduces the attenuation by an additional 
1 dB (62 dB of attenuation is applied to the output).

	 •	 Successive steps of volume increase cause consecutive buttons to first blink, 
then light steadily.

	 •	 At full volume, no attenuation is applied to the output and all input buttons 
light steadily.
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5

Highest #
input button lit

Highest #
input button lit

dB of
attenuation

Output
volume

100 0%None

dB of
attenuation

Output
volume

63

62

5.5%

7%

61

60

8.5%

10%

1 59

58

11.5%

13%

57

56

14.5%

16%

55

54

17.5%

19%

53

52

20.5%

22%

51

50

23.5%

25%

49

48

26.5%

28%

47

46

29.5%

31%

1
Fast
blink

6 Fast
blink

2

1
Slow
blink

6
Slow
blink

2
Fast
blink

2
Slow
blink

3

3
Fast
blink

3
Slow
blink

4

4
Fast
blink

4
Slow
blink 45

44

32.5%

34%

43

42

35.5%

37%

41

40

38.5%

40%

39

38

41.5%

43%

37

36

44.5%

46%

35

34

47.5%

49%

33

32

50.5%

52%

5

Fast
blink

5
Slow
blink

31 53.5%

30 55%

29

28

56.5%

58%

27

26

59.5%

61%

25

24

62.5%

64%

23

22

65.5%

67%

21

20

68.5%

70%

19

18

71.5%

73%

17

16

74.5%

76%

15

14

77.5%

79%

13

12

80.5%

82%

11

10

83.5%

85%

9

8

86.5%

88%

7

6

89.5%

91%

5

4

92.5%

94%

3

2

95.5%

97%

1

0

98.5%

100%

6

7

7
Fast
blink

7
Slow
blink

8

8
Fast
blink

8
Slow
blink

10

10
Fast
blink

10
Slow
blink

11

11
Fast
blink

11
Slow
blink

12

12
Fast
blink

12
Slow
blink

9

9
Fast
blink

9
Slow
blink

Fast
blink

6

Audio volume adjustment settings
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Example 12: Viewing and adjusting an output volume level
In the following example, the audio output volume is viewed and adjusted.  The 
steps show the front panel indications that result from your action.  See the table on 
page 3-40 to read the displayed audio output volume.

1.	 Clear all selections: Press and release the Esc button.

	

C O N T R O L

PRESETENTER ESCVIEW

Press and release the Esc button.

The button flashes once.

2.	 Select Audio mode.  Press and hold the Audio button for approximately 2 
seconds.

	

AUDIO AUDIOPress and hold the Audio button until it blinks.

Release the button.

2 seconds

3.	 Select an output: Press and release the output 1 button.

39 dB attenuation,
41.5% volume

Slow blinking button:

1 2 3 4
COMPUTER/AUDIO O

COMPUTER INPUTS

1 2 3 4 5 6 7 8 9 10 11 12 13 14
VIDEO INPUTS

Press and release the 
Output 1 button.
The button lights green.

• The input buttons display the selected output's audio volume level.

• In this example, the lit and blinking input buttons indicate 40 to 41.5 percent of the applied 
audio input.

• The unlit and unblinking input buttons indicate an audio volume attenuation of 39 dB to 40 dB.

N	 Volume is protected when front panel Lock mode 2 is selected.  You can view 
the volume in Lock mode 2 but you cannot change it from the front panel.  See 
“Setting the front panel Locks (Executive modes)” on page 3-44.

	 If front panel Lock mode 2 is selected and you try to perform step 4, the actions 
are ignored and the Enter, Video, and Audio buttons flash.
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4.	 Change the volume level: Press and release the Esc (>) button once to 
increase the volume by 1.5%.

	 Press and release the Esc (>) button several more times to increase the volume 
by 1.5% per button push.  Note the input button indication changes that occur 
each time the Esc (>) button is pressed and released.

N	 You can press and hold the Esc (>) or View (<) button to ramp the level up or 
down by 3 dB per second to the high or low limit.

	 The figure below shows the result of pressing the Esc (>) button a total of 13 
times.

ESC COMPUTER INPUTS

1 2 3 4 5 6 7 8 9 10 11 12 13 14
VIDEO INPUTS

Decrease the audio 
attenuation (thereby 
increasing the audio 
level) that is applied 
to the output volume 
level by 1 dB per 
button push.

Press the Esc button
Fast Blinking Button:

26 dB attenuation
61% volume

• The input buttons display the selected output's audio volume level.

• In this example, the lit and blinking input buttons indicate 59.5 to 61 percent of the applied audio input.

• The unlit and unblinking input buttons indicate an audio volume attenuation of 26 dB to 27 dB.

5.	 Deselect Audio mode: Press and release the Audio button.

	

I / O

VIDEO AUDIO The Audio button stops 
blinking and lights.

Press the Audio button 
to exit audio mode.

All input buttons and output buttons
return to unlit or background illumination.

The Video button 
lights green.

Selecting the RS-232 Primary port’s baud rate
The matrix switcher supports the RS-232 serial communication protocol on the front 
panel Configuration port and the rear panel RS-232 Primary and RS-232 Secondary 
ports.  All three ports can operate at 9600, 19200, 38400, and 115200 baud.  The baud 
rate for the RS-232 Primary port can be viewed and changed from the front panel.

View and configure the RS-232 Primary port’s baud rate as follows:

1.	 Select Serial Port Configuration mode: Simultaneously press and hold all 
Control buttons (Enter, Preset, View, and Esc).

	

C O N T R O L

PRESETENTER

C O N T R O L

PRESETENTER ESCVIEW ESCVIEW2 seconds

All Control buttons light with one flashing.

The flashing Control button indicates the 
baud rate as follows:

Enter — 9600  Preset — 19200
View — 38400  Esc — 115200

Press and hold the Enter, Preset, View, and Esc buttons.

2.	 Release the Control buttons.
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3.	 Change the baud rate: Press and release the button that relates to the desired 
value.

	

C O N T R O L

PRESETENTER ESCVIEW

Baud rate:
Enter — 9600 Preset — 19200
View — 38400 Esc — 115200

The selected button blinks and the 
others remain lit.

In this example, the port is set to 
38400 baud.

4.	 Deselect Serial Port Configuration mode: Press and release an input or 
output button.

	

C O N T R O L

PRESETENTER ESCVIEW5

All Control buttons return to 
unlit or background illumination.Press and release an 

input or output button.

N	 The switcher requires some time to save the new serial port settings.  Wait at 
least 5 minutes before removing power from the switcher or the settings may be 
lost.
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Setting the front panel locks (Executive modes)
The matrix switchers have three levels of front panel security lock that limit the 
operation of the switcher from the front panel.  The three levels are:

	 •	 Lock mode 0 — The front panel is completely unlocked.  All front panel 
functions are available.

	 •	 Lock mode 1 — All changes are locked from the front panel (except for 
setting Lock mode 2).  Some functions can be viewed.

	 •	 Lock mode 2 — Basic functions are unlocked.  Advanced features are locked 
and can be viewed only.

		  Basic features consist of:

m	 Making ties
m	 Recalling presets
m	 Setting input audio gain and attenuation
m	 Changing Lock modes

		  Advanced features consist of:

m	 Setting RGB delay
m	 Saving presets
m	 Setting video and audio output mutes
m	 Setting audio output volume
m	 Setting the rear panel remote port baud rate

N	 The switcher is shipped from the factory in Lock mode 2.

Selecting Lock mode 2 or toggling between mode 2 and mode 0
N	 If the switcher is in Lock mode 0 or mode 1, this procedure selects mode 2.

	 If the switcher is in Lock mode 2, this procedure selects mode 0 (unlocks the 
switcher).

Change the Lock mode, as shown:

I / O 

 VIDEO AUDIO ENTER

I / O

VIDEO AUDIOENTER

Press and hold the Enter, Video, and Audio 
buttons simultaneously to turn on Lock mode 2 
or to toggle between mode 2 and mode 0.

2 seconds 

The Enter, Video, and 
Audio buttons blink twice to 
indicate mode 2 selection.

The Video and Audio 
buttons blink twice to 
indicate mode 0 selection.

Release the buttons.
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Selecting Lock mode 2 or toggling between mode 2 and mode 1
N	 If the switcher is in Lock mode 0 or mode 1, this procedure selects mode 2.

	 If the switcher is in Lock mode 2, this procedure selects mode 1.

Change the Lock mode, as shown:

I / O 

 VIDEO AUDIO 

I / O

VIDEO AUDIO

Press and hold the Video and Audio buttons 
simultaneously to turn on Lock mode 2 or to 
toggle between mode 1 and mode 2.

2 seconds 
ENTER

The Enter, Video, and 
Audio buttons blink twice to 
indicate mode 2 selection.

The Video and Audio 
buttons blink twice to 
indicate mode 1 selection.

Release the buttons.

Background illumination
The buttons on the front panel can be set to provide amber background 
illumination at all times or the background illumination can be turned off.

Toggle the background illumination on and off as shown:

1 2 3

1 2 3

Press and hold the Input 1 and Input 2 
buttons simultaneously to toggle 
background illumination mode on or off. 

2 seconds 

Release the Input 1 
and Input 2 buttons. 
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Performing a system reset from the front panel
The front panel reset is identical to the EZXXX} SIS command (see chapter 4, 
“SIS Programming and Control”).  A system reset:

•	 Clears all ties

•	 Clears all presets

•	 Clears all video and audio mutes

•	 Sets all input audio levels to unity gain (+0 dB)

•	 Sets all output volume levels to 100% (0 dB of attenuation).
Reset the switcher to the factory default settings by pressing and holding the Video 
button and Audio button while you apply AC power to the switcher.

N	 System reset does not reset the Internet protocol (IP) settings or replace user-
installed firmware.

Power

I / O

VIDEO AUDIO

Press and hold the Video and Audio buttons 
while you apply power to the switcher.

The switcher flashes the button indicators green, red, and 
amber and then turns them off.
Continue to hold the Video and Audio buttons until all input and output buttons return 
to either unlit or to background illumination and the Video and Audio buttons turn on.

Release the Video and Audio buttons.
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Rear Panel Operations
The rear panel has a Reset button that initiates four levels of resets (numbered 1, 3, 
4, and 5 for the sake of comparison with an Extron IPL product).  The Reset button 
is recessed, so use a pointed stylus, ballpoint pen, or Extron Tweeker to access it.

See the following table for a summary of the modes.

C	 Review the reset modes carefully.  Using the wrong reset mode may result 
in unintended loss of flash memory programming, port reassignment, or a 
controller reboot.

N	 The reset modes listed below close all open IP and Telnet connections and close 
all sockets.  Also, the following modes are separate functions, not a continuation 
from Mode 1 to Mode 5.

Reset Mode Comparison/Summary

Mode Activation Result Purpose/Notes

1 Hold down the recessed Reset button 
while applying power to the switcher.

N	 After a mode 1 reset is 
performed, update the switcher’s 
firmware to the latest version.  
Do not operate the switcher 
firmware version that results 
from the mode 1 reset.  If you 
want to use the factory default 
firmware, you must upload that 
version again.  See chapter 5, 
“Switcher Software”, for details 
on uploading firmware.

The switcher reverts to the factory default 
firmware.  Event scripting will not start if the 
switcher is powered on in this mode.  All user files 
and settings, such as IP settings, are maintained.

N	 If you do not want to update firmware, or 
you performed a mode 1 reset by mistake, 
cycle power to the switcher to return to the 
firmware version that was running before the 
mode 1 reset.  Use the 0Q SIS command to 
confirm that the factory default firmware is 
no longer running (look for the asterisk [*] 
following the version number.

Use mode 1 to revert 
to the factory default 
firmware version if 
incompatibility issues 
arise with user-loaded 
firmware.

3 Hold down the Reset button for about 
3 seconds, until the Reset LED blinks 
once, then press Reset momentarily 
(<1 second) within 1 second.

Mode 3 turns events on or off.  During resetting, 
the Reset LED flashes two times if events are 
starting, three times if events are stopping.

Mode 3 is useful for 
troubleshooting.

4 Hold down the Reset button for 
about 6 seconds, until the Reset LED 
blinks twice (once at 3 seconds and 
again at 6 seconds).  Then press Reset 
momentarily (<1 second) within 1 
second.

Mode 4: 
•	 Enables ARP capability. 
•	 Sets the IP address to the factory default. 
•	 Sets the subnet address to the factory default. 
•	 Sets the gateway address to the factory default. 
•	 Sets port mapping to the factory default. 
•	 Turns DHCP off. 
•	 Turn events off. 
The Reset LED flashes three times in quick 
succession during the reset.

Mode 4 enables you 
to set IP address 
information using ARP 
and the MAC address.

5 Hold down the Reset button for 
about 9 seconds, until the Reset LED 
blinks three times (once at 3 seconds, 
again at 6 seconds, and then again 
at 9 seconds).  Then press Reset 
momentarily (<1 second) within 1 
second.

Mode 5 performs a complete reset to factory 
defaults (with the exception of the firmware): 
•	 Does everything mode 4 does. 
•	 Resets most settings including: 
     clears all ties and presets 
     clears all output mutes 
•	 Resets all IP options. 
•	 Removes/clears all files for the switcher. 
The reset LED flashes three times in quick 
succession during the reset. 

Mode 5 is useful if 
you want to start over 
with configuration and 
uploading or to replace 
events. 
Same as EZQQQ} 
SIS command, see 
chapter 4, “SIS 
Programming and 
Control“.
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Performing soft system resets (resets 3, 4, and 5)
Perform a soft reset of the switcher as follows:

1.	 Use an Extron Tweeker or other small screwdriver to press and hold the rear 
panel Reset button until the rear panel Reset LED and the front panel Video 
and Audio buttons blink once (events reset), twice (system reset), or three 
times (absolute reset).

	

RESET
LAN

CT LINK

RESET
LAN

CT LINK

RESET
LAN

CT LINK

Events 
Reset

Press and hold 
the Reset button.

Release, then
immediately

press and hold.
3 seconds

Reset LED
flashes once.

Release the
Reset button.

Reset LED
flashes three
times.

IP Settings 
Reset

Press and hold 
the Reset button.

Release, then
immediately

press and hold.
6 seconds

Reset LED
flashes twice.

Release the
Reset button.

Reset LED
flashes three
times.

2 3

3 3

Absolute 
Reset

Press and hold 
the Reset button.

Release, then
immediately

press and hold.
9 seconds

Reset LED
flashes three
times.

Release the
Reset button.

Reset LED
flashes three
times.

1 3

2.	 Release the Reset button and then immediately press and release the Reset 
button again.  Nothing happens if the second momentary press does not occur 
within 1 second.



 

3-49MPX Plus 866 A Media Presentation Matrix Switcher • Operation

PR
EL

IM
IN

A
RY

Performing a hard reset (reset 1)
The hard reset function restores the switcher to the base firmware that it was 
shipped with.  After a hard reset, events do not automatically start, but user settings 
and files are restored.  Perform a hard reset as follows:

N	 The hard reset restores the factory-installed firmware.  The switcher reverts to 
that factory firmware the next time power is cycled off and on unless a firmware 
update is performed before the power cycle.

1.	 If necessary, turn off power to the switcher.

2.	 Press and hold the Reset button on the rear panel while you apply AC power 
to the switcher.

	

Power 

RESET
LAN

CT LINK

RESET
LAN

CT LINK

Press and hold the Reset button while you apply power to the switcher. 

The switcher flashes the front panel 
buttons and then turns them off.
Continue to hold the Reset button until all input and output buttons return 
to unlit and the Video and Audio buttons light.

Release the Reset button.

Optimizing the Audio
N	 This section addresses front  ols      

setting the digital signal processor adjustments, see “Optimizing the Audio” in 
chapter 5, “Switcher Software”.

Each individual input audio level can be adjusted within a range of -18 dB to 
+24 dB, so there are no noticeable volume differences between sources and for the 
best headroom and signal-to-noise ratio.  Adjust the audio gain and attenuation as 
follows:

1.	 Connect audio sources to all desired inputs and connect the audio outputs 
to output devices such as audio players.  See “Audio input and output 
connections”, in chapter 2, “Installation”.  For best results, wire all of the 
inputs and the outputs balanced.

2.	 Power on the audio sources, the switcher, and the audio players.

3.	 Switch among the inputs (see “Creating a configuration”, in this chapter), 
listening to the audio with a critical ear or measuring the output audio level 
with test equipment, such as a VU meter.

4.	 As necessary, adjust the input audio level of each input (see “Viewing and 
adjusting the input audio level”, in this chapter) so that the approximate 
output level is the same for all selected inputs.

5.	 As necessary, adjust the output audio level of each output (see “Viewing and 
adjusting the output volume”, in this chapter).
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Troubleshooting
This section gives recommendations on what to do if you have problems operating 
the switcher.

1.	 Ensure that all devices are plugged in and powered on.  The switcher is 
receiving power if any of the front panel button indicators are lit.

2.	 Check to see if one or more outputs are muted.

3.	 Ensure an active input is selected for output on the switcher.

4.	 Ensure that the proper signal format is supplied.

5.	 Check the cabling and make corrections as necessary.

6.	 Call the Extron S3 Sales & Technical Support Hotline if necessary.  See the rear 
cover of this manual for the phone number in your region of the world.
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Configuration Worksheets
Rather than trying to remember the configuration for each preset, use worksheets 
to record this information.  Make copies of the blank worksheet on page 3-54 and 
use one for each preset configuration.  Cross out all unused or inactive inputs and 
outputs.  Use different colors for video and audio and for computer video and low 
resolution video.

Worksheet example 1: System equipment
Figure 3-7 shows a worksheet in a fictional organization with the system hardware 
annotated.  Input 3 and 7, mic/line inputs 17 and 18, and outputs 10 and 11 have no 
connections in this organization, so they have been crossed out on the worksheet.

Computer video group inputs include PCs, wall boxes, and an Extron VTG 400.  
The low resolution video group inputs include cameras, a VCR, a DVD player, 
and an audio CD player.  Computer video group output devices include monitors, 
projectors, a stereo, and a VCR for recording presentations.  The low resolution 
video group includes low resolution monitors and audio tape,

The VTG 400 video test generator connected to input 8 or to input 13 enables a 
video test pattern to be sent to one, several, or all output devices within the video 
group for problem isolation or adjustment purposes.  An audio test tape or CD 
could be used in a similar manner to check out the audio components connected to 
the computer video/audio group.

1 2 3 4 5 6 7 8

1 2 3 4 5 6

Computer video group input  sources

Computer video/audio subgroup output destinations 

Preset #  Title:  Video:  Audio:
Fill in the preset number and use colors, or dashes, etc. to make connecting lines.
Indicate if the configuration is for video, audio, or both.

9 10 11 13 14

Low resolution video group input sources

7 8 9 10

12

11 12

Low resolution video subgroup output destinations 

PC 1
RGB 201

PC 2
RGB 201

ISS 506 Wallbox
#1

Wallbox
#2

VTG
400

Classrm
VCR #1

Classrm
DVD #1

Document
camera

VTG
400

Audio CD

Main
hall

PJ #1/
Hall PA

Main
hall

PJ #3

Lobby
sound

Conf.
room

Sound
system

#1

VCR
(USP 506)

Main
hall

PJ#2

Conf.
room

monitor

Classrm
#2

monitor

VCR

15 16 18

Mic audio input  sources

17

Podium
camera

Podium 1
Mic

Podium 2
Mic

Global ties
preset

Partial
preset

Signal
processing

Figure 3-7 — Worksheet example 1: System equipment
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Worksheet example 2: Daily configuration
Figure 3-8 continues from worksheet example 1 by showing the video and audio 
ties that make up the configuration of preset 1.  A black line shows video ties and a 
red line shows the audio ties.

In this example:

	 •	 The image of the presenter, from the main podium camera (low resolution 
video input 9), is:

		  	 Displayed in the main hall (low resolution output 7)

		  	 Displayed to the overflow crowd in the conference room (low resolution 
output 8)

		  	 Tied to the VCR (low resolution output 12) for recording

	 •	 The presenter has a presentation on her laptop computer (computer video 
input 1) that is displayed:

		  	 Displayed in the main hall (computer video outputs 1 and 2)

		  	 Displayed to the overflow crowd in the conference room (computer 
video output 4)

		  	 Tied, through a scaler, to a VCR (computer video output 6) for recording

	 •	 The audio from her microphone (input 16) is:

		  	 Played in the hall (output 1)

		  	 Distributed by the sound system (output 5)

		  	 Sent to the VCR (output 6)

	 •	 Music from the CD player (input 14) is played in the lobby (output 3)

1 2 3 4 5 6 7 8

1 2 3 4 5 6

Computer video group input  sources

Computer video/audio subgroup output destinations 

Preset #  Title:  Video:  Audio:
Fill in the preset number and use colors, or dashes, etc. to make connecting lines.
Indicate if the configuration is for video, audio, or both.

9 10 11 13 14

Low resolution video group input sources

7 8 9 10

12

11 12

Low resolution video subgroup output destinations 

PC 1
RGB 201

Podium 1
Mic

PC 2
RGB 201

ISS 506 Wallbox
#1

Wallbox
#2

VTG
400

Classrm
VCR #1

Classrm
DVD #1

Document
camera

VTG
400

Audio CD

Main
hall

PJ #1/
Hall PA

Main
hall

PJ #3

Lobby
sound

Sales pitch

Conf.
room

Sound
system

#1

VCR
(USP 506)

Main
hall

PJ#2

Conf.
room

monitor

Classrm
#2

monitor

VCR

Podium
camera

Podium 2
Mic

15 16 18

Mic audio input  sources

17

Signal
processing

Global ties
preset

Partial
preset

Figure 3-8 — Worksheet example 2: Daily configuration
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Worksheet example 3: Test configuration
The A/V system in our fictional organization needs to be fine tuned on a regular 
basis.  Figure 3-9 shows a typical test configuration, with an Extron video test 
generator (inputs 8 and 13) connected to each video group.  Each VTG generates a 
test pattern of the appropriate resolution to all connected outputs.  Sound checks 
are run from the CD player (input 14) to both output devices that accept audio, 
with the exception of the VCRs (outputs 3 and 4) regardless of video group.

1 2 3 4 5 6 7 8

1 2 3 4 5 6

Computer video group input  sources

Computer video/audio subgroup output destinations 

Preset #  Title:  Video:  Audio:
Fill in the preset number and use colors, or dashes, etc. to make connecting lines.
Indicate if the configuration is for video, audio, or both.

9 10 11 13 14

Low resolution video group input sources

7 8 9 10

12

11 12

Low resolution video subgroup output destinations 

PC 1
RGB 201

PC 2
RGB 201

ISS 506 Wallbox
#1

Wallbox
#2

VTG
400

Classrm
VCR #1

Classrm
DVD #1

Document
camera

VTG
400

Audio CD

Main
hall

PJ #1/
Hall PA

Main
hall

PJ #3

Lobby
sound

Conf.
room

Sound
system

#1

VCR
(USP 506)

Main
hall

PJ#2

Conf.
room

monitor

Classrm
#2

monitor

VCR

15 16 18

Mic audio input  sources

17

Podium
camera

Podium 1
Mic

Podium 2
Mic

Signal
processing

Global ties 
preset

Partial
preset

Test

Figure 3-9 — Worksheet example 3: Test configuration
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RS-232 Ports
The switcher has three serial ports that can be connected to a host device such as a 
computer running the HyperTerminal utility, an RS-232 capable PDA, or a control 
system.  These ports make serial control of the switcher possible.  The serial ports 
are:

	 •	 two (Primary and Secondary) rear panel RS-232 ports on 3-pin captive screw 
connectors

	 •	 the front panel Configuration (RS-232) port, a 2.5 mm mini stereo jack
The default protocol for all ports is as follows:

	 •	 9600 baud	 •	 no parity	 •	 8 data bits

	 •	 1 stop bit	 •	 no flow control
The RS-232 ports can be configured to operate at the 9600, 19200, 38400, or 115200 
baud rate.

N	 These three ports are hardwired for RS-232 only.

	 The rear panel RS-232 Secondary port is active only if the front panel 
Configuration port is not in use.  If a front panel configuration connection is 
made, the rear panel RS-232 Secondary port becomes inactive and the front panel 
Configuration port is active.

N	 The switcher can operate at 9600, 19200, 38400, or 115200 baud rates, but 
Extron recommends leaving these ports at 9600 baud only. 
See “Selecting the RS-232 Primary port’s baud rate” in chapter 3, “Operation”, 
to configure the RS-232 Primary port from the front panel. 
See the “Set serial port parameters” command on page 4-20 to configure all of 
the ports using an SIS command.
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Rear panel Remote ports
N	 See “Selecting the RS-232 Primary port’s baud rate“, in chapter 3, “Operation”, 

to configure the RS-232 Primary port from the front panel.

FunctionPin
TX
RX
Gnd

Transmit data
Receive data
Signal ground

RS-232
PRIMARY

RS-232
SECONDARY

Tx  Rx

Tx  Rx

Controlling
Device

Ground (    )
Receive (Rx)
Transmit (Tx)

Ground (    )
Receive (Rx)
Transmit (Tx)

Bidirectional

Do not tin the wires!

Figure 4-1 — RS-232 connector pin assignments

Front panel Configuration port
N	 This port parallels the rear panel RS-232 Secondary port.  If a front panel 

configuration connection is made, the rear panel RS-232 Secondary port becomes 
inactive and the front panel Configuration port is active.  The two paralleled 
ports’ protocol can be changed via SIS command control only.  See the “Set serial 
port parameters” command in “Command/response table for IP-specific SIS 
commands” on page 4-20 to configure this port under SIS control.

The optional 9-pin D to 2.5 mm mini jack TRS RS‑232 cable, part #70-335-01 
(figure 4-2) can be used for connection to the Configuration port.

6 feet
(1.8 m)

Part #70-335-01

5

1

9

6

Sleeve (Gnd)

Ring

Tip

 9-pin D Connection TRS Plug

 Pin 2 Computer's RX line Tip
 Pin 3 Computer's TX line Ring
 Pin 5 Computer's signal ground Sleeve

Figure 4-2 — Optional 9-pin TRS RS-232 cable
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Ethernet (LAN) Port
The rear panel LAN connector on the switcher can be connected to an Ethernet 
LAN or WAN, making makes SIS control of the switcher possible.  Communication 
between the switcher and the controlling device is via Telnet (a TCP socket using 
port 23).  The Telnet port can be changed, if necessary, via SIS.   The SIS commands 
and behavior of the product are identical to the commands and behavior the 
product exhibits when you are communicating with it via a serial port.

Ethernet connection
The Ethernet cable can be terminated as a straight-through cable or a crossover 
cable and must be properly terminated for your application (figure 4-3).

	 •	 Crossover cable — Direct connection between the computer and the 
MPX switcher

	 •	 Patch (straight) cable — Connection of the MPX switcher to an Ethernet LAN

A cable that is wired as T568A at one end
and T568B at the other (Tx and Rx pairs
reversed) is a "crossover" cable.

A cable wired the same at both ends is
called a "straight-through" cable, because
no pin/pair assignments are swapped.

12345678

RJ-45
Connector

Insert Twisted
Pair Wires

Pins: Crossover Cable Straight-through Cable

Pin

1

2

3

4

5

6

7

8

Wire color

White-green

Green

White-orange

Blue

White-blue

Orange

White-brown

Brown

Wire color

T568A T568B

End 1 End 2 End 1 End 2

White-orange

Orange

White-green

Blue

White-blue

Green

White-brown

Brown

Pin

1

2

3

4

5

6

7

8

Wire color

White-orange

White-green

Blue

White-blue

White-brown

Brown

Wire color

T568BT568B

White-orange

OrangeOrange

White-green

Blue

White-blue

GreenGreen

White-brown

Brown

Figure 4-3 — RJ-45 Ethernet connector pin assignments

Default IP parameters
To access the switcher via the Ethernet port, you need the Extron IP address and 
may need the subnet mask and the gateway address.  If the IP address has been 
changed to an address comprised of words and characters, you can determine the 
actual numeric IP address using the ping (ICMP) utility (see appendix A, “Ethernet 
Connection”, for more details).  If the addresses have not been changed, the factory-
specified defaults are:

•	 IP address	 192.168.254.254 
•	 Gateway address	 0.0.0.0 
•	 Subnet mask	 255.255.0.0
•	 DHCP	 off
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Establishing a connection
Establish a network connection to an MPX switcher as follows:

1.	 Open a TCP socket to port 23 using the switcher’s IP address.

N	 If the local system administrators have not changed the value, the factory-
specified default, 192.168.254.254, is the correct value for this field.

	 The switcher responds with a copyright message including the date, the name 
of the product, firmware version, part number, and the current date/time.

N	 If the switcher is not password-protected, the device is ready to accept SIS 
commands immediately after it sends the copyright message.

N	 If the switcher is password-protected, a password prompt appears below the 
copyright message.

2.	 If the switcher is password protected, enter the appropriate administrator or 
user password.

	 If the password is accepted, the switcher responds with Login User or 
Login Administrator.

	 If the password is not accepted, the Password prompt reappears.

Connection timeouts
The Ethernet link times out after a designated period of time of no communications.  
By default, this timeout value is set to 5 minutes but the value can be changed.  See 
the Configure port timeout commands on page 4-20.

N	 Extron recommends leaving the default timeout at 5 minutes and periodically 
issuing the Query (Q) command to keep the connection active.  If there are long 
idle periods, Extron recommends disconnecting the socket and reopening the 
connection when another command must be sent.

Number of connections
An MPX switcher can have up to 200 simultaneous TCP connections, including 
all HTTP sockets and Telnet connections.  When the connection limit is reached, 
the switcher accepts no new connections until some have been closed.  No error 
message or indication is given that the connection limit has been reached.  To 
maximize performance of an IP-enabled device, the number of connections should 
stay low and unnecessary open sockets should be closed.

Verbose mode
Telnet connections to an MPX switcher can be used to monitor for changes that 
occur on the switcher, such as front panel operations and SIS commands from 
other Telnet sockets or a serial port.  For a Telnet session to receive change notices 
from the switcher, the Telnet session must be in verbose mode 1 or 3.  See the “Set 
verbose mode” command on page 4-20.  In verbose mode 1 or 3, the Telnet socket 
reports changes by sending messages that resemble SIS command responses.
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Host-to-Switcher Instructions
The switcher accepts SIS commands through the RS-232 ports and Ethernet port.  
SIS commands consist of one or more characters per command field.  They do not 
require any special characters to begin or end the command character sequence.  
Each switcher response to an SIS command ends with a carriage return and a line 
feed (CR/LF = ]), which signals the end of the response character string.  A string 
is one or more characters.

Switcher-Initiated Messages
When a local event such as a front panel operation occurs, the switcher responds 
by sending a message to the host.  The switcher-initiated messages are listed below 
(underlined).

(C) Copyright 2008, Extron Electronics, MPX Plus 866 A, Vx.xx, 60-796-01,
date, time]

The switcher initiates the copyright message when it is first powered on or when 
connection via Internet protocol (IP) is established.  “Vx.xx“ is the firmware version 
number.  “68-796-01“ is the switcher’s part number.  “date/time“ is the date and time 
of the connection and is only reported when the connection is made via the LAN 
port.

]Password:
The switcher initiates the password message immediately after the copyright 
message when the controlling system is connected using TCP/IP or Telnet and the 
switcher is password protected.  This message means that the switcher requires an 
administrator or user level password before it will perform the commands entered 
via this link.  The switcher repeats the password message response for every entry 
other than a valid password until a valid password is entered.

]Login Administrator]
— or —

]Login User]
The switcher initiates the login message when a correct administrator or user 
password has been entered.  If the user and administrator passwords are the same, 
the switcher defaults to administrator privileges.

Qik]
The switcher initiates the Qik message when a front panel switching operation has 
occurred.

Sprnn]
The switcher initiates the Spr message when a memory preset has been saved from 
the front panel.  “nn” is the preset number.

Rprnn]
The switcher initiates the Rpr message when a memory preset has been recalled 
from the front panel.  “nn” is the preset number.

Innn•Audxx]
The switcher initiates the Aud message when a front panel input audio level change 
has occurred.  “nn” is the input number, • is a space, and “xx” is the dB level.

Outnn•Volxx]
The switcher initiates the Vol message when a front panel output audio volume 
change has occurred.  “nn” is the output number, • is a space, and “xx” is the 
volume level.
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Typnn•x]
The switcher initiates the Typ message when the video format for a video input is 
changed from the front panel.  “nn” is the input number, • is a space, and “x” is the 
format: 1 = composite video, 0 = S-video.

Vmtnn•x]
The switcher initiates the Vmt message when a video output mute is toggled on 
or off from the front panel.  “nn” is the output number, • is a space, and “x” is the 
mute status: 1 = on, 0 = off.

Amtnn•x]
The switcher initiates the Amt message when an audio output mute is toggled on 
or off from the front panel.  “nn” is the output number, • is a space, and “x” is the 
mute status: 1 = on, 0 = off.

Exen]
The switcher initiates the Exe message when executive mode is toggled on or off 
from the front panel.  “n” is the Lock (executive) mode status: 0, 1, or 2.

Switcher Error Responses
When the switcher receives an SIS command and determines that it is valid, it 
performs the command and sends a response to the host device.  If the switcher 
is unable to perform the command because the command is invalid or contains 
invalid parameters, the switcher returns an error response to the host.  The error 
response codes are:

	 E01 — Invalid input channel number (too large) 
	 E10 — Invalid command 
	 E11 — Invalid preset number 
	 E12 — Invalid output number (too large) 
	 E13 — Invalid value (out of range) 
	 E14 — Illegal command for this configuration 
	 E17 — Timeout (caused only by direct write of global ties presets) 
	 E24 — Privilege violation (Ethernet, Extron software only)

Using the Command/Response Tables
The command/response tables begin on page 4-9.  Lower case letters are acceptable 
in the command field except where indicated for the gain and attenuation 
commands.  The table below shows the hexadecimal equivalent of each ASCII 
character used in the command/response table.

ASCII to HEX  Conversion Table
Space

Symbols are used throughout the table to represent variables in the command/
response fields.  Command and response examples are shown throughout the table.
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Symbol definitions for basic SIS commands
]	 =	 CR/LF (carriage return/line feed) (hex 0D 0A)

}	 =	 Carriage return (no line feed, hex 0D)  (for URL-encoded commands, use the pipe character, | , instead)

•	 =	 Space character

|	 =	 Pipe (vertical bar) character

*	 =	 Asterisk character (which is a command character, not a variable)

E	 =	 Escape key (hex 1B)  (use W instead of Esc for Web browsers)

X!	 =	 Input number (for tie)	 00 = untied 
	 01 – 08 = the computer video group 
	 09 – 14 = the low resolution video group

X@	 =	 Output number	 01 – 12 for video 
	 01 – 06 for audio

N	 A video input from either of the two groups cannot be tied to an output in the other group. 
Audio can be tied to any output, regardless of the video group to which it was input.

X#	 =	 Input number	 01 – 08 for the computer video group 
	 09 – 14 for the low resolution video group

X$	 =	 Input signal format	 1 = composite video 
	 2 = S-video

X%	 =	 Mute, pre-peaking, Lock mode, power supply	 0 = off/mode 0/not OK 
	 1 = on/mode 1/OK 
	 2 = mode 2

X^	 =	 Volume adjustment range	 0 – 64 (1 dB/step except for 0-to-1, which is 34.5 dB) 
(see the table on page 4-11)

X&	 =	 Audio gain	 0 – 24 (1 dB/step)

X*	 =	 Numeric dB value	 -18 to +24 (45 steps of gain or attenuation)

X(	 =	 Audio attenuation	 1 – 18 (1 dB/step)

X1)	 =	 Preset #	 32 maximum (0 = current configuration)

X1!	 =	 Name (for presets, inputs, and outputs)	 12 characters maximum 
	 Upper- and lower-case alphanumeric characters and 
	 _  :  =  /  and space are valid.

N	 The following characters are invalid in the name: ~ , @ ‘ [ ] { } < > ’ “ ; | \ and ?.

X1@	 =	 Video/audio mute:	 0 = no mutes	 4 = audio right (AR) mute 
	 1 = video mute	 5 = video and AR mute 
	 2 = audio left (AL) mute	 6 = AL and AR (all audio) mute 
	 3 = video and AL mute	 7 = video, AL, and AR (all audio) mute

X1#	 =	 Sync frequency	 xxx.xx (frequency in Hz (V) or kHz (H))

X1$	 =	 Signal detection	 0 = no input detected, 1 = input detected

X1%	 =	 RGB delay interval	 Delay in ½ second increments (10 maximum)

X1^	 =	 Firmware version number to second decimal place (x.xx)

X1&	 =	 Verbose firmware version-description-upload date/time.  See page 4-18.

X1*	 =	 Voltage	 Positive or negative voltage and magnitude

X1(	 =	 Temperature	 Degrees Fahrenheit

X2)	 =	 Group master group number	 01 - 32 (repeated as X6$ in appendix B,”DSP SIS Commands”)
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Command/response table for basic SIS commands

Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Create ties
N	 •	Video ties cannot be made between the computer video group and the low resolution video group.

•	Program audio ties can be made only to the computer/audio output group (outputs 1 through 6).
•	Mixing audio inputs into the output audio using SIS commands requires a complex command.  See appendix B, 

“Command/Response table for DSP SIS commands”.

•	Video and audio ties between the low resolution video input group and the low resolution video outputs group are 
always made with the program audio redirected.  In such an operation, the switcher automatically ties the audio to an 
output in the computer/audio outputs group (outputs 1 through 6) as follows:
	 If the video is tied to output 7, the audio is tied to output 1. 
	 If the video is tied to output 8, the audio is tied to output 2. 
	 If the video is tied to output 9, the audio is tied to output 3. 
	 If the video is tied to output 10, the audio is tied to output 4. 
	 If the video is tied to output 11, the audio is tied to output 5. 
	 If the video is tied to output 12, the audio is tied to output 6.

•	Commands can be entered back-to-back in a string, with no spaces.  For example: 1*1!02*2&02*04%4*6$.
•	The quick multiple tie and tie input to all output commands activate all I/O switches simultaneously.
•	The matrix switchers support 1-, 2-, and 3-digit numeric entries (1*1, 02*02, or 003*003).

N	 The & tie command for RGB and the % tie command for video can be used interchangeably on the matrix switcher, but 
you cannot switch between groups.  The switcher returns an X13 error if you try.

N	 The & view tie command for RGB and the % view tie command for video can be used interchangeably on the matrix 
switcher.

Tie input X! to output X@, 
video and audio

X!*X@! OutX@•InX!•All] (within computer video group)
— or —
Qik] (within low resolution video group [because of automatic 
audio redirect switching])

Tie input X@‘s video and 
audio to output X#. 

Example: 1*3! Out03•In01•All] Tie input 1 video and audio 
to output 3. 

Example: 11*9! Qik] Tie input 11 video to output 9 
and input 11 audio to output 5. 

Tie input X! to output X@, 
computer video only

X!*X@& OutX@•InX!•RGB] Audio breakaway switching.

Example 
(see 2nd note, above)

5*4& Out04•In05•RGB] Tie input 5 RGB to output 4. 

Tie input X! to output X@, 
video only

X!*X@% OutX@•InX!•Vid] Audio breakaway switching. 

Example 
(see 2nd note, above)

9*7% Out07•In09•Vid] Tie input 9 video to output 7.

Tie input X! to output X@, 
audio only

X!*X@$ OutX@•InX!•Aud] Audio breakaway switching. 

Example: 12*4$ Out04•In12•Aud] Tie input 12 audio to output 4.

Quick multiple tie E+QX!*X@!...X!*X@$} Qik]
Example: E+Q3*4!3*5%3*6$} Qik] Tie input 3 video and audio 

to output 4, tie input 3 video 
to output 5, and tie input 3 
audio to output 6.

N	 X! = Input number	 00 = untied 
	 01 – 08 = the computer video group 
	 09 – 14 = the low resolution video group 
X@ = Output number	 01 – 12 for video 
	 01 – 06 for audio
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Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Create ties (continued)
Tie input to all outputs, 
video and audio

X!*! InX!•All]

Example: 5*! In05•All] Tie input 5 video and audio 
to all computer video group 
outputs.

Tie input to all outputs, 
RGBHV only

X!*& InX!•RGB] Audio breakaway switching.

Example 
(see 2nd note on page 4-9)

8*& In08•RGB] Tie input 8 video to all 
computer video group 
outputs.

Tie input to all outputs, 
video only

X!*% InX!•Vid] Audio breakaway switching.

Example 
(see 2nd note on page 4-9)

10*% In10•Vid] Tie input 10 video to all 
low resolution video group 
outputs.

Tie input to all outputs, 
audio only

X!*$ InX!•Aud] Audio breakaway switching.

Read RGB output tie X@& X!] RGBHV input X! tied to 
output X@.

Read video output tie X@% X!] Video input X! tied to 
output X@.

Read audio output tie X@$ X!] Audio input X! tied to 
output X@.

Set input format
Set input video format X!*X2$\ TypX!*X2$] Set the video format to X$ 

for input X!.
1 = composite video 
2 = S-video

N	 The only valid input (X!) numbers are 11 through 14.
Example: 11*1\ Typ11*1] Set input 11 to composite 

video.
Read input format X!\ X2$] Show the video format of 

input X!.

Video mute commands
RGB/video mute X@*1B VmtX@*1] Mute output X@ RGB (video 

off).
RGB/video unmute X@*0B VmtX@*0] Unmute output X@ RGB 

(video on).
View RGB/video mute X@B X%] 1 = mute on, 0 = mute off.

Global RGB/video mute 1*B Vmt1] Mute all RGB outputs.

Global RGB/video unmute 0*B Vmt0] Unmute all RGB outputs.

Command/response table for basic SIS commands (continued)

N	 X! = Input number	 00 = untied 
	 01 – 08 = the computer video group 
	 09 – 14 = the low resolution video group 
X@ = Output number	 01 – 12 for video 
	 01 – 06 for audio 
X# = Input number	 11 – 14 for configurable inputs 
X$ = Input signal format	 1 = composite video 
	 2 = S-video 
X% = Mute	 0 = off (unmuted) 
	 1 = on (muted)
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Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Audio output volume
N	 •	 Individual controls, offering finer trim adjustments (in 0.1 dB increments) for the right and left channels and group 

master offsets are present in the DSP and available through software control (see “DSP Configurator Program”, in 
chapter 5, “Switcher Software“).  The results of these controls are not shown in the responses below.

•	 The table below the commands defines the value of each audio volume step.
Set the audio volume to a 
specific value

X@*X^V OutX@•VolX^]

Example: 1*50v Out01•Vol50] Set output 1 volume to 79%.

Increment volume X@+V OutX@•VolX^] Increase volume by 1 step.

Example: 1+V Out01•Vol51]
Decrement volume X@-V OutX@•VolX^] Decrease volume by 1 step.

View output volume X@V X^]

41

40

38.5%

40%

dB of
attenuation

Output
volume

63

61

62

60

59

57

58

56

55

53

54

52

51

49

50

48

5.5%

8.5%

7%

100 0%00

10%

11.5%

14.5%

13%

16%

17.5%

20.5%

19%

22%

23.5%

26.5%

25%

28%

47

45

46

44

43

42

29.5%

32.5%

31%

34%

35.5%

37%

dB of
attenuation

Output
volume

39

38

37

35

36

34

33

31

32

30

29

27

28

26

41.5%

43%

44.5%

47.5%

46%

49%

50.5%

53.5%

52%

55%

56.5%

59.5%

58%

61%

25

23

24

22

21

20

62.5%

65.5%

64%

67%

68.5%

70%

dB of
attenuation

Output
volume

19

17

18

16

15

13

14

12

11

9

10

8

7

5

6

4

71.5%

74.5%

73%

76%

77.5%

80.5%

79%

82%

83.5%

86.5%

85%

88%

89.5%

92.5%

91%

94%

3

1

2

0

95.5%

98.5%

97%

100%

01

02

03

04

05

06

07

08

09

10

11

12

13

14

15

16

17

18

19

20

45

46

47

48

49

50

51

52

53

54

55

56

57

58

59

60

61

62

63

64

21

22

23

24

25

26

27

28

29

30

31

32

33

34

35

36

37

38

39

40

41

42

43

44

valuevaluevalueX6 X6 X6

Command/response table for basic SIS commands (continued)

N	 X@ = Output number	 01 – 06 
X^ = Audio attenuation	 00 – 64 (1 dB/step except for 0-to-1, which is 36 dB)
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N	 X@ = Output number	 01 – 06 for audio 
X# = Input number	 01 – 14 
X% = Mute	 0 = off (unmuted) 
	 1 = on (muted) 
X& = Audio gain	 0 – 24 (1 dB/step) 
X* = Numeric dB value	 –18 to +24 (45 steps of gain or attenuation) (Default = 0 dB) 
X( = Audio attenuation	 1 – 18 (1 dB/step 

Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Audio input gain and attenuation
N	 •	The set gain (G) and attenuation (g) commands are case sensitive.  The increment, decrement, and read level commands 

are not case sensitive.

•	 Individual controls, offering finer trim adjustments (in 0.1 dB increments) for the right and left channels and group 
master offsets are present in the DSP and available through software control (see “DSP Configurator Program”, in 
chapter 5, “Switcher Software“).  The results of these controls are not shown in the responses below.

Set input audio gain to 
+ dB value

X#*X&G InX#•AudX*]

Example: 1*2G In01•Aud+02] Set input 1 audio gain to 
+2 dB.

Set input audio attenuation 
to - dB value

X#*X(g InX#•AudX*]

Increment level X#+G InX#•AudX*] Increase audio level by 1 dB.

Example: 6+G In06•Aud+03] Increment audio input 6 
level from +2 dB to +3 dB.

Decrement level X#-G InX#•AudX*] Decrease audio level by 1 dB.

Example: 7-G In07•-09] Decrement audio input 7 
level from -08 dB to -9 dB.

Read input audio level X#G X*]
Audio mute

Audio mute X@*1Z AmtX@*1] Mute audio output X@ 
(audio off).

Audio unmute X@*0Z AmtX@*0] Unmute audio output X@ 
(audio on).

Read audio mute X@Z X%] 1 = mute on, 0 = mute off.

Global audio mute 1*Z Amt1] Mute all audio outputs.

Global audio ummute 0*Z Amt0] Unmute all audio outputs.

Command/response table for basic SIS commands (continued)•	 Individual controls, offering finer trim adjustments (in 0.1 dB increments) for the right 
and left channels and group master offsets are present in the DSP and available through 
software control (see “DSP Configurator Program”, in chapter 5, “Switcher Software“).  
The results of these controls are not shown in the responses below.
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Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Save, directly write, name, and recall presets

N	 •	 If the user tries to recall a preset that is not saved, the matrix switcher responds with the error code E11.
•	The following characters are invalid in preset names: + ~ ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  |  \  and ?.

Save the current 
configuration as a global 
ties preset

X1), SprX1)] Command character is a 
comma.

Example: 9, Spr09] Save current ties as preset 9.

Direct write process —

N	 The direct write of a global ties preset command should always be preceded by a clear global ties preset command 
of that same preset number, as shown below.  In a directly-written preset, each output position’s tied input (or no tied 
output) remains unchanged unless overwritten or cleared.

	 If you do not clear a global ties preset number before you directly write a global ties preset to that number, ties that are 
part of the previous version of the specified preset can unexpectedly become part of the newly-created preset.

Clear a global ties preset E+X1)P0*!} SprX1)] Clear all ties in preset X1).
Directly write a global 
ties preset

E+X1)PX!*X@!X!*X@%X!*X@$ ... X!*X@&} Enter as many ties as are 
valid for this model.  The 
tie all (!), tie RGBHV (&), tie 
video (%), and tie audio ($) 
commands are all valid.

SprX1)]

Example: E+27P0*!} Spr27]

E+27P2*5!10*2$13*11%3*6& Brackets are shown to 
separate ties for clarity only.  
Create global ties preset 27, 
which ties video and audio 
input 2 to output 5, 
audio input 10 to output 2, 
video input 13 to output 11, 
and video input 3 to output 6.

Spr27]

Recall a global or partial 
preset

X1). RprX1)] Command character is a 
period.

Example: 5. RprX1)] Recall preset 5, which 
becomes the current 
configuration.

Write preset name EX1),X1!NG} NmgX1),X1!]
Example: E1,Security 1NG} Nmg01,Security 1] Name preset 1 “Security 1”.

Read preset name EX1)NG} X1!]
Example: E2NG} Security 2]

Command/response table for basic SIS commands (continued)

N	 X! = Input number	 00 – 14 (00 = untied) 
X@ = Output number	 01 – 12 for video 
	 01 – 06 for audio 
X1) = Preset #	 32 maximum (0 = current configuration) 
X1! = Name	 12 characters maximum
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Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

View ties, gain, volume, mutes, presets, file status, DSVP, and input status

Read RGB output tie X@& X!] RGBHV input X! tied to 
output X@.

Read video output tie X@% X!] Video input X! tied to 
output X@.

Read audio output tie X@$ X!] Audio input X! tied to 
output X@.

Read input audio level X#G X*]
Example: 4G -02] Gain for input 4 is -2 dB.

View output volume X@V X^]
Example: 7V 55] Volume for output 7 is 55 steps 

(9 dB of attenuation, 86.5% of 
total volume).

Read input video format X#\ X$] Show the video format of 
input X#.

N	 The only valid input (X@) numbers are 11 through 14.
View output mutes EVM} X1@1X1@2X1@3 ... X1@12] Each X1@ response is the 

mute status of an output, 
starting from output 1.

Example: EVM} Mut0 230 1 0 0 0 0 0 00] Output 2 audio left is muted, 
output 3 video and the left 
audio channel are muted, 
and output 5 video and the 
right audio channel are 
muted. 
All other outputs are unmuted.

N	 The “Mut” portion of the response appears only when the switcher is in Verbose mode 2 or 3.  See the Verbose mode 
command on page 4-20.

Command/response table for basic SIS commands (continued)

N	 X! = Input number for tie	 00 – 14 (00 = untied) 
X@ = Output number	 01 – 12 for video 
	 01 – 06 for audio 
X# = Input number	 01 – 14 
X$ = Input signal format	 1 = composite video 
	 2 = S-video 
X^ = Volume adjustment range	 00 – 64 (1 dB/step except for 0-to-1, which is 13 dB) 
X* = Numeric dB value	 -18 to +24 (Default = 0 dB) 
X1@ = Video/audio mutes	 0 = no mutes		  4 = audio right (AR) mute 
	 1 = video mute		  5 = video and AR mute 
	 2 = audio left (AL) mute		  6 = AL and AR mute 
	 3 = video and AL mute		  7 = video, AL, and AR mute 
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Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

View ties, gain, volume, mutes, presets, file status, DSVP, and input status (continued)
View video preset 
configuration

EX1)*1*1VC} X!1•X!2•X!3• ... •X!16•Vid]
Show preset X1)’s video 
configuration.  Show the video 
input tied to 12 sequential 
outputs, starting from output 
1.  (Video outputs 13 through 
16 are not present on this 
switcher model.)

Command description:
Response description:

Preset# * starting output# (StO# [“1” for this switcher]) * 1(=video) VC
Input# (I#) tied to output# (O#)1•I# tied to O#2•I# tied to O#3• ... •I# tied to O#16•Vid]

Example: E4*1*1VC}

01Output:
Response = tied input:

Input 4 tied to output 3

02 03 04 05 06 07
08•08•04•08•08•00•09•00•10•10•10•10•--•--•--•--•Vid

13

No tied input

Computer/Audio Group Video Group Outputs not present
14 15 1608 09 10 11 12

Each position shown in the response is an output: left = starting, right = output 12 (outputs 13 through 16 are not 
present on this switcher model).  The number in each position is the input tied to that output.
Video — Input 8 is tied to outputs 1, 2, 4, and 5; input 4 to output 3; input 9 to output 7; and input 10 to outputs 10 
through 12.  No input is tied to outputs 6 and 8.

N	 If you enter EX1)*1*1VC} where X1) = 0, the switcher returns its current video configuration.
View audio preset 
configuration

EX1)*1*2VC} X!1•X!2•X!3• ... •X!16•Aud]
Show preset X1)’s audio 
configuration.  Show 
the audio input tied to 6 
sequential outputs, starting 
from output 1.  (Audio 
outputs 7 through 16 are 
not present on this switcher 
model.)

Command description:
Response description:

Preset# * starting output# (StO# [“1” for this switcher]) * 2(=audio) VC
I# tied to O#1•I# tied to O#2•I# tied to O#3•I# tied to O#4 ... •I# tied to O#16•Aud]

Example: E4*1*2VC}

01Output:
Response = tied input:

Input 6 tied to output 3

02 03 04 05 06
02•04•06•08•10•12•--•--•--•--•--•--•--•--•--•--•Aud

13

Input 12 tied to output 6

Computer/Audio
Group

Outputs not
present

14 15 1607 08 09 10 11 12

Each position shown in the response is an output: left = starting, right = output 6 (outputs 7 through 16 are not 
present on this switcher model).  The number in each position is the input tied to that output.
Audio — Input 2 is tied to output 1, input 4 is tied to output 2, input 6 is tied to output 3, input 8 is tied to output 4, 
input 10 is tied to output 5, and input 12 is tied to output 6. 

N	 If you enter EX1)*1*2VC} where X1) = 0, the switcher returns its current audio configuration.

Command/response table for basic SIS commands (continued)

N	 X! = Input number	 00 or 01 – 14 
X1) = Preset #	 32 maximum (0 = current configuration) 
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Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

View ties, gain, volume, mutes, presets, file status, DSVP, and input status (continued)
N	 The response to the View file directory command differs, depending on whether the command is sent via an RS-232 or 

Telnet connection or sent via a Web browser connection.
View file directory 
RS-232 and Telnet

EDF} filename1,date/time,length] 
filename2,date/time,length] 
filename3,date/time,length] 
	 •	 • 
	 •	 • 
filenamen,date/time,length]

List user-supplied files.

space_remaining Bytes•Left]]
View file directory 
Web browser

EDF} Var file = new array (); List user-supplied files.

File [1] = ‘filename1,date1,filesize1’, 
File [2] = ‘filename2,date3,filesize2’, 
File [3] = ‘filename3,date3,filesize3’, 
	 •	 • 
	 •	 • 
File [n] = ‘filenamen,daten,filesizen’, 
File [n+1] = space_remaining Bytes•Left]]

Erase user-supplied Web 
pages/files

EfilenameEF} Delfilename]

List individual sync 
frequency 
(Computer video input group, 
inputs 1 through 8 only)

X#LS X1#,X1#] Listed as horizontal frequency, 
vertical frequency.

Example: 2LS 031.50,060.00] Input 2 horizontal frequency 
is 31.5 kHz and its vertical 
frequency is 60 Hz.

N	 The matrix switcher returns 000.00,000.00 if there is no connection or sync frequencies are not applicable.
List input signal status for 
all video inputs

0LS X1$1X1$2X1$3 ... X1$14] Each X1$ value is an input.

RGB delay (ties to outputs in the computer video group only)
Set RGB delay EX@*X1%D} OutX@•DlyX1%]

Example: E4*7D} Out04•Dly07] Set the RGB interval for ties 
to output 4 to 3.5 seconds 
(7 x 0.5).

Read RGB delay EX@D} X1%]
Example: E5D} 05] Output 5 switching interval 

is 2.5 seconds (5 x 0.5).

Command/response table for basic SIS commands (continued)

N	 X@ = Output number	 01 – 12 for video 
	 01 – 06 for audio 
X# = Input number	 01 – 14 
X1# = Sync frequency	 xxx.xx (frequency in Hz (V) or kHz (H)) 
X1$ = Signal detection	 0 = no input detected, 1 = input detected 
X1% = RGB delay interval	 Delay in ½ second increments (10 maximum) 
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Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Names
Write preset name EX1),X1!NG} NmgX1),X1!]

Example: E1,Security 1NG} Nmg01,Security 1] Name preset 1 “Security 1”.

Read preset name EX1)NG} X1!]
Example: E2NG} Security 2]

Write input name EX#,X1!NI} NmiX#,X1!]
Example: E9,Podium cam1NI} Nmi09,Podium cam] Name input 9 “Podium cam”.

Read input name EX#NI} X1!]
Write output name EX@,X1!NO} NmoX@,X1!]

Example: E1,Main PJ1NO} Nmo01,Main PJ1] Name output 1 “Main PJ1”.

Read output name EX@NO} X1!]
Lock (executive) modes

N	 See “Setting the front panel locks (Executive modes)” in chapter 3, “Operation”, for more information on Lock modes.
Lock all front panel functions 1X Exe1] Enable Lock mode 1.

Lock advanced front panel 
functions

2X Exe2] Enable Lock mode 2.

Unlock all front panel functions 0X Exe0] Enable Lock mode 0.

View lock status X X%]
Resets

Reset presets and names EZG} Zpg] Clear all presets and their 
names.

Reset an individual preset EX1)ZG} ZpgX1)] Clear preset X1).
Reset RGB delays EZD} Zpd] Reset all RGB delays to 

0.0 seconds.
Reset audio input levels EZA} Zpa] Reset all audio input levels 

(gain and attenuation) to 0 dB.
Reset audio output levels EZV} Zpv] Reset all audio output 

levels (volume) to 100% 
(no attenuation).

Reset all mutes EZZ} Zpz] Reset all video and audio 
mutes.

Reset a group EZX2)GRPM} GrpmZX2)] Delete all members from 
group X2), reset parameters 
and soft limits.

N	 See “Group masters“, in chapter 5, “Switcher Software“, for more information about audio group masters.
Reset flash EZFFF] Zpf] Reset flash memory 

(erase user-supplied files).
Reset whole switcher EZXXX} Zpx] Clear all ties and presets, 

resets all audio gains to 0 dB, 
and resets the volume to 100%.

Absolute reset EZQQQ} Zpq] Similar to Reset whole 
switcher, plus sets the IP 
address to 192.168.254.254 
and the subnet mask to 
255.255.0.0.

Command/response table for basic SIS commands (continued)

N	 X# = Input number	 01 – 14 
X@ = Output number	 01 – 12 for video	 01 – 06 for audio 
X% = Lock mode	 0 = mode 0	 1 = mode 1	 2 = mode 2 
X1) = Preset #	 32 maximum (0 = current configuration) 
X1! = Name	 12 characters maximum 
X2) = Group master group number	 01 – 32 
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Command/response table for basic SIS commands (continued)

Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Information requests
Information request I V14X12•A14X12] This matrix switcher has 14 

video and 14 audio inputs 
by 12 video and 12 audio 
outputs.

Request part number N 60-796-01 The MPX part number is 
68-796-01.

N	 There are up to three separate sets of Extron firmware that the switcher can report on: the MPX controller firmware, 
which is the overall control firmware; the Ethernet protocol firmware, which handles the Ethernet interface; and the 
latest optional Extron firmware update, which is available at www.Extron.com.

Query controller firmware 
version

Q X1^]

Example: Q 1.23] The factory-installed MPX 
controller firmware version 
is 1.23 (sample value only).

Query software version 
(verbose)

0Q X1^-X1&-X1&] Provide a detailed status 
of the Ethernet protocol 
firmware, the MPX controller 
firmware, and any firmware 
upgrade.  The firmware that 
is running is marked by 
an asterisk (*).  A caret (^) 
indicates that the firmware 
has a bad checksum or an 
invalid load.  ?.?? indicates 
that the firmware is not 
loaded.

Response description: Ethernet protocol firmware version - controller firmware version - updated firmware version]
Example: 0Q

Ethernet protocol
firmware

Response:

Description

MPX firmware version
1.23-0.14(0.20-MPX866D Series   -Wed,	16	Jan	2003	00:00:00	GMT)-0.25*(0.24-MPX866D	Series			-Mon,	08	Sep	2008	14:48:30	GMT)

Updated firmware version

* indicates the version running Upload date and time

Request system status S X1*•X1*•X1*•X1*•X1*•X1(]
Response description: +3.3V•+5V•-5V•+2.5V•-15V•+15V•Temp]
Example: S

3.29•5.04•-5.14•15.27•-15.15•120.20

-15V power system at -15.15V

Temperature 120.20 degrees3.3V power system at 3.29V

N	 X1^ = Firmware version number to second decimal place (x.xx) 
X1& = Verbose firmware version-description-upload date/time 
X1* = Voltage	 Positive or negative voltage and magnitude 
X1( = Temperature	 Degrees Fahrenheit 
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Symbol definitions for IP SIS commands
X3)	 =	 Matrix name	 (Up to 240 characters)

N	 The following characters are invalid in the name: {space}  ~  ,  @  =  `  [  ]  {  }  <  >  ‘  “  ;  :  \  |  and  ?.

X3!	 =	 Default name	 Factory default name (model name + last 3 pairs of MAC address)

X3@	 =	 Time and date (set)	 In the format: MM/DD/YY•HH:MM:SS where: 
	 MM = month: 01 (January) through 12 (December) 
	 DD = day: 01 through 31 
	 YY = year: 00 through 99 
	 HH = hour: 00 through 24 
	 MM = minutes: 00 through 59 
	 SS = seconds: 00 through 59

X3#	 =	 Time and date (read)	 In the format: Day,•DD•Mmm•YYYY•HH:MM:SS where 
	 Day = weekday: Mon through Sun 
	 DD = day: 01 through 31 
	 Mmm = month: Jan through Dec 
	 YYYY = year: 2000 through 2099 
	 HH = hour: 00 through 24 
	 MM = minutes: 00 through 59 
	 SS = seconds: 00 through 59

X3$	 =	 GMT offset	 -12.0 through +14.0 (hours and minutes removed from GMT)

X3%	 =	 Daylight Savings Time	 0 = Daylight Savings Time off/ignore 
	 1 = Daylight Savings Time on (northern hemisphere) 
	 2 = Daylight Savings Time on (Europe) 
	 3 = Daylight Savings Time on (Brazil)

X3^	 =	 IP address	 ###.###.###.###

X3&	 =	 Hardware (MAC) address	 ##-##-##-##-##-##

X3*	 =	 Number of open connections	 0 - 255

X3(	 =	 Password	 12 alphanumeric characters

N	 The following characters are invalid in passwords: {space}  ~  ,  @  =  `  [  ]  {  }  <  >  ‘  “  ;  :  \  |  and  ?.

X4)	 =	 Domain name	 Standard domain name conventions apply (for example, xxx.com)

N	 The following characters are invalid in passwords: {space}  ~  ,  =  `  [  ]  {  }  <  >  ‘  “  ;  :  \  |  and  ? 
The @ character is only acceptable as the lead-in to the domain name (such as @extron.com).

X4^	 =	 DHCP	 0 = off, 1 = on

X4&	 =	 Port #	 01 = rear panel RS-232 Primary port 
	 02 = rear panel RS-232 Secondary port/front panel Cofiguration port

N	 The rear panel RS-232 Secondary port (X4& = 02) is active only if the front panel Configuration port is not in use.  If a front panel 
configuration connection is made, the rear panel RS-232 Secondary port becomes inactive and the front panel Configuration port is 
active.

X4*	 =	 Baud rate	 9600, 19200, 38400, 115200

X4(	 =	 Parity	 Odd, even, none, mark, space (only first letter required)

X5)	 =	 Data bits	 7, 8

X5!	 =	 Stop bits	 1, 2

X5@	 =	 Port type	 0 = RS-232	 1 = RS-422

X5#	 =	 Verbose mode	 0 = Clear/none (default for Telnet connection 
	 1 = Verbose mode (default for RS-232 connection) 
	 2 = Tagged responses for queries 
	 3 = Verbose mode and tagged for queries

N	 If tagged responses is enabled, all read commands return the constant string and the value as the set command does (for example, the read 
matrix name command, ECN}, returns IPN•X3)]).

X5$	 =	 Security level	 00 = Anonymous 
	 10 = Extended security levels 1 through 10 
	 11 = User 
	 12 = Administrator

X5%	 =	 RAM status	 0 = RAM dirty (needs saving to flash) 
	 1 = RAM has been saved (ok to power off / reset)

X5^	 =	 Port timeout interval (in 10-sec. increments)	 1 (= 10 seconds) – 65000 (default is 30 = 300 seconds = 5 minutes)
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Command/response table for IP SIS commands

Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Set matrix name (location) EX3)CN} Ipn•X3)]
Read matrix name (location) ECN} X3)]
Reset matrix name to 
factory default

E•CN} Ipn•X3!]

Set time and date EX3@CT} IptX3@]
Read time and date ECT} X3#]
Set GMT offset EX3$CZ} IpzX3$] The divider between 

hours and minutes is a 
period.

Read GMT offset ECZ} X3$]
Set Daylight Savings Time EX3%CX} IpxX3%] Set the switcher to display 

the local time as Daylight 
Savings Time (+1 hour) in 
summer months.

Read Daylight Savings Time ECX} X3%]
Set IP address EX3^CI} IpiX3^]
Read IP address ECI} X3^]
Read hardware address ECH} X3&]
Read # of open connections ECC} X3*]
Set subnet mask EX3^CS} IpsX3^]
Read subnet mask ECS} X3^]
Set gateway IP address EX3^CG} IpgX3^]
Read gateway IP address ECG} X3^]
Set administrator password EX3(CA} Ipa•X3(]
Read administrator 
password

ECA} X3(]

Reset (clear) administrator 
password

E•CA} Ipa•X3(]

Set user password EX3(CU} Ipu•X3(]
Read user password ECU} X3(]
Reset (clear) user password E•CU} Ipu•X3(]
Set DHCP on or off EX4^DH} IdhX4^]
Read DHCP status EDH} X4^]
Set serial port parameters EX4&*X4*,X4(,X5),X5!CP} X4*,X4(,X5),X5!]
Read serial port parameters EX4&CP} CpnX4&•CcpX4*,X4(,X5),X5!]
Set serial port mode EX4&*X5@CY} CpnX4&•CtyX5@]
N	 All serial ports are limited to the RS-232 protocol only.

Read serial port mode EX4&CY} X5@]
Set verbose mode EX5#CV} VrbX5#]
Read verbose mode ECV} X5#]
Read connection’s security 
level

ECK X5$]

Commit RAM to flash 
memory

E1FF} NvrX5%]

Check RAM EFF} X5%]
Configure current port 
timeout

E0*Y7^TC} Pti0*Y7^]

Read current port timeout E0TC} Y6*]
Configure global IP port 
timeout

E1*Y7^TC} Pti1*Y7^]

Read global IP port timeout E1TC} Y7^]
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Special Characters
The HTML language reserves certain characters for specific functions.  The switcher 
will not accept these characters as part of preset names, the switcher’s name, 
passwords, or locally created file names.

The switcher rejects the following characters: 
{space (spaces are ok for names)}  +  }  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  semicolon (;)  
colon (:)  |  \  and ?.
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Control Software
The Windows®-based Extron Digital Signal Processor (DSP) Configurator 
program and Matrix Switchers Control Program communicate with the switcher 
via the Ethernet LAN port, either rear panel RS-232 port, and the front panel 
Configuration (RS-232) port to provide an easy way to set up ties and sets of ties.  
The DSP Configurator further provides a tool for configuring and controlling all 
of the advanced MPX Plus DSP audio mixing and other processing functions.  The 
programs are compatible with Windows 2000, Windows XP, and later.  Updates to 
these programs can be downloaded from the Extron Web site (www.extron.com).

Installing the software
The programs are contained on the Extron Software Products Disk.  Install the 
software as follows:

N	 For full functionality, install all of the following programs:

	 •	 DSP Configurator

	 •	 Matrix Switchers Control Program

	 •	 Firmware Loader

1.	 Insert the disk into the drive.  The installation program should start 
automatically.  If it does not self-start, run Launch.exe from the disk.

	 The Extron software disk window appears (figure 5-1).

Figure 5-1 — Software disk window

2.	 Click the Software tab (figure 5-1).

3.	 Scroll to the desired program and click Install (figure 5-2).

	

Figure 5-2 — Software installation
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4.	 Follow the on-screen instructions.

	 By default, the installation of the DSP Configurator program creates a 
C:\Program Files\Extron\DSP_Configurator directory, and it places the 
following four icons into a group folder named “Extron Electronics\DSP 
Configurator”:

	 	 •	 DSP Configurator

	 	 •	 DSP Configurator Help

	 	 •	 Uninstall DSP Configurator

	 	 •	 Check for DSP Configurator Updates

	 By default, the installation of the Matrix Switchers Control Program creates 
a C:\Program Files\Extron\Matrix_Switchers directory, and it places the 
following four icons into a group folder named “Extron Electronics\Matrix 
Switchers”:

	 	 •	 MATRIX Switcher+ Control Program

	 	 •	 MATRIX Switcher+ Help

	 	 •	 Uninstall MATRIX Switcher

	 	 •	 Check for Matrix Updates

Software operation via serial port
The MPX Plus switcher can support remote control via either rear panel RS-232 
port or the front panel Configuration port.  The program can operate at 9600, 19200, 
38400, or 115200 baud rates for either port.  See “Selecting the RS-232 Primary port’s 
baud rate” in chapter 3, “Operation”, to configure the rear panel Remote RS-232 
Primary port from the front panel.  See the Serial port configuration commands on 
page 4-20 to configure any of the serial ports using an SIS command.

Software operation via Ethernet
When a matrix switcher is connected to an Ethernet WAN or LAN, up to 200 users 
can operate it, locally or remotely, using the DSP Configurator or the Matrix 
Switchers Control Program.  See “Ethernet connection”, in chapter 2, “Installation”, 
for installation details.

Connection to the switcher via the Ethernet for the Matrix Switchers Control 
Program may be password protected.  There are two levels of password protection: 
administrator and user.  Administrators have full access to all switching capabilities 
and editing functions.  Users can select inputs and outputs, set and recall presets, 
and view all settings with the exception of passwords.  If the same password or 
no password is required for logging on, all personnel log on with administrator 
privileges.  Fields and functions that exceed user privileges are blocked in the 
applicable programs when the operator is logged on as a user.

Ethernet protocol settings
The IP Settings/Options screen of the Matrix Switchers Control Program 
(figure 5-26 on page 5-44) provides a location for viewing and, if connected via 
the RS-232 link or if logged on via the Ethernet port as an administrator, editing 
settings unique to the Ethernet interface.  See “IP Settings/Options window” later 
in this chapter for more details.
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DSP Configurator Program	

Starting the program
N	 Extron recommends connection via the Ethernet LAN port for the DSP 

Configurator program.

To run the DSP Configurator Program, click Start > Programs > Extron Electronics 
> DSP Configurator > DSP Configurator.  The DSP Configurator program starts in 
Emulate mode (figure 5-3, on the next page).

Using the program
In the DSP Configurator window in Emulate mode, you can tailor a variety of audio 
parameters and then transfer them to the MPX by going to Live mode (connected to 
an MPX).  You can also switch to Live mode and then tailor the audio settings in real 
time, while listening to the audio output with a critical ear.  See “Emulate mode vs. 
Live mode”, later in this chapter.

N	 There are three possible DSP Configurator displays:

•	 Audio and video I/O page (figure 5-3)
•	 Audio-only I/O page
•	 Video-only I/O page

	 The DSP Configurator program  always starts in the audio and video I/O page, 
as shown in figure 5-3.  Three additional control blocks are availalable in the 
video-only I/O page.  See “Video-only I/O page controls“, later in this chapter.
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Figure 5-3 — DSP Configurator program window

The DSP Configurator program window consists of a number of signal processor 
chains, an A/V matrix block, and a mic mixer block.

a	 Program audio input (computer/audio group and video/audio group) signal 
processor chains

b	 Mic/line input signal processor chain

c	 A/V matrix block

d	 Output signal processor chain (pre mic mixer)

e	 Mic mixer block

f	 Output signal processor chain (post mic mixer)

g	 DSP usage meter.  See “DSP capacity and design rule verification“, on page 5-30.

N	 The usage meter is shown partially filled for reference only.  On startup, it is at 
0%.
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Audio signal processor chains and control blocks
Each of the four signal processing chains (a, b, d, and f) consists of a series of 
control blocks of two basic types that are specific to that chain: gain, trim, post-gain, 
and volume control blocks (collectively known as “gain blocks” – ) and processor 
blocks ( ).  For example, the computer audio input 1 chain consists of a gain fader, 
a filter block, two dynamic blocks, a delay block, and a trim fader.  Gain controls 
are always present (active) in the signal processor chain.  Processor blocks, while 
always shown in the program window, must be individually activated (“inserted”) 
as shown in figure 5-5.

Many gain blocks can be muted and process block controls can be bypassed.  Mutes 
and bypasses are shown by red indicator(s) in the block.

Gain blocks — The parameters set by the gain blocks are always present in the 
signal chain.  To access the actual fader control to view a value, make a 
change, or observe a live audio meter (Gain and Trim blocks only), double-
click the gain block icon (figure 5-4).  This action opens a dialog box, a new 
window that contains the fader for that control.

	

NOTE

A dialog box opens,
which contains the

full fader control. 

The meter display is for 
example only.  In Emulate 
mode (the startup mode), 
the meter is not operational.

Figure 5-4 — Accessing a typical gain control dialog box

Processor blocks — Each processor block control represents a menu of one or more 
possible processes (such as filters) that can be inserted into the audio stream.  
For blocks that provide more than one processor, only one processor can be 
selected.  Each block can be inserted by a double-click or right-click >Insert  
and selecting the desired processor (figure 5-5).  Once a block is inserted, the 
selected processor is displayed in the block and the block itself changes color.

Double-click the
processor block. 

A dialog box opens,
which contains the

processes available
in this block.

Click to select
the desired process.

The selected processor is displayed in the block.

If you want to change the process’s variables, 
double-click the block again, opening a separate 
window.

Figure 5-5 — Selecting a typical processor block dialog box
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Each processor has a set of associated parameters that define that processor (such 
as a frequency curve); those parameters can be accessed and changed by double-
clicking again on the now inserted process block.  This action opens a customizable 
dialog box, a new window that contains parameters for the process (figure 5-6).

Figure 5-6 — Sample processor dialog box

	 •	 The Set Defaults button lets you discard all custom settings and	  
reload the factory defaults.

	 •	 The Bypass button lets you temporarily suspend the processor	  
without removing the processor block.

By default, each processor block is automatically bypassed when inserted (the 
Bypass button in the processor dialog box is selected), although this can be 
changed for each processor block type, see “DSP Configuratotor Tools menu“ 
and the specific tabs for the processor types.  When a processor is bypassed, a red 
indicator in the block turns on.

N	 Figure 5-6 is a sample of one type of dialog box.  The contents and appearance of 
each processor are unique to that processor.

The block can be removed from the audio stream by selecting it and depressing the 
keyboard Delete key or by right-clicking and selecting Delete.
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Program audio input signal controls (a)

The program audio input signal processor chain makes adjustments to program 
audio material before it is tied to specific outputs.

Gain control — The always-present gain control provides the same basic audio 
input level adjustments that are available from the front panel (see “Viewing and 
adjusting the input audio level“, in chapter 3, “Operation”).

	 Additionally, the left and right input channels each have trim controls,	
accessible in the dialog box, for separate fine adjustment with a gain 
range of -6 dB to +6 dB in 0.1 dB increments.  The default setting is 
unity gain (0.0 dB).

N	 The trim settings are not indicated in the front panel display.

	 The Polarity buttons, accessible in the dialog box, let you flip the polarity of	  
the wires connected to the audio connectors (+/tip and -/ring) to easily 
correct for miswired connectors.

	 The Mute buttons, accessible in the dialog box, let you separately	  
silence the left and right audio channels.  If you mute both channels, 
audio is completely silent on that input. When one or both channels are 
muted, one or two red indicator(s) in the block turn on.

Filter block — The filter processor block, when first	  
inserted, provides one of four filter selections; 
additional filters can then be added.  A filter 
attenuates (removes) or boosts a range of frequencies 
from an audio waveform, while passing other 
frequencies.  Click the desired filter to select it.

N	 Selecting “Bass & Treble Filter” inserts two separate filters.

	 Additional filters, for a total of up to three filters, can then be added by double-
clicking the processor block.  Additionally, each filter’s frequency range can 
be changed in the dialog box, customized to the filter, that can be accessed by 
double-clicking the processor block.

	 To add a second and/or third filter to the filter block, select 	  
the desired filter in the 2  and 3  drop-down boxes in the 
dialog box.

	 The following filters are available:

	 •	 High pass filter — A high pass filter passes a band of 
frequencies extending from a specified cutoff frequency (greater than zero) 
up toward the high-end of the frequency spectrum.  All frequencies above 
the specified cutoff frequency are allowed to pass, attenuating all frequencies 
below.  The default cutoff is 100 Hz.

	 •	 Low pass filter — A low pass filter passes a band of frequencies extending 
from a specified cutoff frequency (less than infinite) down toward the low 
end of the frequency spectrum.  All frequencies below the specified cutoff 
frequency are allowed to pass, attenuating all frequencies above.  The default 
cutoff is 10 kHz
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	 •	 Bass and treble filters — Also known as shelving or tone filters, the separate 
bass and treble filters give the ability to cut or boost gain evenly above 
or below a given frequency, with the end-band shape giving the visual 
appearance of a shelf.  These filters are typically applied to program material, 
and are expressed as bass and treble control.  The bass default frequency is 
100 Hz and the treble default is 8 kHz.

	 •	 Parametric equalizer filter — A parametric equalizer is a variable equalizer 
that offers control of all parameters, including amplitude (boost/cut — the 
amount of gain (boost) or gain reduction (cut) that is applied at a given 
frequency), center frequency (frequency), and bandwidth (Q). This allows the 
user to control the amplitude of each band, shift the center frequency, and 
widen or narrow the affected area.

Dynamics blocks (2) — The two dynamics processor blocks,	  
when inserted, each provide one of four dynamic 
processors.  A dynamic processor alters the dynamic 
range of an audio signal, the difference between the 
loudest to the quietest portions of the signal above the 
system’s noise floor.  Dynamic range can either be increased using an expander 
(noise gate) or reduced using a compressor.  Click the desired dynamics	  
processor to select it or to view a live audio meter as shown at right.

	 Each processor’s parameters can be changed in the dialog box, customized 
to the processor, that can be accessed by double-clicking the processor block.  

	 •	 Automatic gain control (AGC) — AGC adjusts the gain level based upon the 
strength of the incoming signal to achieve a more consistent volume.  Above a 
set threshold, weaker signals receive more gain to reach a user-defined target 
level; stronger signals receive less gain or no gain at all. 

		  A window range is also applied above and below the target level.  When the 
signal reaches the window, gain control starts scaling in a linear fashion 
toward the target level to achieve smoother results.

		  The default threshold is -40 dB.  The default target level is -10.0 dB.  The 
default gain and window are 12.0 dB.

	 •	 Compressor — The compressor regulates the input signal’s level by reducing, 
or compressing, the signal’s dynamic range above a specified threshold.  
The signal’s input level to output level ratio determines the reduction in 
the dynamic range beyond the threshold setting.  For example, with a ratio 
setting of 2:1, for every 2 dB of input the compressor outputs 1 dB of gain.

		  Compression is commonly used to keep mic levels within an acceptable 
range for maximum clarity.  A compressor make softer sounds louder either 
by reducing the dynamic range and then raising the compressor’s output 
level (referred to as “make-up gain”), or by increasing the input signal and 
then preventing clipping by reducing the louder portions of the signal.  This 
has the effect of making louder portions of a signal softer.  Compression also 
can be used, similar to a limiter, to protect a system or a signal chain from 
overload.

		  The default threshold is -30 dB.  The ratio is 2.0:1.

	 •	 Limiter — The limiter  regulates the level of the input signal by severely 
restricting its dynamic range above a specified threshold.  The limiter 
prevents clipping and protects a system against component or speaker 
damage.  The limiter is closely related to the compressor but applies a much 
higher compression ratio, in excess of 20:1 (often expressed as ∞:1) and with 
a high threshold setting (default is -10 dB, close to clipping).  The ratio cannot 
be changed.
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	 •	 Noise gate — The noise gate is an expander, expanding the dynamic range of 
a signal below a specified threshold.  To simplify, it makes soft signals softer, 
effectively removing background noise while allowing a stronger signal, 
above the threshold, to pass.  Using a high ratio of 20:1, the expander closes 
the audio path below the threshold, eliminating background noise, opening 
the path above the threshold to allow signal to pass; hence the term noise gate.

		  The default threshold is -65 dB.  The ratio is 20.0:1.

Delay block — The delay processor block, when inserted,	  
provides a means to delay the audio signal to sync it to video.  
The processor can delay the audio using either time or 
distance as a determiner.  The default delay, when inserted, is at 100 ms, using 
the time function.  The delay block’s settings can be changed in the dialog box 
that can be accessed by double-clicking the processor block.  When you select 
distance, you can select feet or meters; at which point you can also specify a 
temperature, in either degrees Fahrenheit or degrees Centigrade.  The processor 
calculates the change in speed of sound for the specified temperature.

Trim control — The always-present trim control provides separate left and right 
input channel faders for fine adjustment with a gain range of -12 dB to +12 dB in 
0.1 dB increments.  The default setting is unity gain (0.0 dB).

	 The Gang button lets you couple the left and right faders.	  
Ganged faders move together at relative levels to the top or 
bottom of their travel. If one fader reaches the limit of its 
travel first, it retains that position while the other fader continues to travel.  
When the ganged faders travel in the reverse direction, the fader that was at its 
limit reverts to its position relative to the other fader.

Mic/line input signal controls (b)

The mic/line input signal processor chain makes adjustments to microphone or 
line level audio material, such as a speaker’s presentation, before it is mixed with 
program audio.

Gain control — The always-present gain control provides a single long-throw fader 
with a gain range of 0 dB to +80 dB, adjustable in 1 dB increments, with a level 
setting readout below the fader.

	 A gain range from 0 to +10 dB accommodates a line level signal, typically from a 
wireless microphone receiver with a line level output.

	 Above +10 dB, the input switches to a mic level input.

	 The Phantom Power checkbox, accessible in the dialog box, lets you	  
toggle +48 VDC phantom power on and off, typically to power a condenser mic.

	 The Mute button, accessible in the dialog box,	  
let you silence the mic/line input.

Filter block — The filter processor block, when first	  
inserted, provides one of four filter selections; 
additional filters can be then be added.  The available 
filters and adding additional filters are identical to as 
described on the program audio input in the filter 
processor block (except that up to five filters total can be selected for this block).  
See “Program audio input signal controls (a)“.

N	 Selecting “Bass & Treble Filter” inserts two separate filters.
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Feedback suppressor block — The feedback	  
suppressor processor block, when inserted, detects 
feedback on a live microphone channel, and uses a 
set of fixed and dynamic filters to counteract the frequency peaks at the detected 
feedback frequencies.  You may possibly achieve an additional 3 dB to 9 dB of 
mic gain where feedback would have otherwise prevented these levels.

Dynamics blocks (2) — The two dynamics processor blocks,	  
when inserted, each provide one of four dynamic 
processors.  The available processors are identical to the 
processors available on the input in the dynamics 
processor block and described in “Program audio input 
signal controls (a)“.

Delay block — The delay processor block, when inserted,	  
provides a means to delay the audio signal if necessary to 
sync it to video.  The delay processor block is identical to the 
delay processor available on the input and described in “Program audio input 
signal controls (a)“.

Ducking block — The ducking processor block, when	  
inserted, provides a means to duck, or lower the level of, one 
or more microphones and/or the program material when 
the processor detects a signal from another source.  Ducking lasts for the 
duration of the interrupting signal (plus hold and release time) and restores the 
ducked mic’s original level once the other signal has ceased.  Ducking is useful 
when:
•	 Program material needs to be attenuated in order to more clearly hear the 

narrator’s voice.
•	 One microphone, such as one used by a master of ceremonies, needs to have 

priority over other mics and/or program material.
•	 A paging mic needs to attenuate all other signals.

	 There are three possible settings to insert a Mic/line input as a ducking source:
•	 Duck Outputs Only — Ducks only selected outputs.
•	 1st Priority — Ducks other mics, plus selected outputs.
•	 2nd Priority — Ducks selected outputs, and is ducked by another mic(s).

	 All four ducking processor blocks are controlled via a common dialog box that 
opens when you select to configure any of the ducking blocks.   When a Ducking 
processor block is inserted, it is automatically set to the Duck Outputs Only in 
the dialog box (whether the dialog box is opened or not).  Conversely, when the 
Ducking dialog window is open and any mic channel is set to Duck Outputs 
Only, the corresponding processor block in the main DSP Configurator window 
becomes active.
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Output signal, pre mic mixer, controls (d)

The output signal processor chain, pre mic mixer, makes adjustments to program 
audio material, after it is tied to a specific output but before it is mixed with 
microphone audio.

Post Gain control — The always-present post gain control provides separate left 
and right channel (or separate summed mono channel) faders for fine adjustment 
of the program material before the mic material is mixed in, with a gain range of 
-100 dB to +12 dB in 0.1 dB increments.  The default setting is unity gain (0.0 dB).

	 The Mute button, accessible in the dialog box,	  
let you silence the mic/line input.

	 The Gang button, accessible in the dialog box, lets you couple	  
the left and right faders. Ganged faders move together at 
relative levels to the top or bottom of their travel.  If one fader 
reaches the limit of its travel first, it retains that position while the other fader 
continues to travel.  When the ganged faders travel in the reverse direction, the 
fader that was at its limit reverts to its position relative to the other fader.

	 The Enable Mono Summing checkbox, accessible in the  
dialog box, provides the control to insert a stereo-to-
mono summing amplifier if desired.  The summing amp creates dual mono audio 
paths whose levels can be controlled individually.  When a summing amp is 
inserted, the appearance of the Post Gain control changes to Mono Sum,	  
as shown at right.

N	 Summing increases the overall level by 6 dB.

N	 The summing amplifer function occurs before the Post Gain control; any 
adjustments made in the control to summed audio are made to both mono audio 
paths.

Loudness block — The loudness processor block, when	  
inserted, applies a filter compensation curve to the signal in 
an inverse relationship to the the post gain control setting 
and output volume control setting; the higher the post-gain or output volume 
setting, the less compensation is applied.  For the relationship to the Post-gain 
control, the left and right trims are represented by separate curves in the 
Loudness dialog.  You can fine-tune the loudness compensation; see “Optimizing 
the Audio“, later in this chapter.

Bass and treble block — The bass/treble processor	  
block, when first inserted, applies separate bass and 
treble filters.  If you open the associated Bass/Treble 
dialog box, you can then replace these filters.  The bass and treble filters (and the 
other available filters) and selecting different filters are identical to as described 
on the program audio input in the filter processor block (except that only two 
filters total can be selected for this block).  See “Program audio input signal 
controls (a)”.

N	 Selecting “Bass /Treble Filter” inserts two separate filters.

N	 If you select different filters for this block, the name of the block changes	  
to “Filt”, as shown at right.

, accessible in 
the dialog 
box, 
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Output signal, post mic mixer, controls (f)

The output signal processor chain, post mic mixer, makes adjustments to mixed 
program and microphone audio, before it is output to the selected speakers or other 
audio devices.

Delay block — The delay processor block, when inserted,	  
provides a means to delay the audio signal to compensate for 
speaker placement in the situations where some speakers that 
are delivering the same signal are much farther away than others.  The delay 
processor block is identical to the delay processor available on the input 
and described in “Program audio input signal controls (a)“.  Delay the closer 
speakers so that delivery time matches the farther speakers.

Filter block — The filter processor block, when first	  
inserted, provides one of four filter selections; 
additional filters can be then be added.  The available 
filters and adding additional filters are identical to as 
described on the program audio input in the filter 
processor block (except that up to nine filters total can be selected for this block).  
See “Program audio input signal controls (a)“.

N	 Selecting “Bass & Treble Filter” inserts two separate filters.

Dynamics blocks — The dynamics processor block, when	  
inserted, provides one of four dynamics processors.  The 
available processors are identical to the processors 
available on the input in the dynamics processor block 
and described in “Program audio input signal controls 
(a)“.

Volume control — The always-present volume control provides the same basic 
audio output level adjustments that are available from the front panel (see 
“Viewing and adjusting the output volume“, in chapter 3, “Operation”).

	 Additionally, the left and right output channels each have trim controls,	  
accessible in the dialog box, for separate fine adjustment with a gain 
range of -6 dB to +6 dB in 0.1 dB increments.  The default setting is 
unity gain (0.0 dB).

N	 The trim settings are not indicated in the front panel volume display.

	 The Polarity buttons, accessible in the dialog box, let you flip the polarity of	  
the wires connected to the audio connectors (+/tip and -/ring) to easily 
correct for miswired connectors.

	 The Mute button, accessible in the dialog box, lets you silence the audio	  
output.  This control is identical to the audio mute control available 
from the front panel.  When the audio output is muted, red indicators 
in the block turn on.
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A/V matrix block (c)
The A/V matrix block (figure 5-7) displays the current tie configuration of either 
the program’s own emulation or the connected matrix switcher and provides a way 
to make or break ties.

Figure 5-7 — A/V matrix block

•	 To create a tie, drag a line from an input node ( ) to one or more output nodes 
or right-click an input node and select Connect To All Outputs.

•	 To remove a tie, click an input or output node and depress the keyboard 
Delete key or right-click an input or output node and select Delete All 
Connections (input node) or Delete Connection (output node).  The Legend 
field identifies the type of tie: video and audio, audio only, or video only.

N	 Video and audio ties between the low resolution video input group and the low 
resolution video output group are always made with the audio redirected.  In 
such an operation, the switcher automatically ties the audio to an output in the 
computer video/audio outputs group (outputs 1 through 6) as follows:

	 	 If the video is tied to output 7, the audio is tied to output 1. 
	 If the video is tied to output 8, the audio is tied to output 2. 
	 If the video is tied to output 9, the audio is tied to output 3. 
	 If the video is tied to output 10, the audio is tied to output 4. 
	 If the video is tied to output 11, the audio is tied to output 5. 
	 If the video is tied to output 12, the audio is tied to output 6.

•	 To set up audio in follow mode (audio and video have the same tie 
configuration), click Audio & Video in the Legend field or View > Audio & 
Video I/O on the task bar.

•	 To set up audio in breakaway mode (audio and video have different tie 
configurations), click Video Only or Audio Only in the legend field, or View > 
Audio I/O or View > Video I/O on the task bar.
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Mic mixer block (e)
The mic mixer block (figure 5-8), an array of points where mic audio can be mixed 
into the output audio, provides a way to unmute and mute the normally muted 
inputs from the mic/line input signal processor chain.  Unmuting effectively 
mixes the mic inputs into the audio outputs at the level set in the left and right mix 
controls.

Mic Mixer

Level Control
Faders

Figure 5-8 — Mic mixer block and mic mixing dialog box

•	 To mute or unmute a mic, double-click one of the mix-points ( ) to open a mic 
mixing dialog box.  Click the left and/or right Mic Mute buttons in the dialog 
box to unmute or mute the applicable mic/line input into the left and/or right 
output channel.  The appearance of the mix-point indicates the mic/line input 
connection status as follows:

	 Muted

	 Mixed into both (left and right) output channels

	 Mixed into the left output channel only

	 Mixed into the right output channel only

N	 Unlike from line inputs 1 through 14 (typically program audio), more than one 
mic audio input can be mixed into a single audio output.

N	 Note the message “Mic is muted at input!” in figure 5-8.  This 
indicates that Mute is selected in the mic/line input gain control block.

•	 The mic mixing dialog box includes level controls that provide separate left 
and right output channel faders for mix (level) adjustment with a gain range 
of -35 dB to +25 dB in 1 dB increments.  The default setting is unity gain (0 dB).

•	 The Gang button lets you couple the left and right faders.	  
Ganged faders move together at relative levels to the top or 
bottom of their travel. If one fader reaches the limit of its 
travel first, it retains that position while the other fader continues to travel.  
When the ganged faders travel in the reverse direction, the fader that was at 
its limit reverts to its position relative to the other fader.
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Group masters
Any of the gain blocks’ gain, volume, and trim fader controls can be grouped with 
other gain blocks of the same type (in the same location in the audio signal path 
but for different inputs or outputs) for single-fader control of the entire group 
(figure 5-9).  Mute controls within the blocks can also be grouped (figure 5-10).  Up 
to 32 groups can be created, each can include up to 16 group members.

N	 Stereo gain blocks have two, left and right, signal paths; each path counts as a 
group member, limiting you to up to eight gain blocks total for a control group of 
stereo gain controls.  In figure 5-9, the group 2 master consists of six members

Figure 5-9 — Sample fader group master and associated gain controls

Figure 5-10 — Sample mute group master and muted inputs

Assume that your system has several audio outputs dedicated to a single room.  
You want all outputs to receive the same audio input, but there are different audio 
dynamics in different parts of the room: front row audience members need less mic 
audio mixed in, and you want to insert varying degrees of delay for different rows 
of the audience.  The outputs 1 through 3 volume controls can be grouped into a 
master (figure 5-9) that controls the volume throughout the room.

Each individual volume control in the group can be set for that output, but when 
you move the group fader, all three output controls’ faders move in tandem, 
retaining their relative levels.
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Soft limits ( ) are adjustable, letting you set the ceiling and floor for the group.

Grouped faders move together at relative levels to the top or bottom of their travel.  
If one fader reaches the limit of its travel first, it retains that position while the other 
faders continue to travel.  When the grouped faders travel in the reverse direction, 
the fader that was at its limit reverts to its position relative to the other faders.  No 
gain block’s level fader can be set beyond the group fader’s upper or lower limits, 
either the hard limits or the soft limits.  Any gain fader in the group can be set to a 
level below the group fader.

An icon in the gain control indicates that a gain control is assigned to a group; in 
figure 5-9,  indicates group 2.   in the output 3 control indicates that that gain 
control is assigned to more than one group.

N	 If a block is muted, that block remains muted when the group mute is released.

T	 Extron recommends that if you include a control in multiple groups, that you do so 
with care; overlapping group membership can quickly become unmanageable.

Configuring a group master
Configure a group as follows:

1.	 Click Tools > Configure Groups to open the Configure Groups dialog box.

N	 Or, click View > Group Controls and then click the Add a Group menu selection.

2.	 In the Select Group drop-down box, click a group to select it (figure 5-11).

	

2

3 4

5 7

Figure 5-11 — Configure Groups dialog box

N	 <empty> groups have no group members assigned.  Numbered groups (such as 
“Group #1“) have controls assigned that may be overwritten if you select them 
and continue.

3.	 In the Select Control Type field, click the + to expand the Gain and/or Mute 
tree and then select a control to assign it to the group.

4.	 In the Available Group Members field, click the desired checkboxes to select 
or deselect those blocks as members of the group.

N	 Potential group members in step 4 that are already assigned to a different group 
are displayed in blue.

5.	 Click the Apply button to create or configure the group.

6.	 If desired, repeat steps 2 through 5 to create or configure other groups.

7.	 Click the Close button to exit the Configure Groups dialog box.
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Deleting a group master
Delete a group as follows:

1.	 Click Tools > Configure Groups to open the Configure Groups dialog box.

N	 Or, click View > Group Controls and then click the Add a Group menu 
selection.

2.	 In the Select Group drop-down box, click a numbered group (such as 
“Group #1“) to select it (figure 5-11).

3.	 Click Delete Current Group.

4.	 Click Yes in the Confirm Deletion dialog box.

Viewing and using a group master
Click View > Group Controls to open the Group Controls dialog box (figure 5-12).

Figure 5-12 — Group Controls dialog box

•	 Slide a group fader up and down to adjust all gain controls in the group.

•	 Click and drag a soft limit ( ) to set the ceiling or floor for the group.

N	 The soft limits cannot be dragged beyond the current setting of the group fader; 
the ceiling cannot be set below the fader and the floor cannot be set above the 
fader.

N	 None of the individual gain faders can be dragged below the floor or above the 
ceiling of the group’s soft limits.

•	 Click and drag a soft limit ( ) to set the ceiling or floor for the group.

•	 Click the Mute button in a mute group to mute or unmute all blocks in 
the group.

N	 If a block is muted, that block remains muted when the group mute is released.

•	 Click Add a Group to open the Configure Groups dialog box.  See 
“Configuring a group master“ and figure 5-11.

•	 Click Tools > Clear All Groups to delete all groups.
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•	 Click Tools > Increment/Decrement Simulator to open a dialog box 
(figure 5-13) that lets you experiment with fine adjustments.

		

Figure 5-13 — Increment/Decrement Simulator dialog box

N	 	 You must select a group before the other controls in the dialog box are active.

	 The size of the increment can be changed from its default value of 1 dB by 
typing a value in the Increment Value or Decrement Value field, to as fine as 
0.1 dB.

•	 Click Tools > Group Details Report to create a Microsoft Word file that 
details all created groups (figure 5-14).

   GROUP DETAILS REPORT
Group #1
Processor Type: Mute
Current Value: 1
Current Group Members:
Output #7 Left Channel
Output #8 Right Channel
Output #9 Left Channel
Output #10 Right Channel
Output #11 Left Channel
Output #12 Right Channel

Group #2
Processor Type: Gain
Current Value: -10.8
Current Group Members:
Output #1 Left Channel
Output #2 Right Channel
Output #3 Left Channel
Output #4 Right Channel
Output #5 Left Channel
Output #6 Right Channel

Figure 5-14 — Sample group details report



Switcher Software, cont’d

MPX Plus 866 A Media Presentation Matrix Switcher • Switcher Software5-20

PR
EL

IM
IN

A
RY

Video-only I/O page controls
Three video control blocks are available only on the video-only I/O page (figure 5-15), 
selected by clicking Video Only in the legend field, clicking View > Video I/O, or 
pressing the keyboard F4 key.

7

8 9

Figure 5-15 — DSP Configurator program window, video-only I/O page

g	 S-video/composite video selection block — Low resolution video inputs 11 
through 14 are individually configurable as either S-video or composite video.  
Double-click this block to toggle between S-video and composite video.

h	 RGB Delay block — The switcher can 	  
briefly blank the red, green, and blue 
planes of a Computer Video (output 1 
through 6) output when a tie is made 
to it.  Double-click the RGB Delay 
block to open a dialog box that allows 
you to set the RGB Delay from 0.0 to 
5.0 seconds in 0.5 second increments.
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i	 Video Mute block — Double-click the Video Mute block to toggle the video 
mute on and off.  When video is muted, a red indicator in the block turns on.

N	 In the computer video group, the video mute function mutes the R, G, and B 
planes only; the sync (H and V planes) are still active.  In the low resolution 
video group, the video mute function mutes the composite video plane or both 
S-video planes.

Presets
The MPX Plus 866 A can store up to 32 presets.  Presets saved via the 
DSP Configurator program are partial presets, and can include both selected 
ties and selected audio signal processing settings made in the program.  Partial 
presets, when recalled (by any means), overwrite only a portion of the current 
configuration, leaving other ties and settings unchanged, and are useful when only 
selected ties and/or settings, such as for a particular room, need to be changed.

Save a Preset
Before you save a preset using the DSP Configurator program, you must select, or 
mark, the desired ties and signal processor blocks.  Save a preset as follows:

1.	 Mark the desired video and/or line audio ties as desired:

a.	 Click or right-click > Mark an output node ( ).  The node is marked by a 
green outline ( ).

	 The output and the tied input are selected to be saved as a preset.

b.	 Ctrl-click or right-click > Mark additional outputs as desired.

T	 •	 If an input is tied to multiple outputs, and you want the entire set of ties saved as 
a preset, mark each output to save that tie.

•	 To mark multiple successive outputs (marking all outputs selects all ties),	  
mark the uppermost output node as described in step 1a.  Then, Shift-click an 
output node under it to mark all of the outputs between the two nodes.

2.	 Mark the desired mic mix-points:

a.	 Click or right-click > Mark a mix-point ( ).  The point is marked by a 
green outline ( ).

	 The mic/line input, the mixed output, and all mix settings are selected to 
be saved as a preset.

b.	 Ctrl-click or right-click > Mark additional mix-points as desired.

T	 •	 To mark the same mic/line input mix-point for a successive series of	  
outputs, mark the leftmost or rightmost mix-point as described in 
step 2a.  Then, Shift-click a mix-point to the left or right of it to mark each mix-
point in the row (mix the mic/line input to each output).

•	 To mark the same output mix-point for a successive series of mic/line	  
inputs, mark the uppermost mix-point as described in step 2a.  Then, Shift-
click a mix-point under it to mark each mix-point in the column (mix the 
output to each mic/line input).
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3.	 Mark the desired gain and/or processor blocks:

a.	 Click a processor block.  The block is marked by a green outline ( ).

	 The processor block and all of its settings is selected to be saved as a 
preset.

b.	 Ctrl-click additional processor blocks as desired.

H	 •	 To mark multiple successive processor blocks in a	  
chain, use right-click > Mark Row.

4.	 Save the preset:

a.	 Click Tools > Presets > Save Presets.

	 The Save a Preset dialog box appears.

b.	 As desired, enter a specific preset number

c.	 As desired, enter a preset name.

N	 Unless you enter a specific number and/or name, the DSP Configurator 
program enters the next sequential unused preset number and the name “Preset 
{number}.

d.	 Click OK.

Recall a Preset
Recall a preset as follows:

1.	 Select the desired preset in the Presets drop-down menu (figure 5-16).

	 The selected preset appears in the Presets window, marked processors appear 
indicated by green boxes, ties that will be loaded as part of the preset are 
shown by dashed lines, and ties that will be eliminated by the preset are 
indicated by the output node highlighted in green.

	 1

2

Figure 5-16 — Recalling a preset

N	 The Recall, Cancel, and Delete buttons appear when a preset is selected.

N	 An asterisk in the drop-down list indicates that a partial preset that only exists 
in the switcher has not been saved to the DSP Configurator’s configuration file.  
The preset’s ties and settings are not in sync between the DSP Configurator 
program and the switcher.

	 Presets marked with an asterisk should be recalled and then the current 
DSP Configurator settings saved.  Click File > Save or File > Save As.

N	 It may take up to two seconds for the preset data to read-in in Live mode.

2.	 Click Recall to load and make active the selected preset.

H	 •	 Click Cancel to abandon the preset recall (but not deleting the preset) and 
return to the current configuration.

•	 Click Delete to permanently erase the preset.



 

5-23MPX Plus 866 A Media Presentation Matrix Switcher • Switcher Software

PR
EL

IM
IN

A
RY

Emulate mode vs. Live mode
The DSP Configurator program always starts in Emulate mode.  In Emulate mode, 
you can perform all of the functions available in the DSP Configurator program, 
without connecting a switcher to the computer, and save all of the ties and 
settings to a configuration file on your PC.  When you open the file via the DSP 
Configurator program, the program restores all ties and settings as the current 
configuration (emulated if in Emulate mode or live, in the switcher, if in Live mode) 
and makes presets saved in the file available for recall.

Synchronizing: pull vs. push
When you switch to Live mode, after making ties or setting processors in Emulate 
mode, you need to synchronize the switcher and the DSP Configurator program.  
You are given the opportunity to either:

•	 Pull data from the switcher and update the DSP Configurator program’s 
configuration

•	 Push data from the DSP Configurator program to the switcher, overwriting ties, 
settings, and presets in the switcher

You can also switch to Live mode and then tailor the audio settings in real time, 
while listening to the audio output with a critical ear.

Selecting Live mode and pulling data
Switch from Emulate mode to Live mode as follows:

N	 Extron recommends connection via the Ethernet LAN port for DSP Configurator.

1.	 Click the Mode Live button (figure 5-17).  The Communication Type Selection 
windows appears, with either the TCP/IP tab or RS-232 tab active.

1

2

3a

3b

3c

4a

4b

4c

2

or

Figure 5-17 — Selecting Live mode

2.	 If necessary and as desired, click either the:

•	 TCP/IP tab (for connection via the LAN port (preferred) — proceed to 
step 3), or

•	 RS-232 tab (for connection via either of the rear panel RS-232 ports or the 
front panel Configuration port — proceed to step 4).
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3.	 If you selected TCP/IP in step 2:

a.	 Observe the IP Address field in the IP Connection window.  The field 
displays the last IP address entered.

	 If the IP Address field is correct, proceed to step 3b.

	 If the address is not correct, either click in the IP Address field and 
enter the IP address or click on the scroll down button ( ) to open a 
drop-down list and select from among the recently used addresses.  
Proceed to step 3b.

N	 If the local system administrators have not changed the value, the factory-
specified default, 192.168.254.254, is the correct value for this field.

b.	 If the switcher is password protected, click in the Password field and 
enter the appropriate administrator password.

c.	 Click Ok.

	 The Synchronize with Device dialog box (figure 5-18, on page 5-25) appears.  
Proceed to step 5.

4.	 If you selected RS-232 in step 2:

a.	 Click the Com Port drop-down menu and select the PC’s comm port 
that is connected to the switcher’s front panel Configuration port or rear 
panel RS-232 port.

b.	 Check the baud rate displayed in the comm port selection	
window.  If you need to change the baud rate to match 
the switcher’s rate, click the Baud Rate drop-down menu 
and select the desired baud rate.  The default is 9600.

c.	 Click Ok.

	 The Synchronize with Device dialog box appears.  Proceed to step 5.

5.	 If necessary and as desired, click (figure 5-18) either the:

•	 Pull radio button (to configure the DSP Configurator program to match 
the switcher — proceed to step 7)

•	 Push radio button (to configure the switcher to match the DSP 
Configurator program — proceed to step 6)

N	 Extron recommends performing a design rule verification before pushing to 
ensure that the DSP is not overloaded.  See “DSP capacity and design rule 
verification“, on page 5-30.
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6

6a

8

6b

6c

6e

6f

6d

6d

5

5

or

Figure 5-18 — Selecting Live mode, continued
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6.	 If you want to tailor the push to the switcher (push just the configuration, 
just the presets, or the configuration and selected presets), click the Advanced 
button and proceed to step 6a.

	 To push all of the DSP Configurator ties, gain and processor blocks, and 
presets to the switcher, proceed to step 7.

a.	 Select the Custom radio button.

b.	 Select the desired checkbox(es); Push Configuration and/or Push 
Presets.

N	 Configuration includes all ties, mic mixes, and gain and processor blocks.  This 
selection does not include partial presets.

c.	 If you selected Push Presets in step 6b, select either the All or Selected 
checkbox.

	 If you selected Selected, proceed to step 6d.

	 If you selected All (equivalent to a standard push), proceed to step 7.

d.	 If you selected Selected in step 6c, the Synchronize with Device dialog 
box reappears.  Click OK.

e.	 Select the desired partial presets to push by clicking in the appropriate 
checkbox(es).

f.	 Click OK.   — Proceed to step 8.

7.	 Click OK.  The DSP Configurator program is connected live to the switcher 
and the ties, processors, and presets are pushed or pulled as selected, 
completing the selection of Live mode.

8.	 If you have created ties or made any changes to the DSP parameters 
(including gain and/or processor blocks) since the last time you saved to a 
file, the DSP Configurator prompts you to save the file.  Click Yes or No, as 
desired,

		 If a password was required and not entered or if an incorrect password was 
entered, the program prompts for the password.

DSP Configurator Windows menus

DSP Configurator File menu	
N	 New, Open, and Recent Files are unavailable in 

Live mode.

New — Discards the current DSP configuration (after 
prompting to save any changes) and opens a blank 
configuration file with no inserted processors, saved 
partial presets, created ties, or mic mixes.

Open — Loads and activates a previously saved DSP 
configuration file.

Save — Saves all changes to the current DSP configuration 
file under the current file name.  If the file has not 
previously been saved the program prompts for a file 
name.

Save As — Saves all changes to the current DSP configuration file under a new file 
name.

Backup — Transfers all partial presets plus the current configuration to a DSP 
configuration file within the DSP Configurator program.
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Recent Files — Opens a list of recently opened or saved DSP configuration files, 
making it easy to select one to open.

Exit — Closes the DSP Configurator Program.

DSP Configurator Edit menu	
Cut — Copies all of the parameters of a selected processor block 

or set of selected blocks to the clipboard and removes the 
block(s) from the processor stream.

N	 Gain blocks are always present and cannot be Cut.

N	 Processor blocks are removed from the processor stream after a Cut and a 
subsequent Paste operation.

N	 Processor blocks and their parameters can be pasted only into another block of 
the same type.  For example, the input 1 filter block and all of its parameters can 
be copied to the input 2 filter block but not to the input 1 delay block.

Copy — Copies all of the parameters of a selected processor block, gain block, or set 
of selected blocks to the clipboard.

Paste — Inserts processor blocks and their parameters from the clipboard into the 
DSP Configurator program at the location selected.

DSP Configurator View menu	
Audio & Video I/O — Selects the audio and video I/O page 

for the DSP Configurator program (the default view).

Audio I/O — Selects the audio-only I/O page for the DSP 
Configurator program.

Video I/O — Selects the video-only I/O page for the DSP 
Configurator program.

Meter Bridge — Opens a Meters dialog box (figure 5-19) 
that gives you a “system at a glance” view of the audio level at each input and 
output.

N	 Meter Bridge is available in Live mode only and only while connected via the 
switcher’s LAN port.

Figure 5-19 — Meter dialog box

Re-enable all dialogs — Re-enables all dialog boxes, the pop-up windows that 
allow you to make changes to a block’s parameters.

Error log — A troubleshooting tool, error log lists error messages.

Group Controls — Opens the the Group Controls dialog box.  See “Viewing and 
using a group master“ on page 5-18.
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DSP Configurator Tools menu	
Presets — Allows you to mark all items, save a preset, 

and clear marked items:

•	 Mark All Items — Mark (select) all parts of 
the current configuration (excluding presets), 
including processors, created ties, and mic 
mixes to save as a partial preset.

•	 Save Preset — Save the currently marked 
processors, ties, and mic mixes as a partial 
preset.

•	 Clear Marked Items — Unmark (deselect) 
all parts of the current configuration (excluding presets), including 
processors, created ties, and mic mixes.

Protected Configuration — Allows a user (typically the installer) to save and recall 
a protected configuration.  The protected configuration is useful to establish the 
MPX Plus 866 A’s configuration and all presets, mic mixes, parameters, variables, 
and values (with the exception of the switcher’s IP address) in a known state, 
either as a troubleshooting tool or as a baseline configuration.  The protected 
configuration, once saved in the switcher, is always present and cannot be 
overwritten without entering a user-selected Personal Identification Number 
(PIN) password.  The configuration is restored without a PIN:

N	 The default PIN is 0000.

•	 Save — Save the current configuration (excluding presets), including 
processors, created ties, and mic mixes as a password protected 
configuration.  The DSP Configurator program prompts for a PIN to save.

•	 Recall — Recall the protected configuration.

•	 Change PIN — Change the PIN associated with the protected configuration.

Design Rule Verification — Compares all stored presets, checking for possible DSP 
overloads.  See “DSP capacity and design rule verification“, on page 5-30.

Connect to / Disconnect from Device (depending on Emulate or Live mode) — 
Performs the same functions as the Mode Emulate and Mode Live buttons.

Issue RESET Command — Initializes and clears any or all of the following: ties, mic 
mixes, presets, audio configuration, processor blocks, and gain blocks.  This reset 
is identical to the EZXXX} SIS command (see chapter 4, “SIS Programming 
and Control”).

Commit to NVRAM — Commands the switcher to save all set variables, ties, and 
presets to its non-volatile memory.  You should do this before powering down 
the switcher if you have recently made changes.

Firmware Loader — Calls the Firmware Loader program, which allows you to 
replace the firmware that is coded on the switcher’s control board without 
taking the switcher out of service.  This is similar to the Matrix Switchers Control 
Program’s Update Firmware selection.  See “Update firmware”, on page 5-46.

Configure Groups — Opens the Configure Groups dialog box.  See “Configuring a 
group master“ on page 5-17.

Device Setting — Opens a dialog box that provides a means to set the unit’s IP 
address and passwords and to set the serial ports’ baud rates.
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Options — Opens a tabbed dialog box that allows you to tailor the DSP 
Configurator program’s appearance and operation to your liking:

•	 General — Tailor the appearance of dynamics meters.  Set meters to 
automatically appear (default) or require further operator action.

•	 Colors — Set the colors of various dialog boxes for a pleasing appearance.

•	 Dyn Defaults — Sets the default parameters for the automatic gain 
control (AGC), compressor, limiter, and noise gate processors, including 
whether they are initially bypassed (default) or not, when inserted.  Also 
allows you to restore the factory defaults for these processors.

•	 Filter Defaults — Sets the default parameters for the high pass, low 
pass, bass, treble, parametric, and notch (feedback suppressor) filters, 
including whether they are initially bypassed (default) or not, when 
inserted.  Also allows you to restore the factory defaults for these filters.

•	 Gain Defaults — Sets the default parameters for the input gain processor, 
output gain processor, mic gain processor, mic mix gain processor, and 
meter clip indicators.  The gain parameters include whether they are 
initially muted (default for the mic gain and mic mix-points) or not.  Also 
allows you to restore the factory defaults for these processors.

•	 Other Defaults — Sets the default parameters for the ducking, loudness, 
delay, and feedback suppressor processors.  The feedback suppressor 
parameters include whether they are initially bypassed (default) or not.  
Also allows you to restore the factory defaults for these processors and 
for the entire DSP.

DSP Configurator Window menu	
Cascade — Rearranges all open DSP Configurator program 

windows, including dialog boxes, in a cascading array.

Close All Windows — Closes all open dialog boxes.

Individual windows — Brings the associated dialog box to 
the front of the desktop.

DSP Configurator Help selection	
Opens the DSP Configurator program Help file.

DSP Configurator Presets dropbox	
Displays a list of up to 32 partial 
or global ties (depending on how they 
were saved) presets.  You can select a 
preset from the list to display it in the 
window and either activate it (Recall), 
abort the selection without either recalling or deleting it (Cancel), or delete it (Delete).

N	 The Recall, Cancel, and Delete buttons appear when a preset is selected.

N	 An asterisk in the drop-down list indicates that a partial preset that exists only 
in the switcher has not been saved to the DSP Configurator’s configuration file.  
The preset’s ties and settings are not in sync between the DSP Configurator 
program and the switcher.

DSP Configurator Mode buttons	
Allows you to select between Live mode and Emulate mode.  
See “Emulate mode vs. Live mode“, on page 5-23 for more 
information.
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DSP capacity and design rule verification

DSP capacity
Each processor, when inserted, uses a portion of the DSP’s total processing power.

	 •	 The amount of processing power for the block is constant, unchanged by 
parameter settings or whether it is bypassed or not.

	 •	 Processors in the program audio input (computer/audio group and video/
audio group) processor chains (a, on figure 5-3) are active (using processor 
power) only when tied to an output.

	 •	 Processors in the program audio input (a) and line output (d and f) are 
stereo processors, each using two of that processor type.

The DSP Configurator program calculates the processor usage of all active 
processors in the line output (d and f) and mic input (e) processor chains and 
the six most processor-intensive input processors (a), depending on the 
configuration.  The program displays a DSP usage meter that	
shows the results of this usage calculation.

The following table shows the DSP usage for each processor 
type, the maximum number of processors that can be active within a configuration 
or current state/emulation, and the potential DSP usage if all of those processors 
are active at the same time.

Processor type
DSP 

usage
Maximum # of 

active processors
Potential total 

DSP usage

Dynamic processors 0.4% 44 	 17.2%

Ducking blocks 1.6% 4 	 6.3%

Delays 1.9% 28 	 54.3%

FBS blocks (dynamic filters only) 10.6% 4 	 42.4%

All filters (including fixed FBS filters) 0.1% 208 	 22.9%

Loudness 0.3% 12 	 3.1%

Total: 	 146.2%

N	 DSP usage percentages do not exactly add up to the totals due to rounding to the 
nearest 0.1%.

The DSP can overload when a combination of processors is enabled that totals over 
100% usage.  In this case, the switcher can lock up and fail to operate, necessitating 
cycling power.  As part of its monitoring of DSP usage, when the DSP Configurator 
program detects that usage is nearing the 100% threshold, it makes uninserted 
processor blocks unavailable for insertion.  This prevents an overload caused by 
normal operation.  However, you can recall a combination of partial presets that 
causes an overload.  The design rule verification function (see the next page), when 
used properly, can avoid an overload.
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Design rule verification
You can inadvertently recall a combination of partial presets that causes an 
overload.  The user-selected design rule verification function analyzes and 
compares all presets.

Execute the design rule verification function by clicking Tools > Design Rule 
Verification.

After verification, if no combination of presets that would cause an overload 
is detected, the function prepares an on-screen report stating “The current 
configuration has been successfully verified“.

On the other hand, if, after verification, a problem is detected, the function 
prepares an on-screen report stating “Overload Possible” and lists the specific 
errors that it found.  This combination of partial presets, if recalled, will cause an 
overload.  To prevent a possible overload, you need to make adjustments to your 
partial presets.  Run the design rule verification utility again to ensure that you 
have resolved the potential problem.

N	 Extron recommends performing a design rule verification before pushing a 
configuration to the switcher and frequently while designing partial presets to 
ensure that the DSP will not be overloaded.

If you are in Live mode (connected to a switcher) and any presets exist in the MPX 
switcher that are not present in the DSP Configurator program (indicated by an 
asterisk next to the preset name), the function halts and prompts the user to run a 
backup.

Backup (click File > Backup) transfers all partial presets plus the current 
configuration from the switcher to a DSP configuration file within the 
DSP Configurator program and then prompts you to save the file to your hard 
drive.  Backup is unavailable when the DSP Configurator program is in Emulate 
mode.
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Keyboard navigation
The DSP Configurator program is fully navigable using the computer keyboard.  
Some keyboard navigation behavior matches Windows standards, while other 
behaviors are specific to the DSP Configurator program.

When the program is started, the cursor focus is in the upper left corner of the 
program audio input (computer/audio group and video/audio group signal 
processor chains (a on figure 5-20).  The Input 1 Gain block is green highlighted 
[ ]).

N	 The callout numbers on figure 5-20 are not the same as on figure 5-3.

7110

6 11

3 4 5 82

Figure 5-20 — DSP Configurator program window
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Standard Windows navigation
The keyboard keys navigate and function as follows:

	 •	 Tab key —

		  Sequentially jump among major segments of the DSP Configurator program.  
From the program audio input chains (a), sequential jumps are in the 
following order:

	 A/V matrix block (b)
	 Output signal processor chain (pre mic mixer) (c)
	 Mic mixer block (d)
	 Output signal processor chain (post mic mixer) (e)
	 Mic/line input signal processor chain (f)
	 Task bar Presets dropbox (g)
	 Task bar Mode buttons (h)

		  Jump from the input 1 through 14 or mic input 1 through 4 name fields (j) 
into the nearest group of processor chains (a or f).

	 •	 Shift-Tab key combination —

		  Reverses the direction of the Tab key function.

		  Jump from the output 1 through 12 name fields (k) into the nearest group of 
processor chains or the A/V matrix block (e or b).

	 •	 Arrow ( , , , and ) keys —

		  Navigate up, down, left, and right within any of the areas shown on 
figure 5-20.

		  Jump from the input 1 through 14 or mic input 1 through 4 gain blocks (a or 
f) into the name fields (j).

		  Jump from the output 1 through 6 volume block (e) or the output 7 through 
12 nodes on the A/V matrix (b) into the output 1 through 12 name fields (k).

	 •	 Enter Key — Performs the same action as a mouse double-click.  For 
example, opens the context menu from which a processor type may be selected 
or opens a dialog box when applicable.  When an action button is highlighted, 
Enter executes the button action and toggles the button when applicable.

•	 Control key — The Ctrl key can be used in the following shortcuts.

	 Ctrl-X — Cut the selected elements.
	 Ctrl-C — Copy the selected elements.
	 Ctrl-V — Paste the selected elements.
	 Ctrl-L — Go to Live mode.
	 Ctrl-E — Go to Emulate mode.
	 Ctrl-A — The first press of the Ctrl-A combination highlights all A/V 

matrix block (b) output nodes.  The second press highlights all elements 
within the program.

	 •	 Alt key — The Alt key is used with specific letter keys to open and navigate 
task bar menus.  When the Alt key is pressed and either held or released, 
the first letters in the menu titles (File, Edit, View, Tools, Window, or Help) 
become underlined.  Press the underlined letter key to open that menu.

		  Once a task bar menu is open, use the up and down arrow keys to move up 
and down in the menu or submenu, use the right key to open a submenu (if 
applicable), and use the Esc key to back out of an active menu or submenu.
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DSP Configurator-unique navigation

Making ties
Video and audio ties can be made from the keyboard as follows:

1.	 Arrow ( , , , and ) and/or Tab ( Tab ) to the A/V matrix block (b) input 
node ( ) from which you will make the tie.  The node is marked by a green 
outline ( ).

2.	 Press and hold the Shift Shift  key while you press the right arrow  to drag 
the potential tie (dashed line) to the corresponding output node (input 1 to 
output 1, 2 to 2, and so on).

N	 If input number 7 or 8 is selected in step 1, when you perform step 2, the 
potential tie is to output 6.

3.	 Release the Shift Shift  key.

4.	 Press the Enter Enter  key to execute the tie.

5.	 If desired to make additional ties from the same input, press the 
up arrow  or down arrow  (Shift Shift  is not required) to select another 
output to tie to the same input.

6.	 If you made additional ties from the same input, press the Enter Enter  key to 
execute the tie.

7.	 If desired, repeat steps 5 and 6 to tie additional outputs to the same input.

8.	 If desired to make ties from a different input, press the left arrow  key 
once, and repeat steps 1 through 7.

9.	 Press the Tab Tab  key, Esc Esc  key, right arrow  key, or left arrow  key to 
exit the set ties operation.

Highlighting and marking items, cutting or copying, saving a preset
When an item within the program is selected, it is green highlighted.  One or more 
highlighted items can be cut, copied, pasted, or saved as a preset.  The cut, copy, 
and paste functions can be performed using the task bar menus (see the Alt Alt  key, 
above) or the shortcuts described on the previous page.

N	 When an item is cut, it is not removed from its original location until it has been 
pasted in its new location.

Highlight multiple elements for cut, copy, paste, or a preset as follows:

1.	 Use the arrow ( , , , and ) key(s) to move to the first block to 
highlight.

2.	 To highlight sequential blocks:

a.	 Press and hold the Shift Shift  key, then use the arrow ( , , , and ) 
key(s) to navigate to and highlight additional elements.

	 When you reach the last element you want highlighted, release the 
Shift Shift  key.

3.	 To highlight non-sequential blocks:

a.	 Press and hold the Ctrl Ctrl  key, then use the arrow ( , , , and ) 
key(s) to navigate to the next desired element

b.	 Release the Ctrl Ctrl  key.

c.	 To highlight sequential blocks, press and hold the Shift Shift  key, 
then use the arrow ( , , , and ) key to navigate to and highlight 
additional elements.
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d.	 To move away from the highlighted block or set of sequential blocks, 
press and hold the Shift Shift  key, then use the arrow ( , , , or ) 
key to move the highlighting box away from the last-highlighted 
element.

N	 If you do not perform step 3c, the last selected element will not remain 
highlighted.

e.	 Release the Shift Shift  key.

4.	 To highlight another element or group of elements, repeat steps 1 through 3.

5.	 To cut or copy, press the Ctrl-X Ctrl  X  or Ctrl-C Ctrl  C  key combination.

6.	 To save a preset, press Alt Alt  > T T  > right arrow  > down arrow  > 
Enter Enter  (figure 5-21).

	 The Save a Preset dialog box appears.

a.	 As desired, Tab Tab  to the Preset Number field and type a specific preset 
number.

b.	 As desired, Tab Tab  to the Preset Name field and type a preset name.

N	 Unless you enter a specific number and/or name, the DSP Configurator 
program enters the next sequential unused preset number and the name “Preset 
{number}.

c.	 Tab Tab  to highlight the OK button and press the Enter Enter  key.

Alt T Enter

Figure 5-21 — Saving a preset using keyboard navigation
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Setting group master soft limits

	 •	 Shift in a combination moves the upper limit —

	 Shift-Up/down arrow Shift   or Shift   — Moves the soft upper limit in 
0.1 dB increments.

	 Shift-Page Up/Page Down arrow Shift  Page
Up  or Shift  Page

Down  — Moves the soft 
upper limit in 10 dB increments.

	 Shift-Home Shift  Home  — Moves the soft upper limit to the upper default.

	 Shift-End Shift  End  — Moves the soft upper limit to the fader’s position.

	 •	 Ctrl in a combination moves the lower limit —

	 Ctrl-Up/down arrow Ctrl   or Ctrl   — Moves the soft lower limit in 
0.1 dB increments.

	 Ctrl-Page Up/Page Down arrow Ctrl  Page
Up  or Ctrl  Page

Down  — Moves the soft lower 
limit in 10 dB increments.

	 Ctrl-Home Ctrl  Home  — Moves the soft lower limit to the fader’s position.

	 Ctrl-End Ctrl  End  — Moves the soft lower limit to the lower default.

Optimizing the Audio
Program material that you are familiar with is preferable for the following 
procedures, otherwise, pink noise can be used.

T	 The Extron VTG 300 or VTG 400 is recommended to provide the pink noise.

Input clipping and clipping meters
Audio clipping is a form of distortion that occurs when the signal peaks (or 
excursions) exceed the limits of the circuit, cutting off the excursions of a signal.  
This condition gives audibly undesirable results.  While it is difficult to clip the 
audio signal within the DSP audio signal chain, it is extremely important that the 
audio signal is not clipped before the input to the switcher.  Once audio is clipped 
at the input, there is no remedy further down the signal chain.  However, if audio 
clipping occurs at the output of the DSP that is not a result of clipping at the input, 
this can be addressed in the DSP audio signal chain.

Meters are available in the gain controls ( ) and in the dynamic processor 
blocks ( ) when the program is in Live mode and an audio signal is applied to the 
DSP.  The meters in the DSP Configurator program indicate clipping at a user-
definable level, with the default setting at -1 dB.  At the -1 dB setting, the meter 
indicates clipping when it reaches -1 dBFS, or 1 dB below actual clipping.  Setting 
the clipping meter below actual clipping provides a bit of a “safety net”, letting you 
know to pull back on input gain before clipping actually occurs.  You can increase 
or decrease this safety net by clicking Tools>Options, selecting the Gain Defaults 
tab, and setting the clip threshold to a number between	  
0 dB and -20 dB.  When the clip threshold is set to 0 dB, 
clipping is indicated only when actual clipping occurs.

Meters within the DSP Configurator program are peak-
type meters, referenced to “full scale,” or 0 dBFS.  For the 
MPX Plus 866 A, 0 dBFS corresponds to 22 dBu, which is 
the maximum output level of the switcher.
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Setting the input and output gain structure
Before calibrating loudness, set up the system gain structure.

1.	 Set the signal generator to output -10 dBFS or use recorded program material 
at -20 dBFS.

2.	 Set the input gain in the DSP Configurator so that the input meter reads 
-20 dBFS.

N	 In step 3, if using a recorded source and the player has an output level setting 
control, ensure that the output of the player is set to its maximum, or 0 dB of 
attenuation.

3.	 For program material, set the input level to approximately -15 dBFS, with 
peaks at no more than -5 dBFS to -3 dBFS.  This setting provides enough 
headroom to accommodate transients or unanticipated loud events in the 
program material in order to avoid possible clipping.

4.	 Tie the audio from the source to the speakers that will carry program material 
in the room to be calibrated.

5.	 With the output channel volume set to -20 dB, listen to the audio output while 
you set the external amplifier so that the source material plays at a volume 
level that is reasonably loud but tolerable, while verifying that the amplifier is 
not clipping by observing the amplifier clip indicator.

Adjusting the pre-matrix  
The pre-matrix trim control can be used to compensate for any level changes caused 
by signal processing before the trim control.  Adding a compressor generally 
reduces the signal level, while a filter can either boost or cut the overall signal level.

N	 This procedure is valid only if no processing is active in the output signal path, 
and if post-matrix trim value is set to 0 dB (unity gain).  If you have processors 
inserted in the output signal path, open them and bypass them to temporarily 
remove them from the signal path.

1.	 After you have set the input gain, add any processors that you wish to use 
into the input signal chain.

T	 If you make changes to filter settings after you have set your dynamics processors, 
recheck the levels in your dynamics processors to make sure that they are still valid.

2.	 Open the line input gain dialog box, the output volume dialog box, and the 
pre-matrix trim dialog box.

3.	 Set output volume to 100%.  If the audio is too loud or distracting, mute the 
output.

4.	 With program material (or pink noise) present at the input, adjust the pre-
matrix trim so that the meter level in the output volume dialog box matches 
the meter level in the input gain dialog box.  This maintains the audio at an 
optimal level in the input signal chain.

T	 This is a good baseline.  If, after you’ve set up your microphone input gain and mix-
point levels, output processing, and post-matrix trim levels, you find that you need 
more headroom to prevent clipping at the outputs, return to the pre-matrix trim 
controls and lower each trim by the same dB amount.

	 You may also find that further minor adjustments to the pre-matrix Trim controls 
help to balance out the perceived audio levels of the different inputs.
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Finalizing the output gain structure
Adding a compressor generally reduces the signal level, while a filter may boost or 
cut the overall signal level.  Loudness boosts the overall signal level, but mostly at 
lower volume settings (see “Calibrating loudness” for more information).

1.	 Add any processors that you wish to use into the output signal chain.

	 After adding processors to the output signal chain, the output volume level 
may clip when set to or near 100%.

2.	 Set output volume to a level where clipping is eliminated.

T	 Remember that the output volume control is essentially the same volume control that 
is accessible to a front panel or Matrix Switchers Control Program operator.  These 
operators may unknowingly change the volume back to a level where clipping occurs.  
You reduce the chance of this inadvertent clipping by using the post-matrix trim 
control rather than the volume control (see “Adjusting the post-matrix trim”).

N	 Mic levels also contribute to possible clipping at the outputs.  They may need 
to be lowered at the mic mix-points to maintain the balance between program 
material (line inputs) and voice (mic).

Setting the mic input and mic mix-point levels
1.	 Double-click the mic mix-point to be set, opening the dialog box for that 

mix-point.

2.	 Unmute the mix-point (mixing in the mic signal).  The default level is 0.0 dB, 
or unity gain.

3.	 Connect your chosen microphone to mixed mic/line input.

4.	 Open the mic input gain dialog box for the mixed mic.

5.	 If your mic requires phantom power, turn it on in the mic input dialog box.

6.	 Unmute the mic/line input.

7.	 While testing the mic, raise the mic gain fader until the mic is clearly audible.

	 The gain level and the mic gain meter level reading vary at this point, but as a 
general guideline, the input gain level is approximately 40 dB to 50 dB and the 
meter averages approximately -20 dBFS.

T	 You want to optimize audio here, but voice levels at microphone inputs can vary 
greatly.  Having the meters average around -20 dBFS gives enough headroom to 
accommodate sudden changes to voice levels.  Further adjustment may be necessary.
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Adjusting the post-matrix trim
Adjusting the post-matrix trim is a bit of a balancing act.  This section provides 
guidelines, but it may take a bit of going back and forth to set levels just right.  
For example, the output level can be controlled and kept below clipping using a 
compressor or limiter in the output dynamics block.  However, adjusting the post-
matrix trim affects how the compressor or limiter works.

1.	 Open the output volume dialog box and the post-matrix trim dialog box.

2.	 Set output volume to 100% (if the audio is too loud or distracting, mute the 
output).

3.	 With program material or pink noise present at the input, adjust the post-
matrix trim until the output volume dialog box’s meter level is below clipping 
(or ideally, matches the level at the input gain meter).  This maintains the 
audio at an optimal level in the output signal chain, and prevents clipping at 
the output.

Setting the volume control for the amplifier stage
The switcher’s maximum output is +22 dBu.  Assume that you have a power 
amp with a maximum input level of +4 dBu when the input attenuator is fully 
open.  If you want to control volume levels using the switcher’s non-DSP 
output volume controls and at the same time ensure that clipping does not 
occur at the amplifier, you need to turn down the power amp’s input attenuator 
the equivalent of 18 dB (18 + 4 = 22 dB), which puts the amp’s input level at 
-14 dB (+4 minus 18 = -14).  If you find that the amp setting (when the DSP 
Configurator’s output volume controls are at 100%) is too loud for the room, you 
can turn it down further.  If the amp is not loud enough for the room, you will need 
a more powerful amplifier.

On the other hand, if you wish to control volume levels using the power amplifier’s 
input attenuation control, (using the same power amp max input level) you can set 
the DSP Configurator’s output volume control to -18 dB.  This is another way that 
clip points of the two devices will be matched, ensuring that clipping will not occur.

However, Extron recommends using the matrix switcher’s output volume control 
for controlling output volume.  If you are using loudness processing on the unit, it 
works only in conjunction with the output volume control.

Calibrating loudness
The basic gain structure is now set up.  From this point, loudness can be calibrated 
using an SPL meter, a critical ear, or a combination of the two.

Setting loudness using a meter
To calibrate loudness, use a sound pressure level meter set to “C” weighting.

1.	 Open the post-matrix loudness processor dialog box.

2.	 Bypass the loudness processor.

3.	 Place the meter in an average listening location.

4.	 Start your program material playback or generate pink noise.

5.	 Measure the SPL in the room.
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6.	 In the loudness dialog box, adjust the fader until the value in the “SPL” 
readout box matches the reading on the SPL meter. 

N	 Calibration can be performed with the output channel volume set to any 
comfortable listening level, but a relatively loud volume that can be easily 
measured is preferred.

	 Loudness is now calibrated.

7.	 Release the loudness processor’s bypass to hear the compensation.

Alternate method:

N	 This method works if 90 dB is an acceptable amplifier/volume limit for the room. 

1.	 Set the loudness dialog box’s Loudness Compensation slider to its default 
(center) position and the output channel volume fader to 0 dB (100% volume).

2.	 Adjust the amplifier until the SPL meter reads 90 dB.  Loudness is now 
calibrated.

Setting loudness “by ear”
When setting loudness by ear, it is also essential that the system gain structure be 
set up first.

1.	 Open the post-matrix loudness processor dialog box.

2.	 Bypass the loudness processor.

3.	 Place the meter in an average listening location.

4.	 Set the output volume fader to a relatively quiet listening level.  (Filter 
compensation from the loudness processor is most prominent at low listening 
levels.  Set to the levels described earlier.)

5.	 Set the loudness dialog box’s Loudness Compensation slider to its default 
(center) position.

6.	 Release the loudness processor’s bypass to hear the compensation.

N	 You should hear a moderate enhancement to the program material with more 
accentuated bass frequencies (below 500 Hz) and more brightness in the high 
frequencies that carry harmonic content (above 7 kHz). You can toggle the 
loudness bypass on and off to compare the difference between loudness off and 
on. 

7.	 To experiment with less loudness compensation, move the Loudness 
Compensation slider to the left, toward Less.

	 For more loudness compensation, move the slider to the right, toward More.

8.	 Any adjustment you make to the Loudness Compensation slider carries 
through to all listening levels.  Set the DSP Configurator output volume to a 
relatively loud listening level. 

9.	 Toggle the loudness bypass on and off to compare the difference between 
loudness off and on.  At a loud listening level, this difference should be 
minimal, or barely perceivable.
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Matrix Switchers Control Program

Starting the program
Many items found in the Matrix Switchers Control Program (the WCP) are also 
accessible via optional front panel controls (see chapter 3, “Operation”) and under 
SIS control (see chapter 4, “SIS Programming and Control”).  The Matrix Switcher 
Help Program provides information on settings and on how to use the control 
program itself.

1.	 To run the Matrix Switchers Control Program, click Start >	  
Programs > Extron Electronics > Matrix Switchers > 
MATRIX Switcher + Control Pgm.

	 The Comm Port Selection window (figure 5-22) appears.

	

Figure 5-22 — Comm port selection window

2.	 Choose the comm port that is connected to the matrix switcher’s RS-232 port, 
IP [LAN], or Emulate.

	 If you selected a comm port, check the baud rate	  
displayed in the comm port selection window.  If you 
need to change the baud rate, click on the Baud button 
and double-click on the desired baud rate.

	 Click Ok and proceed to step 4.

	 If you selected IP [LAN], click Ok and proceed to step 3.

	 If you selected Emulate, click Ok and see “Using Emulate mode” on 
page 5-57.

3.	 If you selected IP [LAN] in step 2, the IP Connection window appears 
(figure 5-23).

	

Figure 5-23 — Address and password entry
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a.	 Examine the Matrix IP Address field in the IP Connection window.  The 
field displays the last Extron IP address entered.

	 If the IP address is correct: Proceed to step 3b.

	 If the address is not correct: Either click in the Extron IP Address field 
and enter the IP address or click on the scroll down button ( ) and select 
from among the recently used addresses.  Proceed to step 3b.

N	 If the local system administrators have not changed the value, the factory-
specified default, 192.168.254.254, is the correct value for this field.

b.	 If the switcher is password protected, click in the Password field and 
enter the appropriate administrator or user password.

c.	 Click Connect.

	 If you logged on using the administrator password, the program connects 
you to the matrix switcher with all of the administrator rights and 
privileges.

	 If you logged on using the user password, the program connects you to 
the matrix switcher with only user capabilities.

	 If an incorrect password was entered, the program beeps and returns to 
the password entry display.

4.	 The Extron Matrix Switchers Control Program window (figure 5-24 and 
figure 5-25) appears.  The window displays the current configuration of the 
attached matrix and provides a way to make or break ties.

•	 To create a tie, drag an input box to one or more output boxes.  To remove 
a tie, drag the output box to its tied input box or to the trash can.

N	 Video and audio ties between the low resolution video input group and the low 
resolution video output group are always made with the audio redirected.  In 
such an operation, the switcher automatically ties the audio to an output in the 
computer video/audio outputs group (outputs 1 through 6) as follows:

	 	 If the video is tied to output 7, the audio is tied to output 1. 
	 If the video is tied to output 8, the audio is tied to output 2. 
	 If the video is tied to output 9, the audio is tied to output 3. 
	 If the video is tied to output 10, the audio is tied to output 4. 
	 If the video is tied to output 11, the audio is tied to output 5. 
	 If the video is tied to output 12, the audio is tied to output 6.

•	 To set up audio in follow mode (audio and video have the same tie 
configuration), select the Follow box at the bottom of the window.  To 
set up audio in breakaway mode (audio and video have different tie 
configurations), deselect the Follow box.

•	 The Matrix Switchers Control program displays Mic audio ties, 
but they can be made only in the DSP Configurator program.  See 
“DSP Configurator Program”, earlier in this chapter.

•	 To make the control program easier to use, assign a device icon to each 
input and output.  Click on a box that represents an input or output, and 
drag the desired icon onto the box from the icon palette that appears.

•	 For quick display of information on a specific input or output device, 
position the cursor over that device in the control program window. 
The program opens a window that details the connections to that device, 
the audio level, and, for outputs in the computer video group only, the 
switching interval (RGB delay) and the frequency of the video signal 
input from or output to that device.  See the inset box in figure 5-25.
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Figure 5-24 — Sample Program window (no icons or ties)

	

Figure 5-25 — Sample program window (icons assigned and ties made)

T	 You can print a map of the current configuration by clicking File > Print Tie Map.

•	 If desired, on the task bar, click Tools > IP Options to set the switcher’s IP 
parameters in the IP Settings/Options window (figure 5-26).
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IP Settings/Options window
The IP Settings/Options window (click Tools > IP options, figure 5-26) provides a 
location for viewing and, if connected via one of the RS-232 ports or if logged on via 
the Ethernet port as an administrator, editing settings unique to the Ethernet interface.  
See appendix A, “Ethernet Connection”, for basic information about IP addresses.  
None of the fields on this screen can be edited while you are logged on as a user.

Figure 5-26 — Control program IP setting/options window

N	 Editing variables on the IP Settings/Options screen while connected via the 
Ethernet port can immediately disconnect the user from the switcher.  Extron 
recommends editing the settings on this screen using the RS-232 link and 
protecting the Ethernet access to this screen by assigning an administrator’s 
password to qualified and knowledgeable personnel only.

N	 When the control program is connected to the switcher via the RS-232 link, the 
Administrator and User Password fields are not masked.  If a password has been 
inadvertently changed to an unknown value, you can look up and, if desired, 
change a password in this window without knowing the current password.

Address and Name fields
The Matrix IP Address field contains the IP address of the connected matrix 
switcher.  This value is encoded in the flash memory in the switcher.

The Gateway IP Address field identifies the address of the gateway to the 
controlling PC to be used if the matrix switcher and the mail server are not on the 
same subnet.

The Subnet Mask field is used to determine whether the matrix switcher is on the 
same subnet as the controlling PC when you are subnetting.  For more information, 
see “Subnetting — A Primer”, in Appendix A, “Ethernet Connection”.

Valid addresses consist of four 1-, 2-, or 3-digit numeric subfields, properly called 
octets, separated by dots (periods).  Each field can be numbered from 000 through 
255.  Leading zeroes, up to 3 digits total per field, are optional.  Values of 256 and 
above are invalid.

The default addresses are as follows, but if these conflict with other equipment at 
your installation, you can change the addresses to any valid value:

•	 IP address	 192.168.254.254	 •	 Gateway address	 0.0.0.0 
•	 Subnet mask	 255.255.0.0

N	 The address fields are cannot be edited when DHCP is selected.
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The Extron Name/Descriptor field contains the name of the matrix switcher. 
This descriptor can be changed to any valid name, up to 12 alphanumeric characters.

N	 The following characters are invalid in the Extron Name/Descriptor field: 
{space}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  |  \  and ?.

Edit any of these fields as follows:

1.	 Click in the desired field.  The graphic cursor becomes a text cursor.

2.	 Edit the address or name as desired.

3.	 Press the Tab key on the keyboard or click in another field to exit the field.

4.	 Click the Take button to make the address change take affect.

Hardware Address field
The hardware address (MAC address) is hardcoded in the matrix switcher and 
cannot be changed.

Use DHCP checkbox
The Use DHCP checkbox directs the matrix switcher to ignore any entered IP 
addresses and to obtain its IP address from a Dynamic Host Configuration Protocol 
(DHCP) server (if the network is DHCP capable).  Contact the local system 
administrator.

Date, Time (local), and GMT (offset) fields
The Date field displays the current date in the Greenwich Mean Time zone.

The Time (local) field displays the current time in the local time zone.

The GMT field displays the amount of time, in hours and minutes, that the local 
time varies from the GMT international time reference.

N	 Rather than the following procedure, your can click the Sync Time to PC 
button to set the switcher to your computer’s internal time.

If desired, adjust any of these values as follows:

1.	 Click in the desired field.  The field changes to an editable field appropriate to 
the value being change and the graphic cursor becomes a text cursor.

•	 The Date field is in the format	  
(M)M/(D)D/YYYY.  Leading zeroes are not 
shown.

•	 The Time (local) field is in the format HH:MM:SS,	  
(00:00:00 to 23:59:59).

•	 The GMT field (offset from GMT) is in the format ±HH:MM	  
(–12:00 to +14:00).

2.	 Edit the field as desired to set the proper proper value.  For time, use the 
24-hour time standard.  Leading zeroes are optional.

3.	 Press the Tab key on the keyboard or click in another field to exit the set date , 
set time, set offset field.

4.	 Click the Take button to make the date change take affect.

Sync Time to PC button
Clicking the Sync Time to PC button causes the computer you are operating to 
send its internal time to the switcher in a set time command.
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Use Daylight Savings checkbox
If desired, click in the Use Daylight Savings checkbox.  When Daylight Saving 
Time is turned on, the switcher automatically updates its internal clock between 
Standard Time and Daylight Saving Time in the spring and fall on the date that the 
time change occurs in the country or region selected.  When Daylight Saving Time 
is turned off, the switcher does not adjust its time reference.

Administrator Password and User Password fields
The Administrator Password field displays the password required to log on to the 
matrix switcher via the Ethernet port with all of the administrator’s rights and 
privileges.  The User Password field displays the password required to log on to the 
matrix switcher via the Ethernet port as a user, without all of the administrator’s 
rights and privileges.  Passwords are case sensitive and are limited to 12 upper-case 
and lower-case alphanumeric characters.

While you are logged on as a user, both password fields are masked with asterisks 
(************) as a security measure.

N	 Editing the Administrator Password field while connected via the Ethernet port 
can immediately disconnect the user from the switcher.  Extron recommends 
editing this field using one of the serial ports and protecting the Ethernet 
access to this screen by assigning an administrator’s password to qualified and 
knowledgeable personnel only.

N	 An administrator password must be created before a user password can be 
created.

N	 The following characters are invalid in passwords: 
{space}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  |  \  and ?.

Edit either password field as follows:

1.	 Click in the desired Password field.  The pointer tool becomes a text cursor.

2.	 Edit the case-sensitive password as desired.

3.	 Press the Tab key on the keyboard or click in another field to exit the 
Password field.

4.	 Click the Take button to make the password change take effect.

Update firmware
The firmware upgrade utility provides a way to replace the firmware that is coded 
on the switcher’s control board without taking the switcher out of service.

N	 The update firmware utility is for replacing the firmware that controls all 
switcher operation.  This is not the selection to insert your own HTML pages. 
See “Upload HTML files” to insert custom HTML pages.

Update the switcher firmware as follows:

1.	 Visit the Extron Web site, www.extron.com, click the Download Center tab, 
and then click the Firmware link (figure 5-27).
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only.
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Figure 5-27 — Location of firmware upgrade files on the Web site

2.	 Select the appropriate firmware file to download and click Download.

3.	 Enter the requested personal information and then click Download to copy the 
firmware to your computer.

4.	 Click Run twice (figure 5-28).  The PC downloads the firmware update from 
the Extron Web site and starts the Extron Installation Program to extract the 
firmware file.
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Figure 5-28 — Downloading firmware upgrade files

5.	 Click Next.  The program extracts the firmware files and places them in a 
folder identified in the InstallShield Wizard window.

N	 Note the folder to which the firmware file is saved.
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6.	 Click Finish to exit the program.

7.	 Connect a computer running the Windows Operating Systemto either switcher 
serial port or the switcher LAN port.  See chapter 2, “Installation”, for more 
details.

8.	 Start the Matrix Switchers Control Program and connect to the 
matrix switcher.  See “Starting the program” in this chapter, steps 1 through 4, 
starting on page 5-41.

9.	 Click Tools > Update Firmware... .

	 If you are connected via the LAN port, the select file window appears 
(figure 5-29).  See “Ethernet-connected firmware upload”, below.

	 If you are connected via either serial port, the Extron Firmware Loader 
appears (figure 5-30).  See “Serial-port-connected firmware upload”, on 
page 5-50.

Ethernet-connected firmware upload

11

10

Figure 5-29 — Select file window

10.	 Navigate to the folder where you saved the firmware upgrade file.  Select the 
file. 

N	 Valid firmware files must have the file extension .S19.  Any other file extension 
is not a firmware upgrade.

N	 The original factory-installed firmware is permanently available on the 
MPX switcher.  If the attempted firmware upload fails for any reason, the 
switcher reverts to the factory-installed firmware.

11.	 Click the Open button.  The software advises you that you are about to 
reprogram the switcher’s firmware.  Click OK to continue.

	 A status window, which shows the progress of	  
the upload, appears.  The firmware upload to the 
MPX switcher may take a few minutes.  When the 
upload is complete, the program closes.
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Serial-port-connected firmware upload

	

10

11

11

12

Figure 5-30 — Firmware loading

10.	 Click Browse.  The Choose Firmware File window appears.

11.	 Navigate to the folder where you saved the firmware upgrade file.  Select the 
file and click Open.  The Firmware Loader window returns to the top.

N	 Valid firmware files must have the file extension “.S19”.  Any other file 
extension is not a firmware upgrade for your matrix switcher.

12.	 Click Upload.  The File Loader advises you that using the Ethernet (LAN) port 
is preferred over using either serial port (figure 5-31).

	 To quit the firmware upload and start over using the LAN port, click the 
Cancel button and return to step 7.  Use the LAN port connection in step 7.

	 To continue the firmware upload using either serial port connection, click the 
OK button.  The program prompts you to identify the serial port to which you 
are connected.  Continue to step 13.
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12

14

13

13

Figure 5-31 — Confirm window

13.	 If necessary, change the port number in the device port field:

•	 Rear panel RS-232 Primary port, enter 1.

•	 Front panel Configuration portor rear panel RS-232 Secondary port, enter 2.

	 Click the OK button.  The Firmware Loader	  
reports, “This process could take several minutes.  
Please wait...”, then displays a status bar that 
shows the progress of the upload.  When the 
upload is complete, the Firmware Loader reports “Unit resetting, this can take 
some time, please wait. ...”, and then “Transfer complete!”.

14.	 When the Firmware Loader reports, “Transfer complete!”, click the Exit button 
on the Firmware Loader and then again on the port configuration window.  
The Firmware Loader and the Matrix Switchers Control Program close.
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Upload HTML files
N	 The HTML Files List window is for inserting your own HTML pages.  This is 

not the window to replace the firmware that controls all switcher operation.  See 
“Update firmware” in this chapter to replace the firmware.

You can create customized HTML pages for the switcher to display.  The HTML 
Files List window (figure 5-32) provides a way to view the contents of the 
switcher’s file system and upload custom HTML pages to the switcher.

Figure 5-32 — HTML Files List window

N	 The files listed in figure 5-32 are shown for example only and may not be present 
on your switcher.

Upload HTML pages as follows:

N	 The following characters are invalid in file names: 
{space}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  |  \  and ?.

1.	 Connect the PC to the matrix switcher via one of the switcher’s RS-232 ports 
or Ethernet port.

2.	 Start the Matrix Switchers Control Program and connect to the MPX switcher.  
See “Starting the program” in this chapter, steps 1 through 4, starting on page 5-41.

3.	 Click Tools > HTML File Manager.

4.	 Click the Pick File(s) to Load to Server button.  An open file window 
appears.

5.	 Navigate to the folder where you saved the HTML file(s).  Select the file(s).

N	 To select multiple files, hold the Ctrl key while you select the desired files.

N	 If you want one of the HTML files that you created to be the default start-up 
page, name the file “index.html”.  The MPX switcher automatically looks for 
that file name when you first connect to it using an Internet browser.

6.	 Click on the Open button.  The file(s) upload to the MPX switcher may take a 
few minutes.

7.	 Click on the Update button to confirm the upload.

8.	 Click on the Close button to exit the HTML Files List window.
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WCP Windows buttons, drop boxes, and trash
The buttons, drop boxes, and trash can on the right side of the	  
program window perform the following functions:

Power — Unavailable for MPX Plus 866 A switcher, because the 
switcher power cannot be controlled via software.

Executive Mode — Allows you to lock out front panel operations, 
except for the view-only mode functions.  Click the button to 
cycle between Lock mode 0 (the indicator is white), Lock mode 1 
(the indicator displays red), and Lock mode 2 (orange).

N	 See “Setting the front panel locks (Executive modes)” in 
chapter 3, “Operation” for more information on the Lock modes.

Presets menu — Displays a list of up to 32 presets.  You can select a 
preset from the list to display it in the window and either activate 
it (Go) or delete it (Delete).

Go — Activates the selected preset as the current configuration.

Save as — Allows the current set of ties to be saved as a preset.  Enter 
the preset number when prompted to do so.

Delete — Allows the current preset to be deleted.

Changes – Take — Allows you to save to file any changes made to 
the displayed configuration.

Changes – Cancel — Returns to the previous screen, undoing any changes you 
have made.

Trash can — Drag and drop from an input or output button to the trash can to clear 
all ties associated with that input or output.

WCP Windows menus

WCP File menu	
Save matrix settings as ... — Saves a complete set of 

up to 32 presets, plus the last active setting (preset #0), 
to a file.  Saved settings include audio gain settings (if 
specified), assigned icons, and icon captions.

Restore matrix settings from ... — Loads and activates a 
previously saved setting file.

Save this-session’s settings — Saves the current assigned 
icons and icon captions.

Restore last-session’s settings — Loads the icons and icon captions that were 
saved during the last session.  If you saved the previous session’s changes to disk 
the last time you exited the program, the ties from that session are also loaded.

Select printer ... — Selects the target printer from a list of connected printers.

Print tie map — Prints the tie set that is displayed on the screen.

Exit — Closes the Matrix Switchers Control Program.
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WCP Tools menu	
Assign Device Icons — Displays the complete set of input 

and output device icons.  You can drag any of these 
icons to the input and output boxes.

Edit Device Palette — Allows you to add your own device 
icon graphics.

RGB Delay settings — Displays the switching interval 
setting for each input and allows you to change them.

Audio-Input Gain settings — Displays the audio gain 
level setting for a single input or for all inputs and 
allows you to change it.  The level is expressed as the 
amplitude (number of decibels) and polarity (positive, 
gain or negative, attenuation) of the audio adjustment.

N	 Individual controls, offering finer trim adjustments 
(in 0.1 dB increments) for the right and left channels and group master offsets 
are present in the DSP (see “DSP Configurator Program”, on page 5-4).  These 
controls are not shown in the gain display described here.

Audio-Output Volume settings — Displays the audio output level setting for 
a single input or for all inputs and allows you to change it.  The level is 
expressed as a percentage of the input audio volume that is applied to the 
output; 0% is full attenuation (audio is silent), 100% is full volume.

N	 Individual controls, offering finer trim adjustments (in 0.1 dB increments) for 
the right and left channels and group master offsets are present in the DSP (see 
“DSP Configurator Program”, on page 5-4).  These controls are not shown in 
the volume display described here.

Audio DSP Configuration — Calls the DSP Configurator program and 
automatically switches to Live mode.  See ”DSP Configurator Program”, on 
page 5-4.

Mute-Output settings — Displays the Volume and Mute Adjust screen, which 
allows you to mute and unmute individual or all video and/or audio 
outputs.

Video-Input format — Displays the Video-Input Format screen, which allows you 
to define inputs 11 through 14 as either S-video or composite video.

View-Input Frequencies — (DSVP) Displays the input horizontal and vertical 
frequencies for each computer video group input and the signal present or 
not present status for each low resolution video group input.

Update Firmware — Allows you to replace the firmware that is coded on the 
switcher’s control board without taking the switcher out of service, opening 
the switcher enclosure, and replacing the firmware chip set.  See “Update 
firmware” on page 5-46.

IP Options — Allows you to set IP options.  See “IP Settings/Options window” on 
page 5-44.

HTML File Manager — Displays a list of HTML files installed on the switcher and 
allows you to upload custom files from a connected PC to the switcher.  See 
“Upload HTML files” on page 5-52.
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Hardware Status — Provides an overall view of the status of the matrix switcher, 
including the primary and secondary power supply status and the 
individual voltages, the fan and temperature status, the Remote RS-232 port 
configuration, and the installed and updated firmware status (figure 5-33).

	

Figure 5-33 — Status window

Name Presets — Allows you to assign a name to each of the 32 memory presets.

N	 Preset names are limited to 12 upper- and lower-case alphanumeric characters, 
space, and the  _  :  =  and  /  characters.

N	 The following characters are invalid in preset names: 
+  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  |  \  and ?.

Show RS-232 Strings — Displays the ASCII commands that are used by the 
current configuration.  You can refer to these for RS-232 programming.

Initialize — Initializes and clears any or all of the following: ties, presets, audio 
configuration, preset names, icon names, and icons.

WCP Audio-input Configuration menu bar selection	
Displays the audio gain level setting for a single input or for all inputs 
and allows you to change it.  The level is expressed as the magnitude (number 
of decibels) and polarity (positive, gain or negative, attenuation) of the audio 
adjustment.

WCP Preferences menu	
Immediate Changes — Causes configuration changes to take 

effect immediately.

Hold/Verify Changes — Delays implementation of 
configuration changes until the Changes – Take button 
is pressed.

Ties as Lines — Displays ties as lines (figure 5-34).

	

Figure 5-34 — Ties shown as lines
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Ties as Crosspoints — Displays ties as a matrix of inputs and outputs (figure 5-35).  
Ties that have been made are indicated as amber (video and audio), green 
(video only), and red (audio only) boxes.  Ties that will take effect when you 
click on the Take button are indicated by +.  Ties that will be broken when 
you click on the Take button are indicated by –.

	

Figure 5-35 — Ties shown as crosspoints

Frequency read options (computer video inputs only) — Allows you to set the 
input signal detection (DSVP) feature as follows:

•	 To never sample and display the sync or no sync status 
(set this option to None)

•	 To automatically refresh the display 
(set this option to Automatically every 10 seconds)

•	 To sample the sync and update the display whenever you make a 
configuration change (set this option to On demand or by refresh).

Icons in I/O Boxes — Erases any numbers in the I/O boxes in the	  
Control Program window (figure 5-25).  You can place icons in the 
boxes.

Numbers in I/O Boxes — Erases any icons in the I/O boxes in the	  
Control Program window and fills each box with the associated 
input or output number.

Catch FPC/other’s Changes — When checked, sets the switcher to report 
all configuration and setting changes to the Remote RS-232 or Ethernet 
connection that turned this selection on.  These reports allow the Matrix 
Switchers Control Program to track the changes that occur in the switcher’s 
configuration and settings, whether commanded via the front panel, the 
RS-232 port, or the Ethernet port.
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WCP Master-Reset menu bar selection	
Master reset clears all ties and presets, all video and audio mutes, sets all 
input audio levels to unity gain (+0 dB), sets all output volume levels to 100% (0 dB 
of attenuation), and clears the entire DSP configuration.

N	 Master reset does not reset the Internet protocol (IP) settings.

Using Emulate mode
Emulate mode allows you to set up the software without connecting a switcher to 
the computer.  To use Emulate mode, do the following:

1.	 Double-click the Matrix Switchers Control Program icon in the Extron 
Electronics group or folder.

2.	 Choose Emulate, and click Ok.

3.	 Choose an emulation file to open, and click Ok.  The file DEMO.MTX provides 
a sample of a completed matrix setup.  Selecting the file NEW.INI or clicking 
Cancel provides a blank setup to get you started.

4.	 Enter the file name under which you want to save any changes to the file, and 
click Ok.

5.	 Select the number of video boards, audio boards, and matrix model for which 
you are preparing a configuration, and click Ok.

6.	 Continue using the program as described on page 5-42.

Using the help system
For information about program features, you can access the help program in any of 
the following ways:

	 •	 From the Extron Electronics program folder or group,	  
double-click on the Matrix Switcher Help icon (shown at right).

	 •	 From within the Matrix Switchers Control Program, click on the 
Help menu on the main screen.

	 •	 From within the Matrix Switchers Control Program, press the F1 key.

Special Characters
The HTML language reserves certain characters for specific functions.  The switcher 
will not accept these characters as part of preset names, the switcher’s name, 
passwords, or locally created file names.

The switcher rejects the following characters: 
{space (spaces are ok for names)}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  semicolon (;)  
colon (:)  |  \  and ?.

Button-Label Generator Program
The Button Label Generator software creates labels that you can place in the 
translucent covers of the input and output selection buttons.  You can create labels 
with names, alphanumeric characters, or even color bitmaps for easy and intuitive 
input and output selection.  See appendix C, “Reference Information”, for the 
procedure for removing and replacing the translucent covers.

The Extron Button Label Generator is available on the Extron Web site, 
www.extron.com, under the Download Center tab.  Click the Software link 
(figure 5-36), and download and install the program.
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Figure 5-36 — Location of software on the web site

N	 The Button Label Generator software is also included on the Extron Software 
Products Disk that accompanies the switcher.

By default, the installation creates a C:\Program Files\Extron\
ButtonLabelGenerator directory and places the Button Label Generator icon into a 
group or folder named “Extron Electronics”.

Using the Button-Label Generator software
1.	 To run the Button-Label Generator program, click Start > Programs > Extron 

Electronics > Button Label Generator > Button Label Generator.  The 
Button-Label Generator window appears (figure 5-37).

2.	 In the Systems selection box, choose the Matrix Switchers 1616 option to 
match the button label size and quantities for your MPX switcher.

3.	 Using standard Windows controls, you can create and print labels that can be 
placed in the label windows on the front panel of the switcher.

N	 For best results, print on transparent or translucent material.

4.	 Click the Clear All Buttons button and create new labels as many times as 
necessary to make all of the button labels that you need.

To access the help program, click the Help menu.

Figure 5-37 — Extron Button-Label Generator window
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The switcher can be controlled and operated through its Ethernet port, connected 
via a LAN or WAN, using a web browser such as the Microsoft® Internet Explorer®.  
The browser’s display of the switcher’s status or operation has the appearance of 
web pages.  This chapter describes the factory-installed HTML pages, which are 
always available and cannot be erased or overwritten.

N	 If your Ethernet connection to the matrix switcher is unstable, try turning off 
the proxy server in your Web browser.  In Microsoft Internet Explorer, click 
Tools > Internet Options > Connections > LAN Settings, uncheck the “Use 
a proxy server...” box, and then click Ok.

Download the Startup Page
Access the switcher using HTML pages as follows:

1.	 Start the Web browser program.

2.	 Click in the browser’s Address field.

3.	 Enter the switcher’s IP address in the browser’s Address field.

N	 If the local system administrators have not changed the value, the factory-
specified default, 192.168.254.254, is the correct value for this field.

4.	 If you want the browser to display a page other than the default page (such as 
a custom page that you have uploaded), enter a slash (/) and the file name to 
open after the IP address.

N	 The browser’s Address field should display the address in the following format: 
xxx.xxx.xxx.xxx/{optional_file_name.html}

N	 The following characters are invalid in file names: 
{space}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  |  \  and ?.

5.	 Press the keyboard Enter key.  The switcher checks to see if it is password 
protected.

	 If the switcher is not password protected, it checks and downloads the HTML 
pages to the PC (proceed to step 7).

	 If the switcher is password protected, the computer displays the Connect To 
dialog box (figure 6-1).

	

Figure 6-1 — Connect To page

6.	 Click in the Password field and type in the appropriate administrator or user 
password.  Click the OK button.

N	 A User name entry is not required.
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7.	 The switcher checks several possibilities, in the following order, and then 
responds accordingly:

a.	 Does the address include a specific file name, such as 10.13.156.10/file_
name.html?  If so, the switcher downloads that HTML page to the PC.

b.	 Is there a file in the switcher’s memory that is named “index.html”? 
If so, the switcher downloads “index.html” as the default startup page.

c.	 If neither of the above conditions is true, the switcher downloads the 
factory-installed default startup page to the PC, “nortxe_index.html” 
(figure 6-2), also known as the System Status page.

Status Tab

System Status page
The System Status page (figure 6-2) provides an overall view of the status of the 
matrix switcher, including the power supply status, the individual voltages, and 
the temperature.  The System Status page is the default page that the switcher 
downloads to the PC when you connect to the switcher.  Access the System Status 
page from other pages by clicking the Status tab.

 

DSVP
Refresh

Figure 6-2 — System Status page
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DSVP page
You can view a snapshot-in-time of the input frequencies of connected computer 
inputs and input signal status of composite video and S-video inputs on the Digital 
Sync Validation Processing (DSVP) page (figure 6-3).  Click the DSVP link to the 
left of the Status page to download the DSVP page to the PC.  The DSVP page 
automatically updates itself every 30 seconds to show the latest input frequencies 
or if an input has been disconnected.

 

Refresh
System Status

Figure 6-3 — DSVP page
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Configuration Tab

System Settings page
The matrix switcher downloads the System Settings page to the PC (figure 6-4) 
when you click the Configuration tab.  The screen  consists of fields in which 
you can view and edit IP administration and system settings.  The Video Input 
Settings, Passwords, and Firmware Upgrade pages can be accessed by clicking the 
appropriate link.  See appendix A, “Ethernet Connection”, for basic information 
about IP addresses and subnetting.

Video Input Settings
Refresh

Firmware Upgrade
Passwords

 

Figure 6-4 — System Settings page

On password-protected connections, there are two levels of protection: 
administrator and user.  Administrators have full access to all switching capabilities 
and editing functions.  Users can create ties, create and recall presets, set video and 
audio mutes, and view all settings except passwords.

	 •	 Ethernet connection to the switcher is password protected.

	 •	 Connection via any RS-232 port is not password protected.
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IP Settings fields
The IP Settings fields provide a location for viewing and editing settings unique 
to the Ethernet interface.  After editing any of the settings on this page, click the 
Submit button at the bottom of the page.

Unit Name field
The Unit Name field contains the name of the switcher.  This name field can be 
changed to any valid name, up to 24 alphanumeric characters.

N	 The following characters are invalid in the matrix name: 
+  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  |  \  and ?.

DHCP radio buttons
The DHCP On radio button directs the switcher to ignore any entered IP addresses 
and to obtain its IP address from a Dynamic Host Configuration Protocol (DHCP) 
server (if the network is DHCP capable).  The DHCP Off radio button turns DHCP 
off.  Contact the local system administrator to determine if DHCP is appropriate.

IP Address field
The IP Address field contains the IP address of the connected switcher.  This value 
is encoded in the switcher’s flash memory.

Valid IP addresses consist of four 1-, 2-, or 3-digit numeric subfields separated by 
dots (periods).  Each field can be numbered from 000 through 255.  Leading zeroes, 
up to 3 digits total per field, are optional.  Values of 256 and above are invalid.

The factory-installed default address is 192.168.254.254, but if this conflicts with 
other equipment at your installation, you can change the IP address to any valid 
value.

N	 IP address changes can cause conflicts with other equipment.  Only local system 
administrators should change IP addresses.

Gateway IP Address field
The Gateway IP Address field identifies the address of the gateway to the mail 
server to be used if the switcher and the mail server are not on the same subnet.

The gateway IP address has the same validity rules as the system IP address.

Subnet Mask field
The Subnet Mask field is used to determine whether the switcher is on the same 
subnet as the mail server when you are subnetting.  For more information, see 
“Subnetting — A Primer”, in Appendix A, “Ethernet Connection”.

MAC Address field
The Media Access Control (MAC) Address (called the “hardware address” in the 
Matrix Switchers Control Program, chapter 5, “Switcher Software”) is hardcoded in 
the switcher and cannot be changed.
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Date/Time Settings fields
The Date/Time Settings fields (figure 6-5) provide a location for viewing and 
setting the time functions.

Figure 6-5 — Date/Time Settings fields

Change the date and time settings as follows:

1.	 Click the desired variable’s drop box.  The adjustable variables are month, 
day, year, hours, minutes, AM/PM, and (time) zone.  A drop-down scroll box 
appears (the year drop box is selected in figure 6-5).

2.	 Click and drag the slider or click the scroll up  button or scroll down  
button until the desired variable is visible.

3.	 Click the desired variable.

N	 If setting the time, set the local time.  The Zone variable allows you to then select 
the offset from Greenwich Mean Time (GMT).

N	 The Zone field identifies the standard time zone selected and displays the 
amount of time, in hours and minutes, that the local time varies from the GMT 
international time reference.

4.	 Repeat steps 1 through 3 for other variables that need to be changed.

5.	 If appropriate, click in the Daylight Savings radio button to turn on the 
daylight savings time feature.

N	 When Daylight Saving Time is turned on, the switcher automatically updates its 
internal clock between Standard Time and Daylight Saving Time in the spring 
and fall on the date that the time change occurs in the country or region selected.  
When Daylight Saving Time is turned off, the switcher does not adjust its time 
reference.

6.	 Click the Submit button.
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Video Input Settings page
Access the Video Input Settings page (figure 6-6) by clicking the Video Input 
Settings link on the System Settings page.

Refresh
System Settings

Firmware Upgrade
Passwords

 

Figure 6-6 — Video Input Settings page

Low resolution video inputs 11 through 14 are individually configurable as either 
S-video or composite video.  Click the appropriate radio button on the Video Inputs 
Settings page to select between S-video and composite video.
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Passwords page
Access the Passwords page (figure 6-7) by clicking the Passwords link on the 
System Settings page.

Video Input Settings
System Settings

Firmware Upgrade
Refresh

 

Figure 6-7 — Passwords page

The fields on the Passwords page are for entering and verifying administrator and 
user passwords.  Passwords are case sensitive and are limited to 12 upper case and 
lower case alphanumeric characters.  Each password must be entered twice: once 
in the Password field and then again in the Re-enter Password field.  Characters in 
these fields are masked by asterisks or dots (*****).  If you do not want to password 
protect an access level, leave the Password field and the Re-Enter password field 
blank.  After entering the desired password in both fields, click the Submit button.

N	 An administrator password must be created before a user password can be 
created.

To clear an existing password so that no password is required, enter a single space 
in the Password and Re-enter Password fields and click the Submit button.



HTML Operation, cont’d

MPX Plus 866 A Media Presentation Matrix Switcher • HTML Operation6-10

PR
EL

IM
IN

A
RY

Firmware Upgrade page
The Firmware Upgrade page provides a way to replace the firmware that is coded 
on the switcher’s control board without taking the switcher out of service.  Access 
the Firmware Upgrade page (figure 6-8) by clicking the Firmware Upgrade link on 
the System Configuration page.

Video Input Settings
Systen settings

Refresh
Passwords

 

Figure 6-8 — Firmware Upgrade page

Update the switcher firmware as follows:

N	 The Firmware Upgrade page is only for replacing the firmware that controls all 
switcher operation.  To insert your own HTML pages, see “File Management 
Page”, on page 6-14.

1.	 Visit the Extron Web site, www.extron.com, click the Download Center tab, 
and then click the Firmware link (figure 6-9 on the next page).

2.	 Select the appropriate firmware file to download and click Download.

3.	 Enter the requested personal information and then click Download to copy the 
firmware to your computer.
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1

1

The version, release
date, and size shown
are sample values
only.

NOTE

Figure 6-9 — Location of firmware upgrade files on the Web site
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4.	 Click Run twice (figure 6-10).  The PC downloads the firmware update from 
the Extron Web site and starts the Extron Installation Program to extract the 
firmware file.

	
6

4

5

4

Folder where
firmware is
installed

The version shown
is a sample value
only.

NOTE

Figure 6-10 — Downloading firmware upgrade files
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5.	 Click Next.  The program extracts the firmware files and places them in a 
folder identified in the InstallShield Wizard window.

N	 Note the folder to which the firmware file is saved.

6.	 Click Finish to exit the program.

7.	 Connect the PC to the matrix switcher via the switcher’s Ethernet port.

8.	 Access the matrix switcher using HTML pages.

9.	 Click the Configuration tab.

10.	 Click the Firmware Upgrade link.

11.	 Click the Browse button.  An open file window appears.

12.	 Navigate to the folder where you saved the firmware upgrade file.  Select the 
file.

N	 Valid firmware files must have the file extension ‘.S19’.  Any other file extension 
is not a firmware upgrade.

N	 The original factory-installed firmware is permanently available on the matrix 
switcher.  If the attempted firmware upload fails for any reason, the switcher 
automatically reverts to the factory-installed firmware.

13.	 Click the Open button.

14.	 Click the Upload button.  The firmware upload to the switcher may take a few 
minutes.
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File Management Tab

File Management page
To delete files such as HTML pages from the connected switcher or to upload your 
own files to the switcher, click the File Management tab.  The switcher downloads 
the file management HTML page to the PC (figure 6-11).

Figure 6-11 — File Management page

N	 The files listed in figure 6-11 are shown for example only and may not be present 
on your switcher.

To delete a file, click the Delete button at the right of that file.

Upload your own files as follows:

N	 The following characters are invalid in file names: 
{space}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  |  \  and ?.

1.	Click the Browse button.

2.	Browse through your system and select the desired file(s).

N	 If you want one of the pages that you create and upload to be the default startup 
page, name that file “index.html”.

3.	 Click the Upload File button.  The file(s) that you selected appear in the list.
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Control Tab

Set and View Ties page
You can create ties on the Set and View Ties page (figure 6-12).  Access the Set and 
View Ties page by clicking the Control tab.

Video & Audio Settings
Refresh

Global Presets

 

Figure 6-12 — Set and View Ties page

The page consists of a matrix of input (rows) and output (columns) selection 
“buttons” of four different colors, using the same color scheme as the front panel:

•	The amber buttons indicate video and audio ties.

•	The green buttons indicate video only ties.

•	The red buttons indicate audio only ties.

•	The gray buttons indicate no ties.

N	 If you lose track of the input and output associated with a specific button, let the 
mouse pointer rest over a button for a moment.  As shown on figure 6-12, a field 
pops up that identifies the input and output for that button.
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Creating or deleting a tie
Make or break a tie as follows:

1.	 Click the Video Only, Audio Only, or Video & Audio button to select video, 
audio, or both for switching (audio breakaway or audio follow).  Each mouse 
click on a button toggles the other two buttons off.

2.	 Move the mouse over the matrix of input and output selection buttons.  Click 
a button to

•	 Create a pending tie (if a tie does not exist) of the input and output 
associated with that button

•	 Create pending untie (if a tie exists) of the input and output associated 
with that button

A “P” (for pending) appears in the button.

N	 If you lose track of the input and output associated with a specific button, let the 
mouse rest over one of the tie buttons for a moment.  A field pops up (as shown 
on figure 6-12) that identifies the input and output for that button.

N	 To tie an input to all outputs, click that input’s input number.

3.	 Click the Take button to make the configuration changes or the Cancel button 
to abandon the configuration changes.
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Video and Audio Settings page
The Video and Audio Settings page provides a way to set the input audio gain 
and attenuation, set the output volume, and mute and unmute all video and 
audio outputs, and (for outputs in the computer video group) set the RGB delay 
(switching interval).  Access the Video and Audio Settings page (figure 6-13) by 
clicking the Video & Audio Settings link on the Set and View Ties page.

Refresh
Set and View Ties

Global Presets

 

Figure 6-13 — Video and Audio Settings page

Change the input gain and attenuation
Users can set each input’s level of audio gain or attenuation (-18 dB to +24 dB) from 
the Video and Audio Settings page.  Adjustment ensures there are no noticeable 
volume differences between sources.

Change an input’s audio level setting as follows:

1.	 Click the Input drop box.  A drop-down box appears (figure 6-14).

	

Figure 6-14 — Input selection drop box
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2.	 Click the desired input.

3.	 Click the Input Audio Level (dB) drop box.  A drop-down scroll box appears 
(figure 6-15).

	

Figure 6-15 — Gain drop box

N	 Individual controls, offering finer trim adjustments (in 0.1 dB increments) for 
the right and left channels and group master offsets are present in the DSP  
(see “DSP Configurator Program”, in chapter 5, “Switcher Software“).  These 
controls are not shown in the gain display shown in figure 6-15.

4.	 Click and drag the slider or click the scroll up  button or scroll down  
button until the desired audio level is visible.

5.	 Click the desired gain or attenuation value.

Mute and unmute one or all outputs
Mute one or all outputs as follows:

1.	 To select an individual output to mute or unmute, click the Output drop box.  
A drop-down box appears (figure 6-16).

	

Figure 6-16 — Output selection drop box

2.	 Click the desired output.

3.	 Click the Video Only, Audio Only, or Video and Audio button to select video, 
audio, or both for muting.  Each mouse click on a button toggles the other two 
buttons off.

4.	 Click the Mute or UnMute button to mute or unmute the selected output.

	 Click the Mute All or UnMute All to mute or unmute all of the outputs.

	 Observe the Mute status indications on the page (figure 6-17).  Unmuted is 
displayed in green and muted is displayed in red.

	

Figure 6-17 — Mute status indications
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Change the RGB delay (computer group video outputs only
The RGB delay interval defines how long the screen is blanked when switching to a 
new input for the selected output.

Change the RGB delay as follows:

1.	 Click the Output drop box.  A drop-down box appears (figure 6-18).

	

Figure 6-18 — Output selection drop box

2.	 Click the desired output.

3.	 Click the RGB delay drop box.  A drop-down box appears (figure 6-19).

	

Figure 6-19 — RGB delay drop box

4.	 Click the desired RGB delay.
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Change the output volume level
Users can set each output’s volume level through a range of zero steps of 
attenuation (full attenuation, minimum volume) to 64 steps of attenuation (no 
attenuation, full volume) from the Video and Audio Settings page.

Change an output’s audio level setting as follows:

1.	 Click the output drop box.  A drop-down box appears (figure 6-20).

	

Figure 6-20 — Output selection drop box

2.	 Click the desired output.

3.	 Click the Volume Steps (64 Max) drop box.  A drop-down scroll box appears 
(figure 6-21).

	

Figure 6-21 — Volume drop box

N	 Individual controls, offering finer trim adjustments (in 0.1 dB increments) for 
the right and left channels and group master offsets are present in the DSP  
(see “DSP Configurator Program”, in chapter 5, “Switcher Software“).  These 
controls are not shown in the volume display shown in figure 6-21.

4.	 Click the desired output volume step value.

N	 The table on the next page defines the value of each audio volume step.
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Global Presets page
You can save global ties presets and recall global tie presets and partial presets from 
the Global Presets page (figure 6-22).  Access the Global Presets page by clicking the 
Global Presets link on the left of the Control page.

Set and View Ties

Refresh
Video & Audio Settings

Figure 6-22 — Global Presets page

Save a preset
N	 When presets are saved via the HTML page, only the audio and video ties are 

stored; audio gain settings are not saved.

Save the current configuration (configuration 0) as a global ties preset as follows:

1.	 Click the Save Preset button.

2.	 Select the desired preset by clicking on one of the presets listed.  To create a 
new preset, click one of the [unassigned] buttons.  Overwrite an existing preset 
by clicking an already existing preset.

3.	 If desired, type over the current name in the box adjacent to the Save Preset 
button.

N	 Preset names are limited to 12 upper and lower case alphanumeric characters 
and the  {space}  _  :  =  and  /  characters.

N	 The following characters are invalid in preset names: 
+  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  |  \  and ?.

	 If you do not rename an unassigned button, the matrix switcher automatically 
names the preset as Preset {next available number}.

	 If you do not rename an existing preset when it is overwritten, the matrix 
switcher retains the same name.

4.	 Click the Accept button.
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Recall a preset
N	 •	 When presets are recalled via the HTML page, any signal processing 

adjustments that were saved as part of the preset (under DSP Configurator 
control only) are recalled and overwrite the current audio settings.

•	 When a global ties preset is recalled, it replaces the current configuration, 
which is lost unless it is also stored as a preset.  The recalled preset overwrites 
all of the current configuration ties in favor of the preset configuration ties.

•	 When a partial preset is recalled, it overwrites that portion of the current 
configuration addressed by the preset, leaving the rest unchanged.

To recall a preset to be the current configuration, click the button associated with 
the desired preset.

Special Characters
The HTML language reserves certain characters for specific functions.  The switcher 
will not accept these characters as part of preset names, the switcher’s name, 
passwords, or locally created file names.

The switcher rejects the following characters: 
{space}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  semicolon (;)  colon (:)  |  \  and ?.
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Ethernet Link
The rear panel Ethernet connector on the switcher can be 
connected to an Ethernet LAN or WAN.  This connection 
makes SIS control of the switcher possible using a computer 
connected to the same LAN.

Ethernet connection
The Ethernet cable can be terminated as a straight-through cable or a crossover 
cable and must be properly terminated for your application (figure A-1).

	 •	 Crossover cable — Direct connection between the computer and the  switcher

	 •	 Patch (straight-through) cable — Connection of the switcher to an Ethernet 
LAN

A cable that is wired as T568A at one end
and T568B at the other (Tx and Rx pairs
reversed) is a "crossover" cable.

A cable wired the same at both ends is
called a "straight-through" cable, because
no pin/pair assignments are swapped.

12345678

RJ-45
Connector

Insert Twisted
Pair Wires

Pins: Crossover Cable Straight-through Cable

Pin

1

2

3

4

5

6

7

8

Wire color

White-green

Green

White-orange

Blue

White-blue

Orange

White-brown

Brown

Wire color

T568A T568B

End 1 End 2 End 1 End 2

White-orange

Orange

White-green

Blue

White-blue

Green

White-brown

Brown

Pin

1

2

3

4

5

6

7

8

Wire color

White-orange

White-green

Blue

White-blue

White-brown

Brown

Wire color

T568BT568B

White-orange

OrangeOrange

White-green

Blue

White-blue

GreenGreen

White-brown

Brown

Figure A-1 — RJ-45 connector pinout tables

Default address
To access the switcher via the LAN port, you need the switcher’s IP address.  If the 
address has been changed to an address comprised of words and characters, you 
can determine the actual numeric IP address using the Ping utility.  If the address 
has not been changed, the factory-specified default is 192.168.254.254.

Ping can also be used to test the Ethernet link to the switcher.
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Pinging to determine Extron IP address
The ping utility is available at the DOS prompt.  Ping tests the Ethernet interface 
between the computer and the switcher.  Ping can also be used to determine the 
actual numeric IP address from an alias and to determine the web address.

Ping the switcher as follows:

1.	 On the Windows task bar, click Start > Run.

2.	 At the Open prompt, type command.

3.	 Click the OK button.

4.	 At the DOS prompt, type ping {IP address} and then press [Enter].  The 
computer returns a display similar to figure A-2.

	 The line Pinging ... reports the actual numeric IP address, regardless of 
whether you entered the actual numeric IP address or an alias name.

	

C:\>ping 192.168.254.254

Pinging 192.168.254.254 with 32 bytes of data:

Reply from 192.168.254.254: bytes=32 time<10ms TTL=128
Reply from 192.168.254.254: bytes=32 time<10ms TTL=128
Reply from 192.168.254.254: bytes=32 time<10ms TTL=128
Reply from 192.168.254.254: bytes=32 time<10ms TTL=128

Ping statistics for 192.168.254.254:
    Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:
    Minimum = 0ms, Maximum = 0ms, Average = 0ms

Figure A-2 — Ping response

Pinging to determine Web IP address
The ping utility has a modifier, -a, that directs the command to return the Web 
address rather than the numeric IP address.

At the DOS prompt, type ping -a {IP address} and then press [Enter].  The 
computer’s return display is similar to the ping response shown in figure A-2, 
except that when you specify the -a modifier, the line Pinging mail... reports the 
web IP address rather than the numeric IP address, regardless of whether you 
entered the actual numeric IP address or an alias name.
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Connecting as a Telnet client
The Microsoft Telnet utility is available from the command prompt.  Telnet lets you 
input SIS commands to the switcher from the PC via the Ethernet link and the LAN.

Access the command prompt and start Telnet as follows:

1.	 On the Windows task bar, click on Start > Run.

2.	 At the Open prompt, type command.

3.	 Click the OK button.

4.	 At the prompt, type telnet and then press [Enter].  The computer returns a 
display similar to figure A-3.

Microsoft (R) windows 2000 (TM) Version 5.0 (Build 2195)
Welcome to Microsoft Telnet Client
Telnet Client Build 5.00.99203.1

Escape Character is 'CTRL+]'

Microsoft Telnet>

Figure A-3 — Telnet screen

Telnet tips
It is not the intention of this manual to detail all of the operations and functionality 
of Telnet; however, some basic level of understanding is necessary for operating the 
switcher via Telnet.

Open
Connect to the switcher using the Open command.  Once you are connected to the 
switcher, you can enter the SIS commands the same as you would if you were using 
the RS-232 link.

Connect to the switcher as follows:

1.	 At the Telnet prompt, type open {IP address} and then press [Enter].

	 If the switcher is not password protected, no further prompts are displayed 
until you break or disconnect the connection to the switcher.

	 If the switcher is password protected, Telnet displays the password prompt.

2.	 If necessary, at the password prompt, type {password} and then press [Enter].

	 Connection to the switcher via the Ethernet can be password protected.  There 
are two levels of password protection: administrator and user.  A person 
logged on as an administrator has full access to all switching capabilities and 
editing functions.  Users can select video and/or audio for output, select test 
patterns, set audio or RS-232 mutes, select a blue screen, and view all settings 
with the exception of passwords.  By default, the switcher ships with both 
passwords set to {carriage return}.

	 Once you are logged in, the switcher returns either Login Administrator or 
Login User.  No further prompts are displayed until you break or disconnect 
the connection to the switcher.
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Escape character and Esc key
When Telnet is first started, the utility advises that the Escape character is ‘Ctrl+]’.  
Many SIS commands include the keyboard E key.  Consequently, some confusion 
may exist between the Escape character and the Escape key.

The Telnet escape character is a key combination, the Ctrl  key and the ]  key pressed 
simultaneously, that returns you to the Telnet prompt while leaving the connection 
to the switcher intact.

The Escape key is the E key on the computer keyboard.

Local echo
Once connected to the switcher, by default, Telnet does not display your keystrokes 
on the screen.  SIS commands are typed in blindly and only the SIS responses are 
displayed on the screen.  To command Telnet to show keystrokes, at the Telnet 
prompt, type set local_echo and then press [Enter] before you open the 
connection to the switcher.

With local echo turned on, keystrokes and the switcher’s responses are displayed 
on the same line.  For example: 1*1!In1 Out1 All, where 1*1! is the SIS command 
and In1 Out1 All is the response.

With local echo turned on, all keystrokes are displayed, even those that should be 
masked, such as the password entry.  For example, when entering a password with 
local echo turned on, you see a display such as a*d*m*i*n*, where admin is the 
keyed in password and ***** is the masked response.

You can turn off local echo by typing unset local_echo and then pressing 
[Enter] at the Telnet prompt.  If you are connected to the switcher and need to 
access the Telnet prompt to turn local echo off, type the Escape character ( Ctrl + ] ).

Set carriage return-line feed
Unless commanded otherwise, Telnet transmits a line feed character only (no 
carriage return) to the connected switcher when you press the Enter  key.  This is the 
correct setting for SIS communication with the switcher.  The Telnet set crlf 
command forces Telnet to transmit carriage return and line feed characters when 
Enter  is pressed, but if crlf is set, the SIS link with the switcher does not function 
properly.

Close
To close the link to the switcher, access the Telnet prompt by typing the Escape 
character ( Ctrl + ] ).  At the Telnet prompt, type close and then press [Enter].

Help
For Telnet command definitions, at the Telnet prompt, type ? and then press 
[Enter].

Quit
Exit the Telnet utility by typing quit and then pressing [Enter] at the Telnet 
prompt.  If you are connected to the switcher, access the Telnet prompt by typing 
the Escape character ( Ctrl + ] ).
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Subnetting — A Primer
It is not the purpose of this manual to describe TCP/IP protocol in detail.  However, 
some understanding of TCP/IP subnetting (a subnet is a subset of a network — a 
set of IP devices that have portions of their IP addresses in common) is necessary in 
order to understand the interaction of the switcher and the mail server gateway.  To 
understand subnetting at the level required to install and operate the switcher, you 
must understand the concepts of a gateway, local and remote devices, IP addresses 
and octets, and subnet masks and octets.

Gateways
The switcher can communicate with the e-mail server that the switcher uses for 
e-mail notification directly (if they are on the same subnet) or the communication 
can be routed via a gateway (a computer that provides a link between different 
subnets).

Local and remote devices
The local and remote devices are defined from the point of view of the function 
being described.  In this manual, subnetting is an issue when you are using the 
controlling PC to set TCP/IP values in the switcher (see “IP Settings/Options 
window” in chapter 5, “Switcher Software”, and “System Settings page” in 
chapter 6, “HTML Operation”).

IP addresses and octets
Valid IP addresses consist of four 1-, 2-, or 3-digit numeric subfields, properly called 
octets, separated by dots (periods) (figure A-4).  Each octet can be numbered from 
000 through 255.  Leading zeroes, up to three digits total per octet, are optional.  
Values of 256 and above are invalid.

192.168.254.254Typical IP Address:
Octets

Figure A-4 — IP address and octets

Subnet masks and octets
The subnet mask (figure A-5) is used to determine whether the local and remote 
devices are on the same subnet or different subnets.  The subnet mask consists 
of four numeric octets separated by dots.  Each octet can be numbered from 
000 through 255.  Leading zeroes, up to three digits total per octet, are optional.  
Each octet typically contains either 255 or 0.  The octets determine whether or not 
the same octets of two IP addresses will be compared when determining if two 
devices are on the same subnet.

255.255.0.0Typical Subnet Mask:
Octets

255 indicates that this octet will be
compared between two IP addresses.

0 indicates that this octet will not be
compared between two IP addresses.

Figure A-5 — Subnet mask and octets
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Determining whether devices are on the same subnet
To determine the subnet, the local device’s IP address is compared to the remote 
device’s IP address (figure A-6).  Each address’s octets are compared or not 
compared, depending on the value in the related subnet mask octet.

	 •	 If a subnet mask octet contains the value 255, the related octets of the local 
device’s address and the remote device’s IP address are unmasked.

		  Unmasked octets are compared (indicated by ? in figure A-6).

	 •	 If the subnet mask octet contains the value 0, the related octets of the local 
device’s and remote device’s IP addresses are masked.

		  Masked octets are not compared (indicated by X in figure A-6).
If the unmasked octets of the two IP addresses match (indicated by = in figure A-6) 
(example 1), the two addresses are on the same subnet.

If the two unmasked fields do not match (indicated by ≠ in figure A-6) (example 2 
and example 3), the addresses are not on the same subnet.

192.168.254.254
255.255.0.0 (?.?.X.X)
192.168.2.25
=.=.X.X — Match

(Same subnet) (Different subnet) (Different subnet)

Local IP Address:
Subnet Mask:

Remote IP Address:
Match?:

Example 1 Example 2
192.168.254.254
255.255.0.0 (?.?.X.X)
190.190.2.25
≠.≠.X.X — No match

Example 3
192.168.254.254
255.255.0.0 (?.?.X.X)
192.190.2.25
=.≠.X.X — No match

Figure A-6 — Comparing the IP addresses
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Command/Response Table for DSP SIS Commands
Many digital signal processor (DSP) functions; gain (which includes the mic 
mixes), mutes, group masters, and a protected configuration; can be controlled 
using SIS commands.  These commands follow the same general rules as basic SIS 
commands, but the variables (X/s) tend to be more complex.  Also, a comprehensive 
understanding of the DSP’s audio signal flow is helpful to understanding these 
commands.  Figure B-1 shows the specific DSP processors and the mic mix-points 
that can be set via SIS commands.  The signal flow is described in more detail in 
“DSP Configurator Program“, in chapter 5, “Switcher Software”.

15 3 6

2

4

Figure B-1 — DSP processors addressable via SIS commands

a	 Program audio input (pre-matrix) trim block

b	 Mic/line input gain block

c	 Post-matrix gain block

d	 Mix-points (and associated built-in mixing controls)

e	 Stereo audio input gain block (for group master controls only)

f	 Stereo output volume (for group master controls only)
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Symbol definitions
]	 =	 CR/LF (carriage return/line feed) (hex 0D 0A)

}	 =	 Carriage return (no line feed, hex 0D)

•	 =	 Space character

|	 =	 Pipe (vertical bar) character

*	 =	 Asterisk character (which is a command character, not a variable)

E	 =	 Escape key (hex 1B)  (use W instead of Esc for Web browsers)

X6)	 =	 Gain control or mic mix-point	 See the tables on page B-4 and B-5.

X6!	 =	 Level value; pre-matrix (a), post-matrix (c), and mic-mix (d)	 See the table on page B-6 through B-8. 
-35 dB to + 25 dB, in 0.1 dB increments. 
N	 Pre-matrix and post-matrix, -12 dB to +12 dB only.

X6@	 =	 Mic/line gain level value	 See the table on page B-8. 
0 dB to +80 dB, in 1.0 dB increments.

X6#	 =	 Mute status	 0 = unmute 
1 = mute

X6$	 =	 Group master group number	 01 – 32 (repeated as X2) in chapter 4,”SIS Programming 
and Control”)

X6%	 =	 Group fader setting	 dB value, in 0.1 dB increments.  The valid range depends 
on the type of gain block that is assigned to the group 
number (X6$) specified in the command: 

a = -120 to +120  (-12.dB to +12.0 dB) 

b = 000 to 800  (0.00 dB to 80.0 dB) 

c = -1,000 to +120  (-100.0 dB to +12.0 dB) 

d = -350 to + 250  (-35.0 dB to + 25.0 dB) 

e = -180 to +240  (-18.0 dB to +24.0 dB) 

f = -640 to 000  (-64.0 dB to 0.00 dB)

X6^	 =	 Group fader offset	 dB value, in 0.1 dB increments, to raise or lower a group 
fader

X6&	 =	 Group fader soft limit	 dB value, in 0.1 dB increments.  The valid range must be 
within the range for the gain block grouped in X6%.

X6*	 =	 Group type	 6= gain (a through d)	 12 = mute 
18 = gain (e and f)

X6(	 =	 Personal Identification Number (PIN)	 Four numeric digits, default = 0000

X7)	 =	 Protected configuration status	 0 = no protected configuration saved 
1 = protected configuration saved
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X6) — Gain control or mic mix-point

a Trim control X6) a Trim control X6) b Gain control X6)

Input 1, left 30100 Input 1, right 30101 Mic/line input 1 40000

Input 2, left 30102 Input 2, right 30103 Mic/line input 2 40001

Input 3, left 30104 Input 3, right 30105 Mic/line input 3 40002

Input 4, left 30106 Input 4, right 30107 Mic/line input 4 40003

Input 5, left 30108 Input 5, right 30109

Input 6, left 30110 Input 6, right 30111

Input 7, left 30112 Input 7, right 30113 c Post matrix gain 
control X6)

c Post matrix gain 
control X6)Input 8, left 30114 Input 8, right 30115

Input 9, left 30116 Input 9, right 30117 Output 1, left 50000 Output 1, right 50001

Input 10, left 30118 Input 10, right 30119 Output 2, left 50002 Output 2, right 50003

Input 11, left 30120 Input 11, right 30121 Output 3, left 50004 Output 3, right 50005

Input 12, left 30122 Input 12, right 30123 Output 4, left 50006 Output 4, right 50007

Input 13, left 30124 Input 13, right 30125 Output 5, left 50008 Output 5, right 50009

Input 14, left 30126 Input 14, right 30127 Output 6, left 50010 Output 6, right 50011

d Mic mix-point X6) d Mic mix-point X6) d Mic mix-point X6) d Mic mix-point X6)

Output 1, left, mic 1 21200 Output 1, right, mic 1 21201 Output 4, left, mic 1 21206 Output 4, right, mic 1 21207

Output 1, left, mic 2 21300 Output 1, right, mic 2 21301 Output 4, left, mic 2 21306 Output 4, right, mic 2 21307

Output 1, left, mic 3 21400 Output 1, right, mic 3 21401 Output 4, left, mic 3 21406 Output 4, right, mic 3 21407

Output 1, left, mic 4 21500 Output 1, right, mic 4 21501 Output 4, left, mic 4 21506 Output 4, right, mic 4 21507

Output 2, left, mic 1 21202 Output 2, right, mic 1 21203 Output 5, left, mic 1 21208 Output 5, right, mic 1 21209

Output 2, left, mic 2 21302 Output 2, right, mic 2 21303 Output 5, left, mic 2 21308 Output 5, right, mic 2 21309

Output 2, left, mic 3 21402 Output 2, right, mic 3 21403 Output 5, left, mic 3 21408 Output 5, right, mic 3 21409

Output 2, left, mic 4 21502 Output 2, right, mic 4 21503 Output 5, left, mic 4 21508 Output 5, right, mic 4 21509

Output 3, left, mic 1 21204 Output 3, right, mic 1 21205 Output 6, left, mic 1 21210 Output 6, right, mic 1 21211

Output 3, left, mic 2 21304 Output 3, right, mic 2 21305 Output 6, left, mic 2 21310 Output 6, right, mic 2 21311

Output 3, left, mic 3 21404 Output 3, right, mic 3 21405 Output 6, left, mic 3 21410 Output 6, right, mic 3 21411

Output 3, left, mic 4 21504 Output 3, right, mic 4 21505 Output 6, left, mic 4 21510 Output 6, right, mic 4 21511
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X6) — Gain control or mic mix-point (contined)

e Gain control X6) e Gain control X6) f Volume control X6) f Volume control X6)

Input 1, left 30000 Input 1, right 30001 Output 1, left 60000 Output 1, right 60001

Input 2, left 30002 Input 2, right 30003 Output 2, left 60002 Output 2, right 60003

Input 3, left 30004 Input 3, right 30005 Output 3, left 60004 Output 3, right 60005

Input 4, left 30006 Input 4, right 30007 Output 4, left 60006 Output 4, right 60007

Input 5, left 30008 Input 5, right 30009 Output 5, left 60008 Output 5, right 60009

Input 6, left 30010 Input 6, right 30011 Output 6 left 60010 Output 6, right 60011

Input 7, left 30012 Input 7, right 30013

Input 8, left 30014 Input 8, right 30015

Input 9, left 30016 Input 9, right 30017

Input 10, left 30018 Input 10, right 30019

Input 11, left 30020 Input 11, right 30021

Input 12, left 30022 Input 12, right 30023

Input 13, left 30024 Input 13, right 30025

Input 14, left 30026 Input 14, right 30027
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X6! — Pre-matrix (a), post-matrix (c), and mic mix-point (d) level values

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

M
ic m

ix
-p

o
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ts (d
) o

n
ly

-35.0 1698

-34.9 1699 -34.8 1700 -34.7 1701 -34.6 1702 -34.5 1703 -34.4 1704 -34.3 1705 -34.2 1706 -34.1 1707 -34.0 1708

-33.9 1709 -33.8 1710 -33.7 1711 -33.6 1712 -33.5 1713 -33.4 1714 -33.3 1715 -33.2 1716 -33.1 1717 -33.0 1718

-32.9 1719 -32.8 1720 -32.7 1721 -32.6 1722 -32.5 1723 -32.4 1724 -32.3 1725 -32.2 1726 -32.1 1727 -32.0 1728

-31.9 1729 -31.8 1730 -31.7 1731 -31.6 1732 -31.5 1733 -31.4 1734 -31.3 1735 -31.2 1736 -31.1 1737 -31.0 1738

-30.9 1739 -30.8 1740 -30.7 1741 -30.6 1742 -30.5 1743 -30.4 1744 -30.3 1745 -30.2 1746 -30.1 1747 -30.0 1748

-29.9 1749 -29.8 1750 -29.7 1751 -29.6 1752 -29.5 1753 -29.4 1754 -29.3 1755 -29.2 1756 -29.1 1757 -29.0 1758

-28.9 1759 -28.8 1760 -28.7 1761 -28.6 1762 -28.5 1763 -28.4 1764 -28.3 1765 -28.2 1766 -28.1 1767 -28.0 1768

-27.9 1769 -27.8 1770 -27.7 1771 -27.6 1772 -27.5 1773 -27.4 1774 -27.3 1775 -27.2 1776 -27.1 1777 -27.0 1778

-26.9 1779 -26.8 1780 -26.7 1781 -26.6 1782 -26.5 1783 -26.4 1784 -26.3 1785 -26.2 1786 -26.1 1787 -26.0 1788

-25.9 1789 -25.8 1790 -25.7 1791 -25.6 1792 -25.5 1793 -25.4 1794 -25.3 1795 -25.2 1796 -25.1 1797 -25.0 1798

-24.9 1799 -24.8 1800 -24.7 1801 -24.6 1802 -24.5 1803 -24.4 1804 -24.3 1805 -24.2 1806 -24.1 1807 -24.0 1808

-23.9 1809 -23.8 1810 -23.7 1811 -23.6 1812 -23.5 1813 -23.4 1814 -23.3 1815 -23.2 1816 -23.1 1817 -23.0 1818

-22.9 1819 -22.8 1820 -22.7 1821 -22.6 1822 -22.5 1823 -22.4 1824 -22.3 1825 -22.2 1826 -22.1 1827 -22.0 1828

-21.9 1829 -21.8 1830 -21.7 1831 -21.6 1832 -21.5 1833 -21.4 1834 -21.3 1835 -21.2 1836 -21.1 1837 -21.0 1838

-20.9 1839 -20.8 1840 -20.7 1841 -20.6 1842 -20.5 1843 -20.4 1844 -20.3 1845 -20.2 1846 -20.1 1847 -20.0 1848

-19.9 1849 -19.8 1850 -19.7 1851 -19.6 1852 -19.5 1853 -19.4 1854 -19.3 1855 -19.2 1856 -19.1 1857 -19.0 1858

-18.9 1859 -18.8 1860 -18.7 1861 -18.6 1862 -18.5 1863 -18.4 1864 -18.3 1865 -18.2 1866 -18.1 1867 -18.0 1868

-17.9 1869 -17.8 1870 -17.7 1871 -17.6 1872 -17.5 1873 -17.4 1874 -17.3 1875 -17.2 1876 -17.1 1877 -17.0 1878

-16.9 1879 -16.8 1880 -16.7 1881 -16.6 1882 -16.5 1883 -16.4 1884 -16.3 1885 -16.2 1886 -16.1 1887 -16.0 1888

-15.9 1889 -15.8 1890 -15.7 1891 -15.6 1892 -15.5 1893 -15.4 1894 -15.3 1895 -15.2 1896 -15.1 1897 -15.0 1898

-14.9 1899 -14.8 1900 -14.7 1901 -14.6 1902 -14.5 1903 -14.4 1904 -14.3 1905 -14.2 1906 -14.1 1907 -14.0 1908

-13.9 1909 -13.8 1910 -13.7 1911 -13.6 1912 -13.5 1913 -13.4 1914 -13.3 1915 -13.2 1916 -13.1 1917 -13.0 1918

-12.9 1919 -12.8 1920 -12.7 1921 -12.6 1922 -12.5 1923 -12.4 1924 -12.3 1925 -12.2 1926 -12.1 1927
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X6! — Pre-matrix (a), post-matrix (c), and mic mix-point (d) level values, continued

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

P
re

-m
a
trix

 (a
), p

o
st-m

a
trix

 (c
), a

n
d
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ic m

ix
-p

o
in

ts (d
)

-12.0 1928

-11.9 1929 -11.8 1930 -11.7 1931 -11.6 1932 -11.5 1933 -11.4 1934 -11.3 1935 -11.2 1936 -11.1 1937 -11.0 1938

-10.9 1939 -10.8 1940 -10.7 1941 -10.6 1942 -10.5 1943 -10.4 1944 -10.3 1945 -10.2 1946 -10.1 1947 -10.0 1948

-9.9 1949 -9.8 1950 -9.7 1951 -9.6 1952 -9.5 1953 -9.4 1954 -9.3 1955 -9.2 1956 -9.1 1957 -9.0 1958

-8.9 1959 -8.8 1960 -8.7 1961 -8.6 1962 -8.5 1963 -8.4 1964 -8.3 1965 -8.2 1966 -8.1 1967 -8.0 1968

-7.9 1969 -7.8 1970 -7.7 1971 -7.6 1972 -7.5 1973 -7.4 1974 -7.3 1975 -7.2 1976 -7.1 1977 -7.0 1978

-6.9 1979 -6.8 1980 -6.7 1981 -6.6 1982 -6.5 1983 -6.4 1984 -6.3 1985 -6.2 1986 -6.1 1987 -6.0 1988

-5.9 1989 -5.8 1990 -5.7 1991 -5.6 1992 -5.5 1993 -5.4 1994 -5.3 1995 -5.2 1996 -5.1 1997 -5.0 1998

-4.9 1999 -4.8 2000 -4.7 2001 -4.6 2002 -4.5 2003 -4.4 2004 -4.3 2005 -4.2 2006 -4.1 2007 -4.0 2008

-3.9 2009 -3.8 2010 -3.7 2011 -3.6 2012 -3.5 2013 -3.4 2014 -3.3 2015 -3.2 2016 -3.1 2017 -3.0 2018

-2.9 2019 -2.8 2020 -2.7 2021 -2.6 2022 -2.5 2123 -2.4 2024 -2.3 2025 -2.2 2026 -2.1 2027 -2.0 2028

-1.9 2029 -1.8 2030 -1.7 2031 -1.6 2032 -1.5 2033 -1.4 2034 -1.3 2035 -1.2 2036 -1.1 2037 -1.0 2038

-0.9 2039 -0.8 2040 -0.7 2041 -0.6 2042 -0.5 2043 -0.4 2044 -0.3 2045 -0.2 2046 -0.1 2047  0.0 2048

+0.1 2049 +0.2 2050 +0.3 2051 +0.4 2052 +0.5 2053 +0.6 2054 +0.7 2055 +0.8 2056 +0.9 2057 +1.0 2058

+1.1 2059 +1.2 2060 +1.3 2061 +1.4 2062 +1.5 2063 +1.6 2064 +1.7 2065 +1.8 2066 +1.9 2067 +2.0 2068

+2.1 2069 +2.2 2070 +2.3 2071 +2.4 2072 +2.5 2073 +2.6 2074 +2.7 2075 +2.8 2076 +2.9 2077 +3.0 2078

+3.1 2079 +3.2 2080 +3.3 2081 +3.4 2082 +3.5 2083 +3.6 2084 +3.7 2085 +3.8 2086 +3.9 2087 +4.0 2088

+4.1 2089 +4.2 2090 +4.3 2091 +4.4 2092 +4.5 2093 +4.6 2094 +4.7 2095 +4.8 2096 +4.9 2097 +5.0 2098

+5.1 2199 +5.2 2100 +5.3 2101 +5.4 2102 +5.5 2103 +5.6 2104 +5.7 2105 +5.8 2106 +5.9 2107 +6.0 2108

+6.1 2109 +6.2 2110 +6.3 2111 +6.4 2112 +6.5 2113 +6.6 2114 +6.7 2115 +6.8 2116 +6.9 2117 +7.0 2118

+7.1 2119 +7.2 2120 +7.3 2121 +7.4 2122 +7.5 2123 +7.6 2124 +7.7 2125 +7.8 2126 +7.9 2127 +8.0 2128

+8.1 2129 +8.2 2130 +8.3 2131 +8.4 2132 +8.5 2133 +8.6 2134 +8.7 2135 +8.8 2136 +8.9 2137 +9.0 2138

+9.1 2139 +9.2 2140 +9.3 2141 +9.4 2142 +9.5 2143 +9.6 2144 +9.7 2145 +9.8 2146 +9.9 2147 +10.0 2148

+10.1 2149 +10.2 2150 +10.3 2151 +10.4 2152 +10.5 2153 +10.6 2154 +10.7 2155 +10.8 2156 +10.9 2157 +11.0 2158

+11.1 2159 +11.2 2160 +11.3 2161 +11.4 2162 +11.5 2163 +11.6 2164 +11.7 2165 +11.8 2166 +11.9 2167 +12.0 2168
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dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

dB 
value X6!

M
ic m
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o
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+12.1 2169 +12.2 2170 +12.3 2171 +12.4 2172 +12.5 2173 +12.6 2174 +12.7 2175 +12.8 2176 +12.9 2177 +13.0 2178

+13.1 2179 +13.2 2180 +13.3 2181 +13.4 2182 +13.5 2183 +13.6 2184 +13.7 2185 +13.8 2186 +13.9 2187 +14.0 2188

+14.1 2189 +14.2 2190 +14.3 2191 +14.4 2192 +14.5 2193 +14.6 2194 +14.7 2195 +14.8 2196 +14.9 2197 +15.0 2198

+15.1 2199 +15.2 2200 +15.3 2201 +15.4 2202 +15.5 2203 +15.6 2204 +15.7 2205 +15.8 2206 +15.9 2207 +16.0 2208

+16.1 2209 +16.2 2210 +16.3 2211 +16.4 2212 +16.5 2213 +16.6 2214 +16.7 2215 +16.8 2216 +16.9 2217 +17.0 2218

+17.1 2219 +17.2 2220 +17.3 2221 +17.4 2222 +17.5 2223 +17.6 2224 +17.7 2225 +17.8 2226 +17.9 2227 +18.0 2228

+18.1 2229 +18.2 2230 +18.3 2231 +18.4 2232 +18.5 2233 +18.6 2234 +18.7 2235 +18.8 2236 +18.9 2237 +19.0 2238

+19.1 2239 +19.2 2240 +19.3 2241 +19.4 2242 +19.5 2243 +19.6 2244 +19.7 2245 +19.8 2246 +19.9 2247 +20.0 2248

+20.1 2249 +20.2 2250 +20.3 2251 +20.4 2252 +20.5 2253 +20.6 2254 +20.7 2255 +20.8 2256 +20.9 2257 +21.0 2258

+21.1 2259 +21.2 2260 +21.3 2261 +21.4 2262 +21.5 2263 +21.6 2264 +21.7 2265 +21.8 2266 +21.9 2267 +22.0 2268

+22.1 2269 +22.2 2270 +22.3 2271 +22.4 2272 +22.5 2273 +22.6 2274 +22.7 2275 +22.8 2276 +22.9 2277 +23.0 2278

+23.1 2279 +23.2 2280 +23.3 2281 +23.4 2282 +23.5 2283 +23.6 2284 +23.7 2285 +23.8 2286 +23.9 2287 +24.0 2288

+24.1 2289 +24.2 2290 +24.3 2291 +24.4 2292 +24.5 2293 +24.6 2294 +24.7 2295 +24.8 2296 +24.9 2297 +25.0 2298

X6@ — Mic/line input level values

dB 
value X6@

dB 
value X6@

dB 
value X6@

dB 
value X6@

dB 
value X6@

dB 
value X6@

dB 
value X6@

dB 
value X6@

dB 
value X6@

dB 
value X6@

  0.0 2048

 1.0 2058  2.0 2068  3.0 2078  4.0 2088  5.0 2098  6.0 2108  7.0 2128  8.0 2128  9.0 2138 10.0 2148

11.0 2158 12.0 2168 13.0 2178 14.0 2188 15.0 2198 16.0 2208 17.0 2218 18.0 2228 19.0 2238 20.0 2248

21.0 2258 22.0 2268 23.0 2278 24.0 2288 25.0 2298 26.0 2308 27.0 2318 28.0 2328 29.0 2348 30.0 1958

31.0 2358 32.0 2368 33.0 2378 34.0 2388 35.0 2398 36.0 2408 37.0 2418 38.0 2428 39.0 2438 40.0 2448

41.0 2458 42.0 2468 43.0 2478 44.0 2488 45.0 2498 46.0 2508 47.0 2518 48.0 2528 49.0 2538 50.0 2548

51.0 2558 52.0 2568 53.0 2578 54.0 2588 55.0 2598 56.0 2608 57.0 2618 58.0 2628 59.0 2638 60.0 2648

61.0 2658 62.0 2668 63.0 2678 64.0 2688 65.0 2698 66.0 2708 67.0 2718 68.0 2728 69.0 2738 70.0 2748

71.0 2758 72.0 2768 73.0 2778 74.0 2788 75.0 2798 76.0 2808 77.0 2818 78.0 2828 79.0 2838 80.0 2848

X6! — Pre-matrix (a), post-matrix (c), and mic mix-point (d) level values, continued
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Command/response table for DSP SIS commands

Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Audio trim, gain, and mixing
N	 •	The DSP level adjustments are completely separate from the input gain and attenuation (G and g commands) and the 

output volume (V) commands available in the basic SIS commands.
•	The command format is the same, regardless of the control or mix-point that is to be set; the acceptable adjustment 

range varies depending on the control or mix-point:
	 	 The program audio input (pre-matrix) trim range is -12 dB to +12 dB, in 0.1 dB increments. 
	 The mic/line input gain range is 0 dB to 80 dB, in 1.0 dB increments. 
	 The post-matrix level trim is -12 dB to +12 dB, in 0.1 dB increments. 
	 The mic mix-points (with their associated mixing controls) range is -35 dB to +25 dB, in 0.1 dB increments.

•	All responses are shown with the matrix switcher in Verbose mode 2 or 3.
Set a DSP trim or mix 
(excluding mic/line inputs)

EGX6)*X6!AU} DsGX6)*X6!] Set DSP trim or mix control 
X6) to a value of X6! dB.

Example 1 (trim control): EG30124*2040AU} DsG30124*2040] Set the input 13, left audio 
trim to a value of -0.8 dB.

Example 2 (mix control): EG21308*2213AU} DsG21308*2213] Mix +16.5 dB of mic 2 into 
output 5, left.

Set a mic/line gain EGX6)*X6@AU} DsGX6)*X6@] Set mic/line gain control X6) 
to a value of X6@ dB.

Example: EG40001*2288AU} DsG40001*2288] Set the mic/line input 2 gain 
to a level of +24.0 dB.

Read a DSP trim or mix 
(excluding mic/line inputs)

EGX6)AU} DsGX6)*X6!] DSP trim or mix control X6) 
is set to a value of X6! dB.

Example 1 
(post matrix gain control):

EG50007AU} DsG50007*2103] Output 4, post matrix gain is 
set to a value of +5.5 dB.

Example 2 (mix control): EG21211AU} DsG21211*2140] +9.2 dB of mic 1 is mixed 
into output 6, right.

Read a mic/line gain EGX6)AU} DsGX6)*X6@] Mic/line gain control X6) is 
set to a value of X6@ dB.

Example: EG40000AU} DsG40000*2598] Mic/line input 1 gain is set 
to a value of +55.0 dB.

Audio mute

N	 •	Only mic/line input gain blocks (b) and mic mix-points (d) can be muted.
•	All responses are shown with the matrix switcher in Verbose mode 2 or 3.

Audio mute EMX6)*1AU} DsMX6)*1] Mute audio point X6).
Example: EM21410*1AU} DsM21410*1] Mute output 6, left, mic 3.

Audio unmute EMX6)*0AU} DsMX6)*0] Unmute audio point X6).
Read audio mute or level EMX6)AU} DsMX6)*X6#] X6#: 0 = mute off, 1 = mute on.

N	 X6) = Gain control or mic mix-point	 See the tables on page B-4 and B-5. 
X6! = Level value	 See the tables on page B-6 through B-8. 
X6@ = Mic/line gain level value	 See the table on page B-8. 
X6# = Mute status	 0 = unmute	 1 = mute 
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Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Audio group master commands

N	 •	See “Group masters“, in chapter 5, “Switcher Software“, for more information about audio group masters.

•	You must have assigned members to a group for these commands to have an effect.

•	For X6%, a positive (+) value is assumed unless you specify otherwise (-).

•	If you enter a X6% value that is outside the valid range for the group or outside the soft limits, the switcher responds 
with an “invalid parameter” (E13) error.

•	X6%, X6^, and X6& values can be sent without leading zeroes; responses are alway 5 digits.
Set a group fader control EDX6$*X6%GRPM} GrpmX6$*X6%] Set the group fader to a 

value of X6%.
Example: Ed2*-293*GRPM} GrpmD02*-00293*GRPM] Set the group 2 fader control 

to -29.3 dB.
Raise a group fader control EDX6$*X6^+GRPM} GrpmX6$*X6%] Increase the level of the X6$ 

group fader by X6^ dB.
Example Ed2*30+GRPM} GrpmD02*-00263*GRPM] Raise the group 2 fader 3 dB 

(from -29.3 dB to -26.3 dB, 
starting from the level set 
in the “Set a group fader 
control” example, above.

Lower a group fader 
control

EDX6$*X6^-GRPM} GrpmX6$*X6%] Decrease the level of the X6$ 
group fader by X6^ dB.

View the group fader 
control level

EDX6$GRPM} GrpmX6$*X6%] In verbose modes 1 and 2, the 
response is simplified to 
X6%].

Mute a group mute control EDX6$*1GRPM} GrpmDX6$*+00001] Mute all blocks in group X6$.
Clear (unmute) a group 
mute control

EDX6$*0GRPM} GrpmDX6$*+00000] Umute all blocks in group 
X6$.

View a group mute control EDX6$GRPM} GrpmDX6$*X6#] For group masters, X6# 
is always expresed as a 
positive, 5-digit value.

Set soft limits ELX6$*X6&upper*X6&lowerGRPM} Set the groups soft limits to 
X6& and X6&.GrpmLX6$*X6&*X6&]

Example: EL2*-48*-630GRPM} GrpmL02*-00048*-00630] Set the upper soft limit for 
the group 2 fader to -4.8 dB 
and the lower limit to -63 dB.

View soft limits ELX6$GRPM} GrpmLX6$*X6&*X6&] In verbose modes 1 and 2, 
the response is simplified to 
X6&*X6&].

View group type EPX6$GRPM} GrpmPX6$*X6*] Show the group type (X6*) 
for group X6$.  In verbose 
modes 1 and 2, the response 
is simplified to X6*].

View group members EOX6$GRPM} GrpmOX6$*X6)1*X6)2*...*X6)16]
X6) is the control or mix point.  
In verbose modes 1 and 2, 
the response is simplified to 
X6)1*X6)2*...*X6)16].

Reset a group EZX6$GRPM} GrpmZX6$] Delete all members from 
group X6$, reset parameters 
and soft limits.

N	 X6) = Gain control or mic mix-point	 See the tables on page B-4 and B-5. 
X6# = Mute status		  0 = unmute	 1 = mute 
X6$ = Group master group number 	 	 01 - 32 
X6%, X6^, X6& = Group fader soft limit	 dB value, in 0.1 dB increments, see page B-3. 
X6* = Group type (see figure B-1)	 	 6= gain (a through d)	 12 = mute	  
		  18 = gain (e and f) 
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Command ASCII command
(host to switcher)

Response
(switcher to host)

Additional 
description

Protected configuration
N	 The MPX Plus 866 A can save and recall a Personal Identification Number (PIN)-protected configuration, including 

all presets, mic mixes, parameters, variables, and values (with the exception of the switcher’s IP address).  The protected 
configuration is useful to establish the MPX Plus 866 A in a known state, either as a troubleshooting tool or as a 
baseline configuration.

Save the configuration ESX6(PCFG} PcfgS] Save the configuration to the 
protected memory location.

Recall the configuration ERPCFG} PcfgR] Recall the protected 
configuration

Change the PIN EPX6(old*X6(newPCFG} Overwrite the old PIN 
(X6(old) with the new one 
(X6(new).

PcfgP X6({new}]

Query configuration saved 
status

EQPCFG} X7)]

N	 X6( = PIN number 	 nnnn (default = 0000) 
X7) = Saved status	 0 = not saved	 1 = saved 
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MPX Plus 866 A

CAppendix C

Reference Information

Specifications

Part Numbers
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Specifications

Video
Routing

RGB/VGA	��������������������������	 8 x 6 matrix
S-video/composite video	�	 6 x 6 matrix

Gain	�������������������������������������������������	 Unity
Bandwidth

RGB/VGA	��������������������������	 300 MHz (-3 dB), fully loaded
S-video/composite video	�	 150 MHz (-3 dB), fully loaded

0 - 10 MHz	������������������	 No more than +0.1 dB to -0.1 dB
0 - 30 MHz	������������������	 No more than +0.1 dB to -0.5 dB

Differential phase error	����������������	 1.0° at 3.58 MHz and 4.43 MHz
Differential gain error	�������������������	 1.0% at 3.58 MHz and 4.43 MHz
Crosstalk

RGB/VGA	��������������������������	 <-50 dB @ 10 MHz, <-30 dB @ 100 MHz
S-video/composite video	�	 -50 dB @ 5 MHz

Switching speed	����������������������������	 100 ms (max.)

Video input
Number/signal type

RGB/VGA	��������������������������	 8 VGA-QXGA RGBHV, RGBS, RGsB, RsGsBs, component video
S-video/composite video	�	 Up to 4 S-video and 2 composite video 

or 
6 composite video

Connectors
RGB/VGA	��������������������������	 8 female 15-pin HD
S-video/composite video	�	 4 x 2 female BNC for S-video or composite video (inputs 11 to 14) and 

2 x 1 female BNC for composite video or genlock only (inputs 9 and 10)
Nominal level	��������������������������������	 1 Vp-p for Y of component video or S-video and for composite video 

0.7 Vp-p for RGB and for R-Y and B-Y of component video 
0.3 Vp-p for C of S-video

Minimum/maximum levels
RGB/VGA	��������������������������	 Analog: 0.3 V to 1.5 Vp-p with no offset
S-video/composite video	�	 Analog: 0.5 V to 2.0 Vp-p with no offset

Impedance	��������������������������������������	 75 ohms
Return loss

RGB/VGA	��������������������������	 <-40 dB @ 5 MHz
S-video/composite video	�	 <-30 dB @ 5 MHz

DC offset (max. allowable, S-video or composite video) 
1.5 V

External sync (genlock, S-video or composite video) 
0.3 V to 0.4 Vp-p
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Video output
Number/signal type

RGB/VGA	��������������������������	 6 VGA-QXGA RGBHV, RGBS, RGsB, RsGsBs, (follows input type)
S-video/composite video	�	 2 S-video, 2 S-video or composite video, and 2 composite video

Connectors
RGB/VGA	��������������������������	 6 female 15-pin HD
S-video/composite video	�	 2 x 2 female BNC for S-video only (outputs 9 and 10) 

2 x 2 female BNC for S-video or composite video pass-through (outputs 11 
and 12) 
2 x 1 female BNC for composite video only (outputs 7 and 8)

Nominal level	��������������������������������	 1 Vp-p for Y of component video or S-video and for composite video 
0.7 Vp-p for RGB and for R-Y and B-Y of component video 
0.3 Vp-p for C of S-video

Minimum/maximum levels
RGB/VGA	��������������������������	 Analog: 0.3 V to 1.5 Vp-p with no offset (follows input)
S-video/composite video	�	 Analog: 0.0 V to 2.0 Vp-p with no offset

Impedance	��������������������������������������	 75 ohms
Return loss

RGB/VGA	��������������������������	 -40 dB @ 5 MHz
S-video/composite video	�	 -30 dB @ 5 MHz

DC offset
S-video/composite video	�	 ±5 mV with input at 0 offset
VGA	�������������������������������������	 ±10 mV with input at 0 offset

Switching type
RGB/VGA	��������������������������	 Triple-Action
S-video/composite video	�	 Vertical interval

Sync
Input type (VGA group)	���������������	 RGBHV, RGBS, RGsB, RsGsBs
Output type (VGA group)	�����������	 RGBHV, RGBS, RGsB, RsGsBs (follows input)
Horizontal frequency (RGB)	��������	 15 kHz to 145 kHz
Vertical frequency (RGB)	��������������	 30 Hz to 170 Hz
Genlock connector	������������������������	 1 BNC female (video input 9)
Standards (S-video and composite video groups) 

NTSC 3.58, NTSC 4.43, PAL, SECAM
Input level	��������������������������������������	 1.9 V to 5.0 Vp-p
Output level	�����������������������������������	 TTL: 5.0 Vp-p, unterminated for RGBHV, RGBS
Input impedance	���������������������������	 510 ohms
Output impedance	������������������������	 75 ohms
Max. input voltage	������������������������	 5.0 Vp-p
Max. propagation delay	���������������	 <65 ns
Polarity	�������������������������������������������	 Positive or negative (follows input)
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Audio
Routing	�������������������������������������������	 14 x 6 stereo switching matrix 

4 x 6 microphone mixing matrix
Gain	�������������������������������������������������	 Unbalanced output: -6 dB; balanced output: 0 dB
Frequency response	����������������������	 20 Hz to 20 kHz, ±0.15 dB
THD + Noise	����������������������������������	 0.01% @ 1 kHz at nominal level
S/N	��������������������������������������������������	 >105 dB, balanced, at maximum output (21 dBu) (unweighted)
Crosstalk	�����������������������������������������	 <-90 dB @ 1 kHz, fully loaded
Stereo channel separation	������������	 >96 dB @ 1 kHz
CMRR	����������������������������������������������	 >70 dB @ 1 kHz
Volume range	���������������������������������	 -100 dB to 0 dB (volume numbers 0 to 64 in 1.0 dB steps, except from step 0 

to 1, which is a 37 dB step)

N	 Full attenuation is volume level 0, -100 dB.  The default is -0 dB, volume level 64.

Audio input
Number/signal type	���������������������	 14 stereo or mono, balanced/unbalanced
Connectors	�������������������������������������	 (14) 3.5 mm captive screw connectors, 5 pole
Impedance	��������������������������������������	 >11.5k ohms unbalanced, 22k ohms balanced, DC coupled
Nominal level	��������������������������������	 +4 dBu (1.23 Vrms)
Maximum level	������������������������������	 +24 dBu at 1% THD+N
Input gain adjustment	������������������	 –18 dB to +24 dB, adjustable per input by RS-232, Ethernet, or front panel

N	 0 dBu = 0.775 Vrms, 0 dBV = 1 Vrms, 0 dBV ≈ 2 dBu

Mic/line input
Number/signal type	���������������������	 4 balanced/unbalanced
Connectors	�������������������������������������	 (4) 3.5 mm captive screw connectors, 3 pole
Impedance	��������������������������������������	 >2.5k ohms unbalanced, >5.0k ohms balanced
Nominal level	��������������������������������	 -60 dBV (1 mVrms) when Mic gain is set to +40 dB
Equivalent input noise	�����������������	 <-120 dBV (1.0 µVrms) when Mic gain is set to +40 dB
Maximum level	������������������������������	 +12 dBV (2 Vrms) at 1% THD+N when Mic gain is set to 0 dB
Input gain adjustment	������������������	 0 dB to +80 dB, adjustable per input
Mic DC power	�������������������������������	 +48 VDC (can be switched on or off)

Audio output
Number/signal type	���������������������	 6 stereo or mono, balanced/unbalanced
Connectors	�������������������������������������	 (6) 3.5 mm captive screw connectors, 5 pole
Impedance	��������������������������������������	 50 ohms unbalanced, 100 ohms balanced
Gain error	���������������������������������������	 ±0.10 dB channel to channel
Maximum level (Hi-Z)	�����������������	 >+21 dBu, balanced; or +15 dBu, unbalanced at 1% THD+N
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Control/remote — switcher
Serial host control port	�����������������	 (2) RS-232: 2 rear panel 3.5 mm captive screw connectors, 3 pole; 

1 front panel 2.5 mm stereo mini jack (Either this or the rear panel secondary 
port is active, not both at the same time.)

Baud rate and protocol	�����������������	 9600 baud; 8 data bits, 1 stop bit, no parity
Serial control pin configurations	�	 Captive screw connectors: 1 = TX, 2 = RX, 3 = GND 

Mini stereo jack: tip = TX, ring = RX, sleeve = GND
Ethernet host control port	������������	 1 RJ-45 female connector
Ethernet data rate	��������������������������	 10/100Base-T, half/full duplex with autodetect
Ethernet protocol	���������������������������	 ARP, DHCP, ICMP (ping), TCP/IP, Telnet, HTTP, SMTP
Default settings	������������������������������	 Link speed and duplex level = autodetected 

IP address = 192.168.254.254 
Subnet mask = 255.255.0.0 
Gateway = 0.0.0.0 
DHCP = off

Web server	��������������������������������������	 Up to 200 simultaneous sessions 
7.25 MB nonvolatile user memory

Program control	�����������������������������	 Extron’s control/configuration program for Windows® 
Extron’s Simple Instruction Set (SIS™) 
Microsoft® Internet Explorer, ver. 6 or higher, Telnet

General
Power	����������������������������������������������	 100 VAC to 240 VAC, 50-60 Hz, 48 watts, internal
Temperature/humidity	����������������	 Storage: -40 to +158 °F (-40 to +70 °C) / 10% to 90%, noncondensing 

Operating: +32 to +122 °F (0 to +50 °C) / 10% to 90%, noncondensing
Cooling	�������������������������������������������	 Convection, vents on left and right sides
Mounting

Rack mount	������������������������	 Yes
Enclosure type	�������������������������������	 Metal
Enclosure dimensions	�������������������	 3.5” H x 17.0” W x 9.4” D (2U high, full rack wide) 

(8.9 cm H x 43.2 cm W x 23.9 cm D) 
(Depth excludes connectors.  Width excludes rack ears.)

Product weight	������������������������������	 15 lbs (6.8 kg)
Shipping weight	����������������������������	 25 lbs (12 kg)
DIM weight	������������������������������������	 TBD
Vibration	�����������������������������������������	 ISTA 1A in carton (International Safe Transit Association)
Regulatory compliance

Safety	�����������������������������������	 CE, c-UL, UL
EMI/EMC	��������������������������	 CE, C-tick, FCC Class A, ICES, VCCI

MTBF	�����������������������������������������������	 30,000 hours
Warranty	�����������������������������������������	 3 years parts and labor

N	 All nominal levels are at ±10%.

N	 Specifications are subject to change without notice.
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Part Numbers and Accessories

Included parts
Model Part number

MPX 866 A Media Presentation Matrix Switcher 60-796-01

5-pole captive screw audio connectors (qty. 20) 10-703-12LF

3-pole captive screw serial connectors (qty. 2) 10-703-11LF

Extron Software Products Disk (DSP Configurator, 
Matrix Switchers Control Program, and Button-Label 
Generator)

MPX Plus 866 A Media Presentation Matrix Switcher 
User’s Manual

Replacement parts
Included parts Part number

Button and cap diffuser kit 70-352-01

Button overlays 100-196-01

5-pole captive screw audio connectors (qty. 10) 100-460-01

Optional accessories
These items can be ordered separately:

Adapters, power supplies, labels Part number

MKP 1000 remote keypad

Black 60-239-02

White 60-239-03

WT (water-tight) (black) 60-239-52

WT (white) 60-239-53

MCP 1000P (primary) 60-298-01

MCP 1000S (secondary) 60-298-02

MKP 2000 matrix switcher X-Y remote control panel

Black 60-682-02

White 60-682-03

MKP 3000

Black 60-708-02

White 60-708-03

MKP 3000 MAAP

Black 60-709-02

White 60-709-03

MKP 3000 L (lectern mounted) 60-709-22
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Cables
When using signals with a scanning frequency of 15-125 kHz and running 
distances of 100 feet or more, use high resolution BNC cables to achieve maximum 
performance.

Bulk cable and termination tools

MHR mini high resolution cable Part number

MHRVGA/500 non-plenum 5-conductor, 500' (150 m) 22-024-01

MHRVGA/1000 non-plenum 5-conductor, 1000' (300 m) 22-024-03

MHRVGAP/500 plenum 5-conductor, 500' (150 m) 22-131-02

MHRVGAP/1000 plenum 5-conductor, 1000' (300 m) 22-131-03

MHR-2/250 non-plenum 2-conductor, 250' (75m) 22-123-02

MHR-2/500 non-plenum 2-conductor, 500' (150 m) 22-123-03

MHR-2P/250 plenum 2-conductor, 250' (75m) 22-129-02

MHR-2P/500 plenum 2-conductor, 500' (150 m) 22-129-03

RG6 super high resolution cable Part number

RG6/500 non-plenum 1-conductor, 500' (150 m) 22-098-02

RG6-1000 non-plenum 1-conductor, 1000' (300 m) 22-098-03

RG6P/500 plenum 1-conductor, 500' (150 m) 22-164-02

RG6P/1000 plenum 1-conductor, 1000' (300 m) 22-164-03

Termination tools and connectors Part number

15-pin HD connectors, (VGA style), qty. 10 100-070-51

CTU 200 universal crimp tool 100-241-01

MHR universal crimp term. kit (100 MHR BNC connectors) 100-266-01

RG6 universal crimp term. kit (100 RG6 BNC connectors) 100-267-01

CTU 100 universal compression tool (BNC, F, RCA) 100-181-01

MHR BNC compression kit (100 MHR BNC connectors) 60-538-01

RG6 BNC compression kit (100 RG6 BNC connectors) 60-538-02

Terminated cable assemblies

VGA male-to-male cables

VGA M-M MD, 3' to 100' (0.9 m to 30.4 m) (molded) 26-238-nn

VGA M-M BK, 3' to 100' (0.9 m to 30.4 m) (backshell) 26-238-nn

VGAP M-M MD, 3' to 25' (0.9 m to 7.6 m) (molded) 26-439-nn

VGAP M-M BK, 35' to 100' (10.6 m to 30.4 m) (backshell) 26-439-nn
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VGA male-to-male with audio cables Part number

VGA-A M-M MD, 3' to 100' (0.9 m to 30.4 m) (molded) 26-490-nn

VGA-A M-M BK, 3' to 100' (0.9 m to 30.4 m) (backshell) 26-490-nn

VGA-A 90º M-M MD, 3' to 12' (0.9 m to 3.6 m) (molded) 26-510-nn

VGA-A 90º M-M BK, 3' to 12' (0.9 m to 3.6 m) (backshell) 26-510-nn

VGA-A 90º Up M-M MD, 3' to 12' (0.9 m to 3.6 m) (molded) 26-510-nn

VGA-A 90º Up M-M BK 3' to 12' (0.9 m to 3.6 m) (backshell) 26-510-nn

VGA male-to-female cables Part number

VGA M-F MD, 3' to 100' (0.9 m to 30.4 m) (molded) 26-112-nn

VGA M-F BK, 3' to 100' (0.9 m to 30.4 m) (backshell) 26-112-nn

VGAP M-F MD, plenum 3' to 25' (0.9 m to 7.6 m) (molded) 26-438-nn

VGAP M-F BK, plenum 35' to 100' (10.6 m to 30.4 m) 
(backshell) 26-438 -nn

VGA male-to-female with audio cables Part number

VGA-A M-F MD, 3' to 50' (0.9 m to 15.2 m) (molded) 26-491-nn

VGA-A M-F BK, 3' to 50' (0.9 m to 15.2 m) (backshell) 26-491-nn

VGA-A 90º M-F MD, 3' to 12' (0.9 m to 3.6 m) (molded) 26-509-nn

VGA-A 90º M-F BK, 3' to 12' (0.9 m to 3.6 m) (backshell) 26-509-nn

VGA-A 90º Up M-F MD, 3' to 12' (0.9 m to 3.6 m) (molded) 26-509-nn

VGA-A 90º Up M-F BK 3' to 12' (0.9 m to 3.6 m) (backshell) 26-509-nn

S-video cables Part number

MHR-2 SVM-M, 6' to 100' (1.8 m to 30.4 m) 26-316-nn

MHR-2P SVM-M, Plenum, 6' to 100' (0.9 m to 30.4 m)) 26-522-nn

S-video/BNC adapters Part number

SVHSF-BNCM, S-video female to BNC male, 1' to 6' 
(30 cm to 1.8 m) 26-541-nn

SVHSF-BNCF, S-video female to BNC female, 8" (20 cm) 26-541-01

SVHSM-BNCF, S-video male to BNC female, 1' to 6' 
(30 cm to 1.8 m) 26-353-nn

SVHSM-BNCF, S-video female to BNC female, , 8" (20 cm) 26-353-01

Composite video male-to-male cables

RG6 BNC, 3' to 100' (0.9 m to 30.4 m) 26-383-nn
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Button Labels
Page C-11 provides strips of blank button labels.  If desired, photocopy them or cut 
them out of the manual, write button information in each button area, and put them 
in the switcher’s input or output buttons’ windows.  You can also create labels 
using the Button-Label Generator software (see chapter 5, “Switcher Software”).

Installing labels in the matrix switcher’s buttons
Install new labels in the matrix switcher’s front panel buttons as follows:

1.	 Make new labels using either the blanks on page C-11 or the Button-Label 
Generator software.  Cut them out.

N	 For best results, print on transparent or translucent material.

2.	 Remove the button from the switcher: use a small, flat bladed screwdriver such 
as an Extron Tweeker to gently pry a button out from the front panel (figure C-1).

	

TEXT 

Separate the two-
piece button here at
the corner.

Pry the two 
pieces apart. 

Diffuser 

Base 

Button Label 
Clear Lens 

Figure C-1 — Illuminated button label replacement

3.	 Locate the notch in the corner of one side of the clear button cap lens.

4.	 Separate the white backing (diffuser) from the clear button cap (lens); insert 
the blade of the small screwdriver into the corner notch and gently twist the 
blade.

5.	 Save the translucent, white diffuser, but remove the text/label insert from the 
transparent button cap lens.

6.	 Insert the replacement button label into the button cap.  Check for correct 
label orientation.

7.	 Align the white diffuser plate with the cap (lens).  The bumps on the diffuser 
plate should be aligned (top and bottom) with the notches on the clear button 
cap.  Firmly snap it into place.

8.	 Align the tabs on the switcher’s plunger with the notches on the diffuser 
plate.  Gently, but firmly, press the reassembled button into place in the 
switcher’s front panel.

9.	 Repeat steps 2 to 8 as needed to relabel other buttons.
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Extron’s Warranty
Extron Electronics warrants this product against defects in materials and workmanship for a period 
of three years from the date of purchase.  In the event of malfunction during the warranty period 
attributable directly to faulty workmanship and/or materials, Extron Electronics will, at its option, 
repair or replace said products or components, to whatever extent it shall deem necessary to restore 
said product to proper operating condition, provided that it is returned within the warranty period, 
with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1001 East Ball Road 
Anaheim, CA 92805 
U.S.A.

Japan: Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe, Africa, and the Middle East: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road, Songjiang 
District 
Shanghai 201611 
China

Asia: 
Extron Asia 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, 
electrical or mechanical abuse, abnormal operating conditions or non-Extron authorized modification 
to the product.

If it has been determined that the product is defective, please call Extron and ask for an Applications 
Engineer at (714) 491-1500 (USA), 31.33.453.4040 (Europe), 65.383.4400 (Asia), or 81.3.3511.7655 (Japan) 
to receive an RA# (Return Authorization number).  This will begin the repair process as quickly as 
possible.

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of 
loss or damage during shipment.  Returned units must include the serial number and a description of 
the problem, as well as the name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the 
product and its quality, performance, merchantability, or fitness for any particular use.  In no event 
will Extron Electronics be liable for direct, indirect, or consequential damages resulting from any 
defect in this product even if Extron Electronics has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this 
warranty may not apply to you.
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